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Dear Trainer,

This manual consists of lesson plans, exercises, and a training agenda developed by Internews
Networks’ Local Voices programs to train radio journalists in HIV reporting. We hope this train-
ing manual will help you to develop your own training program. 

At least 70% of these training exercises focus on teaching such radio reporting skills as inter-
viewing, scriptwriting, digital sound editing, and sound recording. The rest focuses on HIV-spe-
cific skills, such as language use and developing HIV knowledge. The Local Voices program is
convinced that journalists will only be able to use HIV knowledge on radio effectively if they’re
given the opportunity to also develop their storytelling and reporting skills. 

The CD that accompanies this manual contains all the training exercises and lesson plans in the
manual. This enables you to adapt them to your region and training needs. The CD also con-
tains sound used in some of the exercises. 

Chapter 5 contains a training agenda that works well for seven-day training workshops. You
can either use it as a set agenda, or adjust it to better suit your needs. The exercises and lesson
plans that are referred to in the training agenda are explained step by step in the different
chapters of this manual. The hand-outs and answer sheets that you will need to carry out some
of the exercises are also provided.

As a trainer, you may have your own training methods and preferences. This manual does not
intend to prescribe to you how to train but rather to assist you with useful workshop exercises,
guidelines, and insight into a training method that has worked well in Kenya, Nigeria, and
India. 

Should you require any additional information, please contact Internews at info@internews.org.
This manual is also available on the Internews website at www.internews.org.

We wish you all the best with your HIV journalism training workshops and trust that they will
equip journalists to tell stories that change people’s lives for the better. 

Best regards,

Mia Malan
Manual Editor and Internews Senior Health Journalism Advisor
September 2008
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Learning objectives 
After working through this chapter, the trainer will: 

1. Be able to explain the principles of the Local Voices Training Model.

2. Understand why developing general journalism skills should be an integral part of  
HIV journalism training. 

3. Better understand the context of the training exercises in the different chapters 
of this manual. 

Why is it important to understand the Local Voices Training Model?
The Local Voices Training Model is based on principles different from those of most HIV journal-
ism training approaches. It has a strong focus on nurturing radio reporting skills, while most
other models place more emphasis on developing knowledge of HIV. The Local Voices approach
requires trainers to assist journalists with the production of their stories and therefore demands
a considerably higher level of trainer involvement than do other types of workshops.

Good radio features – whether about HIV or other subjects – rely on the story-telling skills of
journalists and their ability to use sound creatively. It is important that radio journalists leave
training workshops armed with these skills. Providing trainees with HIV knowledge is merely
one aspect of a workshop. If they’re unable to package HIV knowledge effectively and translate
it into good stories, their work won’t have an impact. In a nutshell: The Local Voices training
approach teaches journalists how to tell compelling HIV stories that appeal to media con-
sumers.

This chapter discusses the principles of the Local Voices Training Model and explains how to
apply them to training. It also contains a list of Frequently Asked Questions.

How much time do I need to work through this chapter? 
2 hours: 1 hour and 15 minutes to study this chapter, and 45 minutes to look at training exer-
cises in the manual and relate them to the Local Voices Training Model

Exercises
None

Hand-outs
1A Local Voices: Success by Any Measurement

chapter 1

The Local Voices Training Model
MIA MALAN
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CHAPTER 1: THE LOCAL VOICES TRAINING MODEL

What is the Local Voices Training Model?
The principles of the Local Voices Training Model were developed after a media needs assess-
ment completed in Kenya and Nigeria in 2002. The model was refined by the Internews Kenya
Local Voices Team in 2003-4. The Kenya Team also developed and created the basis of the train-
ing curriculum presented in this manual. In addition to expanding trainees’ HIV knowledge, the
approach has a strong focus on story-telling and radio production skills. It teaches radio jour-
nalists how to produce high-quality HIV features followed by live call-in shows with in-studio
guests.

Trainees who have excelled and shown a commitment to producing high-quality HIV stories
are invited back for advanced training within three to six months after their first training. All
trainees are invited to regular, interactive roundtables on HIV-related subjects at which they
get new story ideas and are able to record interviews with guests. All trainees receive their own
flash recorders after producing five high-quality HIV programs with the mentoring of Local
Voices trainers. Everyone has free access to LV radio production and recording facilities. After
broadcasting five stories in the LV format, trainees become eligible to submit travel grant pro-
posals to do HIV stories outside of the cities in which they are based. 

Every time we take journalists to a site visit, I am always very much surprised because it is
always the first time they’ve gone to such places. And these are journalists who have been

reporting on HIV/AIDS issues for a long time. 

After a recent Internews-sponsored workshop on women and HIV that included a site visit to a PLHIV
association, the group’s founder called me to say they had never had journalists come to their office or
their income-generation project before, even when they had approached the media about an issue.
She said that it was very empowering for the women at their project and that the contact
made with journalists has been ongoing, a positive result for both sides.  

–Meron Seyoum, Project Coordinator of the Local Voices Program in Ethiopia

“
”
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CHAPTER 1: THE LOCAL VOICES TRAINING MODEL

The 10 Principles of the Local Voices Training Model

1. Local Voices training consists of 70% journalism training and 30% HIV information –
not the other way around 

Providing top-quality radio journalism training to reporters is expensive, because it requires
paying for pricey equipment and exceptionally skilled journalism trainers. These expenses
mean that reporters in developing countries often don’t have access to the same high training
standards as journalists from more developed countries. Merely providing trainees with access
to accurate HIV information does not necessarily translate into better stories. If they’re not
equipped with good radio story-telling skills, they will not be able to effectively use the HIV
information they receive in training sessions. It takes much longer to cultivate good radio jour-
nalism skills in reporters than it does to simply give them access to accurate HIV information. It
is therefore important to spend a significant amount of training time on developing journalists’
radio-specific journalism skills, such as scriptwriting, interviewing, recording, and digital sound
editing. It is a worthwhile investment – once mastered, journalists can apply their story-telling
skills to all their HIV stories.  

2. Workshops are a minimum of seven days long

LV training is practical. Journalism theory, such as scriptwriting or digital sound editing, is never
taught without providing trainees with the opportunity to turn theory into practice in con-
trolled learning environments (exercises in the classroom) as well as in freer learning settings
such as site visits. Seven days may sound long, but it’s a short period of time for the number of
skills that need to be taught. The entire last two days of the training are spent on producing
trainees’ stories. When reporters are able to return for mentoring/production of their stories in
the week after the training, the workshop is reduced to five days. The two days that would have
been spent on production are then spent individually with each trainee over the course of the
next week. The five-day approach works well when journalists live in the same town as the train-
er. When reporters have to travel to the workshop from far away, a seven-day training agenda is
more practical.  

3. Journalists always leave Local Voices training with a ready-for-broadcast story

For effective learning, it is important that trainees get the opportunity to apply their newly
acquired skills (radio journalism skills and HIV knowledge) to an end product. Getting to pro-
duce a radio feature story with the help of the journalism trainer is of immense benefit to the
trainee. Not only does it result in higher-quality stories, it also gives the trainee the opportunity



to correct mistakes on the spot. In addition to this, editors are considerably more open to
releasing journalists for seven days if they know their station will receive a good-quality prod-
uct to broadcast. With a ready-for-broadcast story, editors get the opportunity to hear the dif-
ference between a pre- and post-training story.

4. Local Voices training always includes a site visit and interviews with PLHIV  

Local Voices radio trainees are encouraged to give their stories a human face that will help
their listeners identify with people affected by HIV. In most cases, this includes interviews with
people living with HIV (PLHIV). Sometimes it includes interviews with family members of PLHIV
or someone else affected by HIV. Trainees have at least one site visit where they can record
interviews and natural sound with the guidance of the trainer(s).

Journalists in Kenya on a site visit to an HIV testing center.
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5. Local Voices training is theme based

Attempting to teach journalists as much as possible about HIV in a single training workshop is
over-ambitious and rarely successful. Very few people have the ability to absorb that much
knowledge in such a short amount of time. It’s more effective to work with a specific theme
such as counseling and testing, prevention of mother-to-child transmission (PMTCT), or anti-
retroviral treatment (ART). That way, the case study (PLHIV or someone affected by HIV), med-
ical expert interview, and site visit can be arranged so that they all enhance the theme. For
instance: If the training focuses on ART, the case study will be someone who is on ART, the site
visit an ART clinic, and the expert a doctor specializing in ART. 

6. Local Voices training doesn’t mix media

Each medium (radio, television, print, and online) requires very specific journalism skills and
story-telling skills. Radio journalists need to learn how to use, edit, and script to sound, where-
as print and television reporters need an entirely different set of skills.  

7. The Local Voices journalism trainer is always an experienced radio journalist 

Because the focus is on developing the radio journalism skills of trainees, it is important for the
journalism trainer to have a significant amount of field reporting experience in the same medi-
um as the trainees. Television or print journalists don’t have the skills to train radio journalists
and vice versa.

8. Local Voices training is done in small groups (12 journalists or fewer)

Local Voices training requires the trainer to spend the last two days of a seven-day training
workshop helping journalists to correctly apply their skills in the production of a story. In addi-
tion to this, the trainer also spends individual time with each trainee during exercises in con-
trolled learning environments. It is impossible to spend high-quality time with each trainee
when there are more than 12 journalists. The fewer the trainees, the higher the quality of the
mentoring, and the better equipped trainees will be to produce good stories after the work-
shop.

9. Local Voices radio trainees gain access to equipment and other resources

Our Local Voices model is adjustable. In most of the countries where we work, we have a fully
developed Local Voices model that includes an office with a Media Resource Center, studio,
and equipment library, as well as a media coordinator and a resident health journalism advisor

15
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who mentor trainees and review their story scripts. Trainees who have successfully completed
a workshop have free access to all of these facilities, including phones, the internet, sound edit-
ing facilities, printers, and a regularly updated HIV library. Journalists have access to these
resources and are expected to use them to produce high-quality stories. Without these “tools,“
first-rate radio productions become close to impossible. It doesn’t make sense to train
reporters to use equipment they don’t have access to afterwards.  

In countries where there are no Local Voices offices and part-time journalist mentors lead the
training, journalists receive such field recording equipment as flash recorders, and their sta-
tions receive computers with digital sound editing software. It becomes their property once
they’ve adhered to specific requirements. Each journalist needs to produce and broadcast five
high-quality stories within an agreed-upon time frame to receive a flash recorder, and news
editors need to allow them sufficient time to do so to receive a computer for their station. 

Internews also provides travel grants to journalists to cover HIV stories outside the city in which
they are based. Journalists become eligible to apply for travel grants once they’ve broadcast
their five stories. 

10. Local Voices workshops are always followed up by mentoring 

The Local Voices Training Model does not support “fly-in, fly-out“ training, where a trainer
leaves the country with no formal contact with trainees after the training workshop. Because it
is impossible to teach journalists all they need to know in a mere week-long training, individual
mentoring is essential, especially in countries where reporters don’t have regular access to
skilled editors or mentors where they work. Trainers’ contracts always provide for intensive
post-workshop mentoring, both virtually and in person. In countries where there are Local
Voices offices, reporters have daily access to training staff.
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11 Frequently Asked Questions About the 

Local Voices Training Approach

1. Who does the Local Voices Training Model target?

The Local Voices Training Model aims to support radio journalists from developing countries,
particularly from Africa. It is also suitable as a training model for radio journalism college stu-
dents from developed countries. It aims to teach journalists how to produce high-quality HIV
features for radio followed by a live call-in show with an in-studio guest.

2. What is different about the Local Voices Training Model?

The Local Voices Training Model has a stronger emphasis on the development of journalism skills
than most other training models. Most other training approaches focus mainly on increasing
journalists’ HIV knowledge. In contrast, the Local Voices model focuses first on nurturing
reporters’ storytelling skills. Journalists need the necessary reporting skills to translate HIV knowl-
edge into compelling stories.

3. Why does Local Voices deal mainly with radio?

In most of the countries where Internews works, particularly in Africa, radio is the most accessi-
ble form of media to the general public. This means that more people are likely to get infor -
mation about HIV from the radio than from television or print. In addition, television training is
considerately more expensive, as it requires costly recording and editing equipment and TV
training staff. We do regular television training in our Kenya office and have also trained tele -
vision presenters in India. We do print training in all our programs with in-country offices with
the particular aim of reaching policymakers.

4. Is there a Local Voices Training Model for television and print?
Yes. However, the radio model was created first and established all the broad principles of the
training model. The television and print training models share the same principles. Television
workshops train both journalists and camera operators. Print workshops include sessions on
photography and multimedia where appropriate. 

5. Why do Local Voices workshops train such a small number of journalists at a time?

Local Voices training has a strong practical focus. One trainer is expected to help 10 to 12 jour-
nalists each produce a radio feature and design a live call-in show with an in-studio guest. The



Local Voices approach emphasizes the quality of these programs and also requires the trainer
to spend a significant amount of time on production with each trainee. More trainees will
result in less individual time and fewer skills learned in the weeklong training. Although a small
number of journalists are trained at a time, their output is often much higher than that of a
larger group of 20 journalists trained more intensively.

6. How is Local Voices advanced training organized and who gets to attend? 

Advanced training is between two and seven days long. Once journalists have successfully
completed basic training and completed their five high-quality radio programs, they are invit-
ed to attend advanced training. Advanced trainings are designed to focus on advanced
scriptwriting and editing, critiquing sessions of each others’ stories, and a more in-depth HIV
information on a specific theme. Some journalists attend more than one advanced training
workshop. The more advanced the training (and the journalists) becomes, the shorter the train-

Journalists in Kenya on a site visit to the Kenya Medical Research Institute.
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ing sessions are. A trainee’s third or fourth advanced training session focuses on such special-
ized subjects as HIV and property rights. Many of the trained journalists create weekly HIV
radio programs. Advanced radio training gives them access to stories and case studies that
would have taken them a long time to find otherwise. These sessions are aimed at journalists
who already know how to produce excellent HIV stories; they have a greater focus on building
specialized HIV knowledge than building journalism skills.

7. What are Local Voices roundtables?

In countries where there are Local Voices offices, monthly roundtables are held on HIV-related
issues. Roundtables bring experts and PLHIV together to offer short presentations on a specific
theme (e.g., extremely drug-resistant or multidrug-resistant tuberculosis and HIV). Journalists
get to ask questions after presentations and conduct interviews with guests in the Local Voices
studios. Snacks are provided so reporters have the time to mingle informally with guests and
each other.

8. How do travel grants work and who qualifies?

Only journalists who have successfully completed Local Voices training and have produced and
broadcast five high-quality HIV programs are invited to apply for travel grants. Successful appli-
cants travel to mostly rural areas outside of the town in which they’re based to tell the HIV 
stories of other communities. This ensures that HIV coverage is not concentrated in large towns
only. A travel grant is generally not more than $500 and covers a trip of three to five days.
Travel grants are generally for stories inside the country where the journalist lives, but excep-
tions have been made. In 2008, the Local Voices program provided journalists from Kenya and
Ethiopia who have shown a strong commitment to HIV reporting with scholarships to cover
the HIV Implementers Conference in Kampala, Uganda. 

9. How does Internews measure the impact of Local Voices training?

Internews keeps careful records of the number of stories each Local Voices trainee has com-
pleted. A trainee-story ratio is used to assess the productivity of trainees. In the Kenya office,
each trainee produces an average of ten high-quality programs within twelve to twenty four
months after a workshop; many do much more. In addition, we use training evaluation forms
and pre- and post-training tests of HIV and journalism knowledge. In our Kenya office we’ve
done formal monitoring and evaluation (M&E). We’re in the process of implementing specially
designed M&E models in our other offices; results are not available yet. For more information
on the evaluation of our training programs, please see Chapter 13.

19
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The Local Voices program published an external evaluation of all Local Voices programs in
2008, of which copies can be obtained through the contact address in this manual. It is also
available on our website: www.internews.org.

10. Is there any proof that the LV model has had an impact on the quality of 
HIV journalism?

Yes. Independent M&E in Kenya has shown that the frequency of HIV reports on 11 radio sta-
tions increased by an average of 52% within a year after training began. There was also a signi -
ficant increase in the quality of HIV radio programs, with more diverse subjects being covered
and a significantly higher number of PLHIV interviewed on air. Mia Malan and Elizabeth Gold
delivered a paper on this at the International Conference for Communication for Development
in Rome in 2006. The paper can be viewed at: http://www.internews.org/global/health/
gold_malan_survey_200609.shtm

Also see the hand-out at the end of this chapter. 

11. Does Internews have to pay for the airtime of the Local Voices stories and programs
that journalists produce? 

No, Internews does not pay for airtime. The programs that journalists produce are theirs and
their stations own the copyright. Local Voices merely assists with the quality and technical 
production of programs. We do not require our name to be mentioned on air and do not tell
journalists what to broadcast, although we carefully guide them toward capturing good news
angles and interesting story ideas. We don’t refuse to help journalists who are working for radio
programs paid for by a sponsor, but encourage them to create programs for which the sponsor
doesn't dictate the content.
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Learning objectives
After working through this chapter, the trainer will: 

1. Understand how adults best absorb information and skills training workshops.

2. Be able to incorporate real-life experiences of the trainees into the workshop.

3. Think of themselves as collaborative trainers rather than lecturers.

Why is it important to use these skills to train radio journalists?
Journalists come to training sessions with significant professional and general life experience.
Even young journalists, many of whom work in highly challenging political and physical envi-
ronments, bring wisdom and experience beyond their years. Trainers working with these pro-
fessionals must recognize this knowledge and incorporate it into the program. A course that
fails to do so will lack interaction and overall energy.

Because of the importance of providing an opportunity for class participants to share their
experiences, both good and bad, trainers must be prepared to abandon a lecturer’s mindset.
The lecture format is acceptable only in a classroom of children or younger learners.
Experienced adults respect and learn best from a trainer whom they see as interested in them
and willing to face the challenge of analyzing and working with real-life scenarios. Providing as
many opportunities as possible for such communication ensures overall positive outcomes for
the training session. 

Exercises
None

Hand-outs
None

chapter 2

How Adults Learn
LAURA RANDALL-COOPER
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Main Principles of Adult Learning1

Adult learning occurs best when it:

• Is self-directed
Adults can share responsibility for their own learning because they know their own needs.

• Fills an immediate need
Motivation to learn is highest when it meets the immediate needs of the learners.

• Is participative
Participation in the learning process is active, not passive.

• Is experiential
The most effective learning is from shared experience; learners learn from each other, and 
the trainer often learns from the learners.

• Is reflective
Maximum learning from a particular experience occurs when a person takes the time to
reflect back upon it, draw conclusions, and derive principles for application to similar
experience in the future.

• Provides feedback
Effective learning requires feedback that is corrective but supportive.

• Shows respect for the learner
Mutual respect and trust between trainer and learner help the learning process.

• Provides a safe atmosphere
A cheerful, relaxed person learns more easily than one who is fearful, embarrassed, or angry. 

• Occurs in a comfortable environment
A person who is hungry, tired, cold, ill, or otherwise physically uncomfortable cannot learn
with maximum effectiveness. 

1 Chauhan, Seema and Ralph Stone. 1995. Training Trainers for Development: Conducting a Workshop on Participatory Training Techniques.
The CEDPA Training Manual Series, vol. I. Washington: The Center for Development and Population Activities. Available at
<http://www.cedpa.org>.

CHAPTER 2: HOW ADULTS LEARN
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The Old and the New
To more fully understand how adult learning is different, it helps to compare it to the class-
room teaching that children receive. In traditional classroom education, the learner’s role is to
passively receive information yet take little responsibility for the learning process. This is in part
because the motivation for learning is external, driven by the forces of the family, religion, or
tradition. Under these conditions, generally the learner does not see the immediate benefit of
the undertaking. The content of the courses is controlled by the teacher and the learner has lit-
tle or no choice in what is being taught. The focus is on gaining facts and information, not nec-
essarily acquiring and applying knowledge.

In contrast, the adult learner’s role in the workshop setting is to offer ideas based on experi-
ence. These ideas evolve as adult learners interact by sharing their work and life experiences
and their observations about their field. The learner is responsible for the learning process. The
motivation for learning comes from within and, quite beneficially, the learner sees an immedi-
ate application to the lesson. The training method focus is on sharing knowledge, replicating
real-life situations, and building on experiences.2

Setting the Learning Stage
To design an effective learning environment for adults, it’s important to understand the expec-
tations from the perspective of both trainer and trainee. Unlike children, adults come to a
learning experience with expectations not only of the trainer, but also with the underlying
expectation that they will leave the encounter with something gained. They want to learn
something that has real-life applications to enhance their life or career. Their expectations also
include being treated with respect as willing participants who arrive with ideas, hopes, and
questions based on their own personal work and life experiences. It’s similarly important to
communicate training expectations from the trainer’s perspective, including attendance
requirements, scheduling issues, maintaining classroom collegiality and respect for one anoth-
er, and commitment to learning.

To fulfill the learners’ needs and meet their expectations, and also to create an optimal environ-
ment for adult learning, trainers must begin by preparing some basics for the start of class. The
first step is laying out a road map for the training session that includes the following:
• Session title, overview, and content. 
• Learning goals or objectives.

• The session’s agenda and timing, including such basic needs as meals and comfort breaks for
telephone calls and restroom use.

2 Knowles, M.S. 1980. The Modern Practice of Adult Education: Andragogy versus pedagogy. Cambridge, MA: Prentice Hall
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3 Chauhan, Seema and Ralph Stone. 1995. Training Trainers for Development: Conducting a Workshop on Participatory Training Techniques.
The CEDPA Training Manual Series, vol. I. Washington: The Center for Development and Population Activities. Available at
<http://www.cedpa.org>.

• Attendance expectations, especially in a multi-day program, so that all participants under-
stand the requirements of successful participation and completion.

• Discussion of whether and how successful learning and course completion will be 
determined. 

Trainers should also provide copies of course reference materials in advance so learners can fol-
low along.

Experiential Learning 

Adults learn by sharing their own work. Therefore, one of the most important steps in any adult
education process is bringing participants’ experiences directly into the classroom.

The process of experiential learning consists of four parts:

1. Experience: people often experience something without really learning from it. In order to
learn, the rest of the experiential learning process must be completed.

2. Reflection: considering through writing or discussion what the experience meant 
or how it felt.

3. Generalization: making conclusions about the lessons learned from the experience.

4. Application: because learners often fail to apply new learning once they return to work, it is
very important, while still in the learning setting, to have learners decide how to apply their
new knowledge on the job.3

The trainer’s role is to guide students through each step of the process.

Inventory of Learning Styles
One of the greatest challenges for a trainer is conducting a class where participants arrive with
different skill levels. This automatically means the learners will have different learning styles. 

• Students for whom the material or concepts are unfamiliar will be dependent learners
requiring more structure, direction, and encouragement.  

• When learners already have some knowledge and ideas and would like to share them or try
them out, they are collaborative learners who need interaction with the trainer and peers and
ongoing challenges throughout the course. For these types of learners, the trainer must
constantly evaluate the progress of the training session and manage the discussion so it
fulfills learners’ needs. Feedback is critical for this learner to feel the course is beneficial. 

• When learners come to training already feeling quite knowledgeable, they will be
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independent learners and may feel the trainer does not have much to offer. For these
students, the trainer must listen, encourage, consult, and evaluate but, most importantly,
provide resources and opportunities for challenging experiences.

There are several critical elements of learning that must be addressed to ensure that partici-
pants learn.4 These are: 

• Motivation. The instructor must impress upon learners how they can benefit from the class.  

• Reinforcement. Reinforcement is a necessary part of the teaching/learning process; through
it, trainers encourage better practices and attitudes.

Positive reinforcement is normally used by trainers as a reward for improving practices and
attitudes. But negative reinforcement also has a role, especially when the trainer is teaching
new skills or new information. Negative reinforcement is useful for changing “bad“ practices
and attitudes. The trainer uses negative reinforcement (finding a way to gently or humorously
point out the mistake) until the learner improves.  

When instructors are trying to change old practices, they should apply both positive and 
negative reinforcement. 

PEPFAR Kenya co-ordinator Warren Buckingham sharing his experience of living with HIV
with a group of adult trainees in Kenya.

4 Lieb, Stephen, 1991. Principles of Adult Learning. Vision (Fall). Available at
<http://www.hcc.hawaii.edu/intranet/committees/FacDevCom/guidebk/teachtip/adults-2htm>
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3 Lieb, Stephen, 1991. Principles of Adult Learning. Vision (Fall). Available at
<http://www.hcc.hawaii.edu/intranet/committees/FacDevCom/guidebk/teachtip/adults-2htm>

• Retention. Students must retain information from classes to benefit from the learning.
Retention by the participants is directly affected by the amount of hands-on learning
activities offered by the training session.

• Transference. Transfer of learning is the result of successful training: the ability to use the
information taught in the course but in a new setting. Transference is most likely to occur
when participants can associate the new information with something they already know or
draw a similarity to an experience they have already had. 

Conclusion
Although the most important outcome for adult learners is always to know how what they
learn will be applied to the workplace, it’s important to remember that the learning still hap-
pens in different ways for different people. Learning results from stimulation of the senses. In
some people, one sense is used more than others to learn or recall information; therefore,
instructors should present materials that stimulate as many senses as possible in order to
increase their chances of teaching success. Personal experience, group support, and mentoring
are almost always preferred over lectures. Group experiences are useful in providing the oppor-
tunity to share experiences, but also to allow learners to assist each other in understanding the
material. Especially in a profession where teamwork drives a successful outcome, the adult
classroom is the best place for experimentation and exploration. 
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PUTTING YOUR WORST FOOT FORWARD
Communicate Required Basics in the Adult Classroom 

One of the best ways to get everyone involved at the start of the class and to help everyone
get to know each other is to stage a screening of trainees’ work – but rather than asking for

their best work, ask each participant to bring along and share a sample of their worst production. In
the presentation, ask the reporter to explain what went wrong and what they hope to learn in the
class to overcome their challenges. Too often, asking participants to bring their best work results in
the class being fearful of making honest comments and assessments. Knowing that everyone is
sharing their horror stories makes it easier for the group to open up and hopefully start the class on a
lighter note. It also indirectly gives the trainer an idea of the skill level of each participant.

–Laura Randall-Cooper, Internews Trainer, Azerbaijan

“
”

Kenyan journalists Anne Waithera and Nasteha Mohammed learning about the experiences
of an AIDS vaccine volunteer in a real-life environment.
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chapter 3

Planning Your Training
SANDRA NDONYE AND ANN MIKIA

Learning objectives 
After working through this chapter, the trainer will: 

1. Be able to understand and appreciate the magnitude of the work involved in planning a
training workshop.

2. Be able to effectively execute the preparation process for a workshop. 

3. Be able to adjust the checklist, letters, and procedures in this chapter to specific needs.

Why is it important to plan for your training? 
This chapter provides a guide to preparing and planning for a Local Voices radio journalism
training workshop. All workshops require thorough planning and preparation to be successful.

Workshop facilitators who do not properly plan often end up with the wrong mix of trainees or
speakers, which can severely handicap a workshop. Having reporters with starkly different skill
levels in the same workshop creates an uncomfortable atmosphere that can prevent them
from acquiring the skills you’re trying to teach. Inadequate planning can also mean choosing
inappropriate speakers who are not the best experts on their subjects or are not skilled at pres-
entation. Such speakers often end up confusing journalists or even discouraging them from
becoming interested in the subject you are trying to teach them. Speakers themselves also get
embarrassed when they realize they’re not up to the task. This can have serious implications for
your organization’s relationship with HIV organizations. 

It is important that the trainer or facilitator knows what the workshop planning process
involves so there is enough time to make changes, should emergencies arise (and they almost
always do). 

Even something as minor as the food or snacks you serve can significantly influence the con-
centration levels of participants. If you carefully plan for the smaller things ahead of time, it’s
much easier to handle more complex challenges, such as when speakers inform you 10 min-
utes prior to their scheduled speaking times that they can only make it the next day.  

This chapter also includes tips and checklists that are based on the planning procedures of our
Local Voices Programs in Kenya, India, Nigeria, and Ethiopia. All examples have been saved on
the manual CD – you will therefore be able to adjust the materials, should the need arise.  
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How much time do I need to allocate to planning?
About six days over a one-month period 

Exercises 
None

Hand-outs 
3A Workshop Application Form (Internews Nigeria example)

3B Checklist (Internews Kenya example)

3C Example of a workshop invitation letter to editors

3D Example of a workshop invitation letter to editors suggesting trainees 

3E Example of a workshop invitation letter to journalists 

3F Example of a site visit request letter

3G Example of a workshop invitation letter for a guest speaker
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The Countdown

Step 1:  Four weeks before training
• Decide on the HIV theme of the workshop, such as counseling and testing (CT), 

antiretroviral treatment (ART), or prevention of mother-to-child transmission
(PMTCT). Also think of possible journalism angles for the chosen theme.

• Decide on a specific profile for identifying journalists appropriate for the training (health jour-
nalists who cover HIV-related issues) and assess them as a group to determine whether they
are at a similar skill level. You may want to ask about the HIV topics that the journalist has cov-
ered before, what their understanding of different HIV terminology is (CD4 count, viral load,
ART), the level of their computer skills and typing speed, their competence in handling a
minidisc or flash recorder, their ability to edit sound digitally, their familiarity with the digital
sound editing software you will be using in your training (e.g., Adobe Audition, Audacity),
what journalism skills they think they need most, and what more they would like to learn
about HIV. Developing a questionnaire based on these issues and asking applicants or nomi-
nees to complete it will help you select trainees as well as plan the training agenda. 
Hand-out 3A could be used as a guide. 

• Initiate contact with editors/station managers with a phone call, then follow up in writing (e-
mail is fast and widely acceptable). It helps to recap the previous phone conversation when
following up in writing. See Hand-out 3C as an example of a workshop invitation letter to an
editor to nominate a journalist for training. Hand-out 3D is an example of an invitation in
which you ask an editor to send a particular journalist to the training. 

• Start identifying relevant guest speakers and case studies for the workshop.

Having trainees with different skill levels in the same workshop is counterproductive. Those
who need to learn basic skills don’t get to learn them properly because there are too many

people who want to learn more advanced skills and vice versa. If you assess these skills with a
questionnaire, you will prevent such a situation. In some of the countries where we work we pay a
significant amount of attention to the computer skills of journalists; reporters who have not used
computers before and are not familiar with Windows will find it very hard to understand digital sound
editing programs. By sending out questionnaires, we know whether we need to build a computer
literacy class in to our training courses, or ask certain reporters to arrive a day or two
before others to equip them with the necessary skills. 

–Mia Malan, Senior Health Journalism Advisor, Internews Network

“
”
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• Identify and start making formal requests for a site visit.

• Editors need to plan for the absence of journalists while they are away on training.

• Some trainees need to travel to the training location and need accommodation and planning
logistics arranged in advance.

• If you don’t plan ahead of time, you are unlikely to secure the best guest speakers, case
studies, and site visits for your workshop. 

• There will be ample time to successfully engage alternatives if the first choices fail.

Why?
• Editors need to plan for the absence of journalists while they are away on training.

• Some trainees need to travel to the training location and need accommodation 
and planning logistics arranged in advance.

• If you don’t plan ahead of time, you are unlikely to secure the best guest speakers, case
studies, and site visits for your workshop. 

• There will be ample time to successfully engage alternatives if the first choices fail.

Step 2: Three weeks before training

• Check whether the editors received your written requests for trainees and follow
up on those requests. 

• Check on the willingness and availability of nominated journalists. You may also
ask nominees to fill out an application form that tells you more about them and their work
and training needs. Hand-out 3A is an application form for journalists that our Internews
Nigeria office uses.  

• Check on the progress of plans for the site visit. 

• Check on the willingness and availability of your guest speakers (experts and case studies).
Hand-out 3G is an example of an invitation letter for a guest speaker.  

• Thoroughly brief case studies and expert speakers on the theme and specific angles you
would like them to address so they can prepare psychologically and start to think about such
visual aids as PowerPoint presentations.



Internews Radio Training Manual

34

CHAPTER 3: PLANNING YOUR TRAINING

Why?
• Most editors are very busy and may need reminding, or may not have had

enough time to respond.

• Some health care sites or guest speakers may decline your request; knowing
this in good time enables you to scout for alternatives.

Step 3: Two weeks before training
• Write to the trainees to inform them of the details of the workshop and what is

expected of them. Hand-out 3E is an example of an invitation letter to a 
journalist that spells out expectations.

• View story samples that the nominated journalists have submitted. 

• Ask guest speakers to send you their PowerPoint presentations for comments, if they intend
to use any. Advise them against reading directly off slides or notes and encourage them to
engage the journalists and make their session interactive. Encourage them to bring along
samples (e.g., ARVs, condoms, test kits) that can be displayed and passed round the room. Be
aware that asking speakers you’ve never met for their PowerPoint presentations in advance
may be offensive to them, so explain that you need them to provide to journalists before the
presentation, should they contain terminology and procedures that will be hard for them to
understand. Alternatively, you can explain that reporters are a very different audience from
the donors or NGO partners to whom presenters generally speak. Offer to help prepare the
PowerPoint presentation – make a date with the speaker at his or her office. Or invite the
speaker over to your own office (if you have an LV office with a studio) to both work on the
presentation and familiarize him or her with the studio. 

• Notify the guest speakers that journalists may be interested in individual or small group inter-
views after the formal presentations; ask them to allow time for that. At the least, factor in an
extra hour for these interviews and for a short break (10-15 minutes) between the two ses-
sions that will allow time for trainees to draw up questions. 

Dr. XYZ, from Clinic ABC: formal presentation on ARVs 20 minutes

Question and answer session 40 minutes

BREAK 15 minutes

Studio interviews 60 minutes
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Why?
• Some trainees may have personal commitments that jeopardize their atten-

dance, especially if they were not properly briefed by their editors.

• Viewing story samples will help gauge the skill level of the journalists, which helps you avoid
mixing high and low skill levels (or, if you have no alternative, allows you to strategically plan
for a mixed-level workshop). Viewing stories also helps to identify specific training needs.

• It’s important to look through and, if necessary, edit PowerPoint presentations so they offer
brief points to guide the presenter.

• Allocating extra time for interviews ensures that speakers don’t rush to cram everything into a
short time. Sending the speakers a program (like the draft above) clearly indicating how much
time they’ll have and how they should break it down allows them to better plan.

Step 4: One week before training
• Prepare the final training agenda and share it with a fellow trainer for proofread-

ing and comments.

• Make final confirmations of the site visit and guest speakers (experts and case
studies).

• Gather details of your confirmed site visit location so that you can plan for transportation.  

• Phone trainees to confirm their plans to attend. 

• Ensure that you have adequate facilities (e.g., computers and recorders) for journalists to use
and that everything is tested and in good working order.

• Shop for the required workshop stationery.

Why?
• This helps ensure that none of the details are overlooked.

Step 5: Three days before training
• Review the training program and checklist. 

• Make copies of all hand-outs that you intend to use during the workshop.

• Prepare a workshop registration file where trainees may fill in their contact 
details on the first day of the workshop.
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Why?
• The checklist points out any areas or details that may have been overlooked

and helps ensure that everybody assigned a task has remembered to carry it
out during workshop planning. Hand-out 3B is an example of a checklist that

our Kenya office uses for workshop preparation. 

• The training program enables fellow trainers to prepare for their roles and responsibilities dur-
ing the actual workshop.

• Other support staff involved in the workshop can plan appropriately (e.g., for preparation of
tea, snacks and lunches, stationery, and cleaning the training room). 

Step 6: During the training (the first day)
• At the opening of the workshop, discuss logistics and let trainees know what to

expect. Discuss the week’s training program, team spirit, breaks, and provisions
for meals and transport. It is important to provide trainees with a copy of the 

entire week’s agenda so they know what to expect. It is not necessary to give them detailed
agendas for the entire session, just an overview. You can give them a daily agenda each morn-
ing with significantly more details than the overview you provide on the first day. 

• It is always important to address the issue of per diems on the first day. In our LV programs we
provide per diems for lunch, if that is not provided by trainees’ employers. We also provide a
small per diem for transport. But we never “pay“ journalists to attend our training workshops
– the per diems are pro rata and only for transport to and from a training workshop and for
lunch. In our Nigeria office we fly journalists in from different states and put them up in

It is important to explain to trainees why they are getting per diems and what the per diems
are for. Creating the impression that you are paying journalists to attend a workshop is

dangerous. In our Kenya office we divide the per diem in two: one part for transport and another for
lunch. By mid-2008 we were giving trainees Ksh 1,000 (about $15) a day. Ksh 500 is for lunch and Ksh
500 for transport. It costs significantly less than Ksh 500 to get to our office with public transport, but
we offer more to allow trainees to take a private taxi to our office and thus arrive on time. If someone
turns up late for a training workshop, the person does not get the Ksh 500 for transport. We explain this
clearly on the first day: Slow public transport is not an excuse for turning up late at a workshop.

–Mia Malan, Internews Senior Health Journalism Advisor and  Sandra Ndonye, Internews Kenya
Media Manager

Note: The Local Voices Program also uses a “point system“ to encourage journalists to arrive on time
and to complete their required number of stories. You can read more about this in chapters 5 and 12. 

“
”
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hotels. We provide breakfast and lunch in the office and give them a per diem for supper. 

• Set working rules early to ensure things flow smoothly throughout the rest of the workshop
period. Address such issues as interruptions from ringing cell phones, punctuality, and absen-
teeism. Allow the trainees an opportunity to be part of the process of making the rules or
“constitution“ that will be used throughout the workshop.

• Ensure any hand-outs for the day are available and arranged in a logical order, ready for distri-
bution when necessary.

• Phone guest speakers two or three hours in advance on the day they are due as a reminder.

Why?
• The registration forms help capture all of the trainees’ contact details. This is

very useful for future communication.

• Rules ensure order and trainees are well aware of the consequences of breaking
rules.

• Advance calls to guest speakers serve as last-minute reminders and emphasize the impor-
tance of keeping time.

We start preparing for training well in advance, several weeks if possible. We prepare our train-
ing materials the week prior to the workshop and decide on the workshop theme at least a

week before that. We identify guest speakers and a site visit location, sometimes in partnership with a
federal government agency, a nongovernmental organization, or a PLHIV advocacy group. We also
prepare folders, hand-outs, and copies of the training agenda two or three days in advance. 

Although we have all the materials ready on the first day of the workshop, we don’t give trainees
hand-outs and detailed agendas beforehand but rather an overview of the workshop on the first day.
We distribute the daily agenda every morning after participants have signed in. 

–Meron Seyoum, Project Coordinator of the Local Voices program in Ethiopia

“
”
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Give a brown bag lunch!

The Local Voices Program in Kenya started to provide trainees with brown bag lunches
during roundtables on some training days in 2007. The brown bag lunches replaced outside
catering services, which can be costly and time-consuming to deal with. 

Serving journalists a
balanced meal is a clear
indication of walking the
walk. Our training often
emphasizes the
importance of good
health and nutrition, so
why not practice what
we preach? 

–Ann Mikia, Radio
Specialist Trainer,
Internews Kenya

‘’

‘’Journalists in Kenya having a brown bag lunch.

• The brown paper bag contains a sandwich, a banana, an apple, a small packet of nuts, a
cookie or brownie, and a small packet of juice. Remember to be considerate and make
provisions for vegetarian and halal needs when planning for the sandwiches.

• It’s easy to pack and convenient for everyone (participants and hosts) – they just pick up a
bag and eat at their convenience.

• Packed lunches require less space than buffets and formal dining areas.

• The cost of putting lunch bags together is low (catering is more than double the price).
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HAND-OUT 3A

ENHANSE/INTERNEWS JOURNALISM PROJECT
Workshop for Health Reporters 

On Adolescent Reproductive Health  
Abuja, Nigeria: December 10 - 15, 2007

APPLICATION FORM
(Please type or print)

1. Applicant Information

Surname Sex          M           F

Other Names

Organization

Office Address in full

Home Address

Postal Address

Telephone

E-mail address required*

*Please note that Internews routinely communicates by e-mail with associates and workshop applicants.

2. Work Record

How long have you worked as a reporter in your organization?

Do you currently cover the health or social sector beat? Yes No

Have you ever reported on reproductive health issues? Yes No

OFFICIAL PERSONAL

H
A
N
D
-
O
U
T
S
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Please provide details of your work record in the past three years, stating: 

lHow many news organizations have you worked for?

lHow long have you worked in the current organization?

lHow satisfied are you with your current position? (Tick one) Yes            No

lWhat level of education have you attained? (Tick one) Diploma             BA/BSC           MSc

lAre you trained in journalism? (Tick one) Yes            No

lIf not, what is your discipline?

lAs part of your current job, provide an estimate of the number 

of stories you have done in the last six months.

lHow well do you use Microsoft Office Systems?

 lDo you know the digital editing software Cool Edit? (Tick one) Yes            No

lIf yes, how well can you use it? (Tick one) Very well                Fairly well              Not well

3. Past Work and Training

Have you ever attended an Internews workshop? (Tick one) Yes            No

If YES, state workshop title and dates

Have you attended any journalist training? (Tick one) Yes            No

If yes, list the training you have attended. Indicate training theme, date, and sponsor.

Give the titles of two of your recent feature stories on REPRODUCTIVE HEALTH issues. Please provide 

air checks (off-air recording of the report or program). 

Note: Air checks of stories must be included in your application for you to be considered.

1.

2.

H
A
N
D
-
O
U
T
S



Internews Radio Training Manual

41

CHAPTER 3: PLANNING YOUR TRAINING

H
A
N
D
-
O
U
T
S

4. Objective

How do you expect this training to improve your work as a health reporter?

What types of professional training currently exist within your organization?

Have you participated in any of them? Yes             No

If YES, which ones?

5. Thinking about Media Practice

In what ways is training important for a news media practitioner like you?

6. Recommendation by Employer

By appending their name, signature, and official stamp below, the employer endorses this application and the 

claims made by the applicant. The employer also agrees to release the applicant completely for the duration of 

the workshop without working on any other assignment.  The employer is obligated to publish and/or broadcast 

stories generated and produced from this workshop.

Name ....................................................................................... 

Position ................................................................................... .......................................................................................

Source: Developed by Internews Nigeria.

SIGNATURE/STAMP
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HAND-OUT 3B

WORKSHOP CHECKLIST 

Theme of the workshop: .......................................................................................

Duration of workshop: ...........................................................................................  days

Number of trainees invited: .................................................................................

Lunch allowance (per diem) per person: ..........................................................

Guest speakers (experts and case studies invited): 

Technical preparations required:

Number of site visit(s):

Name & organization Day & time of presentation Gift or honorarium amount 

Description Day & time required Technical person in charge

Venue(s) Day & time Transport/prop requirements & costs 

H
A
N
D
-
O
U
T
S
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Graduation:

Number of certificates required: ....................................................................................... 

List of names as they should appear on the certificates:

Name: ..........................................................................................................................................

Station: ..........................................................................................................................................

Theme of the workshop (successful completion of a course in): ..............................................

Source: Designed by Ann Mikia (Radio Specialist Trainer) and Ninda Kang’ethe (Administrator), Internews, Kenya.

Names & organizations of invited
guests (editors/speakers)

Technical requirements Technical person in charge
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HAND-OUT 3C

10 June 2007

Attn: Mr. Waweru Mburu, Editor, Radio Citizen

Dear Mr. Mburu,

RE: HIV/AIDS TRAINING WORKSHOP FOR RADIO JOURNALITS

As a media organization doing work in the field of HIV/AIDS, liaising with the Radio Citizen has always been a

pleasure. Your station’s commitment to broadcasting quality HIV/AIDS programmes is inspiring; that is why

we continue to invite the journalists from your station to our training workshops. 

Next month, we will be running a week-long workshop on the impact of HIV/AIDS on children. Internews

would like to invite you to nominate one radio journalist who regularly covers HIV/AIDS issues for your radio

station to attend this week-long training.

The workshop will take place from Monday 30 June to Friday 4th July 2007 daily from 9:00am to 5:00pm. The

training programme is tailored such that activities are in sequence and lead into each other, so trainees shall

be required to attend all sessions of the workshop. We therefore request that your nominee is officially

relieved of his/her regular duties over the workshop week. 

The venue will be at Internews’ 4th Floor IPS Building Office. 

Please note that you are not required to pay any fees for this training. Internews shall provide tea, snacks, and

lunch.

We look forward to receiving the name of your nominee and to working with Radio Citizen. 

With best regards,

Sandra N. Ndonye

Media & Development Manager

Internews Network

Nairobi, Kenya

Tel: +25420252492

www.internews.org

Source: Developed by Internews Kenya.

H
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HAND-OUT 3D

Ms. Leah Gachegu

Editor, FEBA/Baraka FM

7 July 2007

Dear Ms. Gachegu,

Internews is inspired by Baraka FM’s dedication to airing HIV/AIDS programmes and we would like to further

extend our working relationship with FEBA.

Next month, we will be running a week-long workshop for radio journalists on how to report on HIV/AIDS

issues.

With your permission, we would like to invite Jackie Ooko to attend this training workshop to give support to

the already existing team of Alex Mwakideu and Linda Oriaso in Mombasa.

This workshop will run daily from 1-5 August 2005 at our IPS building office, from 9am to 5pm. 

Internews will cover the entire cost of training and will also ensure that Jackie returns with a good-quality

HIV/AIDS story for broadcast on your station.

Kindly confirmation her attendance on: Tel 253249/252492 or via e-mail: sandy@internews.co.ke.

Sincerely,

Sandra Ndonye

Media Manager

Internews Network

Source: Developed by Internews Kenya.
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HAND-OUT 3E

6 July 2007

Dear Caleb,

RE: INVITATION TO RADIO TRAINING WORKSHOP

Internews Network would like to invite you to attend a training workshop specially tailored for radio journal-

ists who report on HIV/AIDS. This will run daily from Monday 9 to Friday 13 July 2007, 9:00am to 5:30pm at

the Internews 4th floor IPS building office.

At this training workshop, you will get professional radio journalism skills and tips as well as useful informa-

tion on HIV and AIDS. To culminate the skills learnt on this workshop, Internews will help you to produce a

good-quality HIV feature story for broadcast on your station. You will have free and unlimited access to our

Media Resource Centre which contains relevant contacts and HIV/AIDS information packaged in a media-

friendly way. You will also be able to use our studios and equipment (recorder) lending facilities. 

The training programme is tailored such that all activities are in sequence and lead into each other, so

trainees shall be required to attend all sessions of the workshop. We therefore request that you be officially

relieved of regular duties over training week. 

Please note that you are not required to pay any fees for this training. Tea, snacks, and lunches shall be pro-

vided by Internews. 

We are excited and look forward to meeting you. 

Please feel free to contact Internews in case of any queries.

With best regards,

Sandra N. Ndonye

Media Manager

Internews Network

Tel (DL): 253249

Nairobi, Kenya

www.internews.org

Source: Developed by Internews Kenya.
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HAND-OUT 3F

Attn: Mr. Gordon Odundo, Administrator

Gertrude’s Garden Children’s Hospital

Nairobi

8 November 2004

Dear Sir/Madam,

RE: SITE VISIT TO GERTRUDE’S GARDEN CHILDREN’S HOSPITAL

Internews Network is a media development organization supported by USAID. We work closely with local

radio journalists to support and train them on how to report effectively and responsibly on HIV/AIDS issues.

Internews will be running a workshop for a group of six radio journalists drawn from the local media houses.

The topic of this workshop will be Children and HIV/AIDS. As part of the activities around the workshop, we

would be interested in visiting a pediatric hospital to focus on the special needs of children. 

The purpose of the site visit will be for the radio journalists to get to see around the children’s hospital and

interview a resident nurse who takes care of the in-patient children. If possible, we would be glad to talk to a

child or two and their parent/guardians. We further wish to reassure you that confidentiality will be highly

observed in the interviews and we shall abide by all your hospital’s rules and regulations. 

We had in mind Friday the 3rd of December 2006 for the site visit. We however will be willing to visit on any

other day convenient to you. 

We hope you shall favorably look into our request, and look forward to hearing from Gertrude’s Garden

Hospital.

Sincerely,

Sandra Ndonye

Media Coordinator

Internews Network

Source: Developed by Internews Kenya.
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HAND-OUT 3G

Prof. Karega Mutahi
Permanent Secretary, Ministry of Education

23 June 2005

Dear Professor Mutahi,

RE: INTERNEWS WORKSHOP ON THE IMPACT OF HIV/AIDS ON THE COUNTRY’S EDUCATION SECTOR

Internews Network is a USAID-funded media organization that works with the local journalists. We train and
support journalists in reporting responsibly and effectively on HIV/AIDS issues.

Next month, Internews will be running a workshop for radio journalists. The theme around this workshop will
be ‘The impact of HIV/AIDS on the Country’s Education Sector’.  If the country constantly loses teachers to
HIV/AIDS, it impacts on the quality of education that children have and drains the resources of the education
system. This in turn means children will have fewer and fewer resources with regard to the extra help that
they may need.

Internews would like to invite you to this workshop to give an overview on the impact of AIDS on Kenya’s
education sector. This can be a short introduction using a few slides/PowerPoint presentation (15 min) fol-
lowed by a question and answer session with the journalists (45 min). Thereafter, the journalists will be inter-
ested in individual interviews with you in our studios (one hr). In total, your session will take two hours.

This workshop will also feature two members of the Kenya Network of HIV-positive Teachers (KENEPOTE) who
will share their personal experiences of living with HIV and the impact it has on their teaching profession.

Venue:  Internews Network, IPS Building (6th floor), Kimathi Street

Date: Friday 8th July 2005                       Time: 10:30am-12:30pm

We look forward to your response.

Sincerely,

Sandra N. Ndonye
Media Manager, Internews Network
Nairobi, Kenya

Source: Developed by Internews Kenya. 
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Learning objectives
After working through this chapter, the trainer will: 

1. Be able to explain why reporting on HIV is different from reporting on other health issues.

2. Be able to conduct language-editing exercises to help trainees improve the accuracy and
tone of the HIV language they use. 

Why is it important to teach radio journalists this skill?
The HIV pandemic is a complex topic. To report effectively on HIV, a journalist must investigate
and sometimes challenge social structures, cultural values, and beliefs that contribute to the
epidemic. This may mean discussing such sensitive topics as sexual behavior, inadequate social
services, and the denial of basic human rights. 

The delivery of a story is as important as its content. Insensitive language and tone can rein-
force an audience’s negative stereotypes about HIV, particularly in communities where stigma
and discrimination are rampant. But accurate and sensitive language can encourage an audi-
ence to be more thoughtful and open-minded about HIV. Journalists who use sensitive and
inclusive language to illustrate the scope and context of the epidemic can shed new light on
the social causes and impact of HIV in their communities. 

Chapter 4 guides the trainer through training sessions with exercises to teach the importance
of accurate use of language for reporting on HIV.  The first two exercises examine context and
language in radio stories on HIV and how they shape your audience’s understanding of the
issues. Later sections help teach the importance of language choice through group discussion
and hands-on application.  All of the exercises are based on actual HIV story examples, but may
be adjusted to be culturally and contextually suitable for Local Voices journalism training in any
country. The exercises have been saved on the manual CD, should you like to adjust them.

How much time do I need to allocate to teaching this skill in a weeklong
training workshop? 
• Overview of what makes HIV reporting different: 1 hour 

• Teaching accurate language and non-discriminatory tone: 1 hour 10 minutes 

Total: 2 hours, 10 minutes

chapter 4

What Makes HIV Reporting Different?
JAYA SHREEDHAR AND SARA BARRETT
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Exercises
• Find the Links: Covering HIV/AIDS (essential: 1 hour)

• Flash Card Game: Teaching Appropriate HIV Language (essential: 30 minutes)

• Language Editing Exercise #1 (essential: 40 minutes)

• Language Editing Exercise #2 (optional: 40 minutes) 

Hand-outs
4A  Fact Sheet and Corresponding Statements

4B  Language Style Sheet

4C  Language Editing Exercise #1 (for trainees)

4D  Language Editing Exercise #1 (  answer sheet for trainers)

4E  Henry’s Story (uncorrected version for trainees)

4F  Henry’s Story (answer sheet for trainers) 

4G HIV in Context
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EXERCISES

FIND THE LINKS: COVERING HIV/AIDS
LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Better understand the links between HIV, gender, and human rights. 
• Be able to better contextualize the HIV pandemic.

MATERIALS
3“ by 6“ cards, in different colors – one for each journalist, plus 4 more for the trainer to demonstrate 

HAND-OUTS
• Hand-out 4A (Fact Sheet and Corresponding Statements) 

Note: There are 12 “facts” and “corresponding statements” on Hand-out 4A. If you have more than eight trainees,
you will have to create more facts of your own. Many of these items are India specific but can be changed to be
appropriate for the country where you work.

• Hand-out 4G (HIV in Context)

Journalists in Tamil Nadu exchanging “facts” and “corresponding statements” in the “Find
the Links: Covering HIV/AIDS” exercise.
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TIME
1 hour 

PREPARATION INSTRUCTIONS
1. Prepare the cards according to the instructions below before the workshop session. 
2. Divide the cards into two equal stacks.  
3. Write a fact about the HIV epidemic from the list provided in Hand-out 4A on each card in the first stack. 

Example:
Fact 3: Most HIV infections are in the developing world. 

4. Write the “corresponding statement“ of each “fact“ (as documented in Hand-out 4A) on the second 
stack of cards. 
Example:  
Corresponding statement of Fact 3: Ignorance, poverty, and malnourishment exacerbate the spread of HIV.

5. Make sure there is a pair of cards (one from each stack) for each “fact“ and “corresponding statement.“ You 
need one pair of cards for each trainee, plus an additional four pairs to demonstrate how the card works.  

INSTRUCTIONS FOR THE WORKSHOP SESSION
1. Get everyone to sit in an informal circle on chairs. 
2. Ask the group:  “Why is HIV such a complex topic to report on?“ Leave time for a few responses.
3. Make sure to get across the following points:  

HIV is more than a virus that affects the health of a person.  The epidemic is linked to deeply rooted
cultural and human rights issues. This makes reporting on the virus more complex, particularly if
the goal is to put the pandemic in context. As reporters, we have to explain the links between HIV
and these contextual issues so our audiences think not only about how HIV affects people but also
how society contributes to the epidemic. 

4. Ask the group: “Why is HIV/AIDS a human rights issue?“ 
5. Allow for a few responses. 
6. Make sure the following points get across: 

Those who are infected often lack the resources and information necessary for counseling and
treatment or to prevent the spread of the virus. They may also be ill-equipped to take care of their
family.

7. Announce to the group that they will be playing a matching game, and that first you’ll demonstrate how
to play.

8. Take four pairs of cards from the two stacks of cards (four “facts“ from the first stack and four
“corresponding statements“ from the second stack). 

9. Take one card with a “fact“ for yourself. 
10. Distribute the other cards to the group. 
11. Read out the fact on your card aloud. For instance, if you have fact 10 on Hand-out 4A, the fact will read:

“There is no vaccine for HIV.“ 
12. Announce that someone in the group has a “corresponding statement“ for your “fact.“ 
13. Ask each person with a card to read out what’s written on it aloud. 
14. When you come to the trainee with the “corresponding fact“ to your statement, which would be “Safer sex

is the only way to protect oneself from HIV,“ indicate that it is the “corresponding statement.” 
(continued on next page)
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15. Ask the group how they think the “fact“ and “corresponding statement“ are linked. 
16. Explain that the “fact“ that there is no cure or vaccine for HIV means that safer sex (abstinence and sex

with the correct use of condoms) is the only protection against it. Use the websites on Hand-out 4A to
make your case with more information. 

17. Do the same with the other three pairs of cards.
18. After the demonstration, ask the group if everyone understands how the game works and if there are any

questions.
19. Shuffle the cards in the two stacks and pass one out to each member of the group.  If you have more cards

than participants, be sure to leave matching/linked cards out of the stack to ensure that each card has a
match within the group. If there is an odd number of participants, the trainer can take a card too.

20. Ask the journalists to get up out of their chairs and find their “date“ – the person with the corresponding
card. Give everyone three minutes; remind the group when there is one minute remaining.

21. Explain that the act of going around the room looking for the right partner is similar to dating. It isn’t
uncommon to decide that a person isn’t your match, and so you will move on and continue looking for
the “right partner.“

22. Once participants have found their partners and have paired up into couples, ask them to gather around
you in a half-circle. 

23. Ask each pair to read the statements on their cards out loud, and explain how/why the cards go together.
Use Hand-out 4A as a guide.  

24. Invite the other group members to state whether or not the cards go together, and why. 
25. Once you have finished going around the circle, congratulate the group for bringing out the contexts in

which the epidemic has unfolded.  
26. Explain that they may draw upon these contexts to develop dynamic, interesting stories about HIV/AIDS.

Whether you write from a business, cultural, or human rights perspective, it’s possible to negotiate your
story into so many possible angles and perspectives. Because we have the flexibility and freedom to
explore the issues around HIV and report on them, we have the potential to impact policy.

27. Distribute Hand-outs 4A and 4G as reference guides.

This exercise was developed by Jaya Shreedhar. 
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FLASH CARD GAME: TEACHING APPROPRIATE HIV LANGUAGE

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Understand the importance of sensitive and scientifically accurate HIV language.
• Become familiar with key HIV terms. 

MATERIALS 
• Twelve 6“ by 6“ colored cards, each with an inappropriate term (refer to Hand-out 4C)
• Sweets 

TIME
30 minutes 

HANDOUTS
Hand-out 4B (Language Style Sheet)

PREPARATION INSTRUCTIONS
1. Select six “try not to say“ terms in Hand-out 4B. 
2. Write one term on each 6“ by 6“ card.

WORKSHOP INSTRUCTIONS
1. Tell the group:  “This is a quick-draw game to see how quickly you can spot inappropriate language for

reporting on HIV and correct it. I will hold up cards with HIV-related terms you may see being used in the
media these days. It may not be the best term to use, or it might be. It is up to you to decide. If there is a
more appropriate alternative, I want you to call it out. The first person to shout out the correct language
for each card wins a prize [a small sweet].“

2. Say: “I am just going to demonstrate with [your co-trainer or a volunteer from the group] and then we can
continue.“  

3. Demonstrate using two of the cards as examples. Ask your co-trainer (or a volunteer from the group) to
hold up both of the cards for you, one at a time. Give one correct and one incorrect answer.  

4. Ask the group to help provide feedback. 
5. Hold up the first card. Using the answer key, toss a sweet to the first person with the correct answer.  
6. Go through all of the cards.
7. The group may call out right and wrong answers. If/when a wrong answer is given, provide the correct

answer, explaining why in just a couple of sentences. 
8. Ask: “Why is it important to think about using appropriate language when reporting on HIV?“

Answer: HIV is a relatively “young“ topic that has spawned its own vocabulary. Language needs to
be inclusive to draw a diverse audience.  When reporting on HIV/AIDS, certain words can be
exclusionary, stigmatizing, and discriminatory. Such words all too often turn out to be inaccurate as
well.  What would be some examples of this type of language? 

9. Go back through the cards. Hold up each incorrect term again, one by one.  
10. Ask the group for input on why these terms may send the wrong message.
11. Refer to Hand-out 4B for the answers. 
12. Distribute Hand-out 4B and give trainees 10 minutes to read through it. 
13. Allow for questions and discuss the terms for about 15 minutes.  

This exercise was developed by Jaya Shreedhar. 
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LANGUAGE EDITING EXERCISE #1

LEARNING OBJECTIVES 
By the end of this exercise, participants will: 
• Have practiced how to identify incorrect HIV terms and correct them.

MATERIALS
None

HAND-OUTS
• Hand-out 4B (Language Style Sheet)
• Hand-out 4C (Language Exercise #1 for trainees)
• Hand-out 4D (Language Exercise #1 answer sheet for trainers)

TIME
40 minutes

INSTRUCTIONS 
1. Distribute Hand-out 4C. 
2. Tell the group that this is a rough draft of a radio script that needs some editing for more appropriate

language.  
3. Explain that each person has to identify the wrong terms and replace them with more appropriate terms. 
4. Announce that journalists are allowed to refer to Hand-out 4B (the HIV style sheet) .
5. Ask them to start working on Example 1. Give them 10 minutes to complete it.
6. Once the time is up, ask volunteers to share their edits with the group, and ask the others to provide

feedback.  
7. Use Hand-out 4D as a guide for the correct answers. 
8. Ask trainees to edit Example 2 in Hand-out 4D. 
9. Give them 10 minutes to do so. 
10. Once the time is up, ask volunteers to share their edits with the group, and ask the others to provide

feedback. 
11. Use Hand-out 4D as a guide for the correct answers. 
12. Ask the group: “How would an audience perceive the unedited text version? Do you think the edited

version would be received differently?”
13. Make sure the following points get across: 

When we inject certain attitudes into our stories, they can be infectious and influence the attitude
of our audience. The words we use can at best help shape attitudes or at least help people think
through stigma, denial, and discrimination issues from a different perspective.

14. Conclude by stressing that the language and tone of a story can make a huge difference to the quality of
the radio programs. 

15. Make sure to get the following points across: 
The best radio programs are those that manage to strike a chord in the hearts of your listeners.
Inclusive, sensitive, and caring language can help draw in audiences, not turn them away.  Above
all, appropriate language can potentially make a huge difference in the way someone treats a
person living with HIV.

This exercise was developed by Jaya Shreedhar. 
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LANGUAGE EDITING EXERCISE #2

LEARNING OBJECTIVES 
By the end of this exercise, participants will: 
• Know how to identify incorrect HIV terms and be able to correct them.

MATERIALS
A notebook and pen for each trainee

HAND-OUTS
• Hand-out 4B (Language Style Sheet)
• Hand-out 4E (Henry’s Story – uncorrected version for trainees)
• Hand-out 4F (Henry’s Story – answer sheet for trainers)

TIME
40 minutes

INSTRUCTIONS
1. Introduce the concept of “think words“ to the group. 
2. Ask the group: “What do you think ‘think words’ are?“

Answer:  Much of the preferred HIV terminology grew out of advances in HIV/AIDS science or a
better understanding of behavioral aspects relating to HIV/AIDS. Think about what science has
taught us and how that influences what we say about people living with HIV. The terms do not have
to be memorized; instead, simply think about the reason for the new term or about how an
outdated term may offend. For example, we now talk about people living with HIV, not people
living with AIDS, because medical advances such as antiretrovirals have made it possible for
someone to live with HIV and not progress to AIDS. Thinking about these facts will help you avoid
making mistakes as you interview and write your scripts.

3. Discuss the importance of “think words“ for 5-10 minutes.
4. Distribute Hand-out 4B. 
5. Give the trainees 20 minutes to edit the language in the story for accuracy and appropriateness.
6. Use Hand-out 4F (the answer sheet) to refer to the right answers. 
7. When everyone has finished, ask for volunteers to explain how they edited the story, sentence by

sentence.

This exercise was developed by Ida Jooste. 
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HAND-OUT 4A: FACT SHEET AND CORRESPONDING STATEMENTS
1. Fact

• Many youth between the ages of 15 and 24 are sexually active.   
http://www.unifem.org/gender_issues/hiv_aids/facts_figures.php

Corresponding statement
• India’s National AIDS Control Organisation implements its Adolescent Education Programme across 144,409 

secondary and senior secondary schools with the objective of reaching out to about 33 million students
within two years.
http://www.nacoonline.org/Quick_Links/Youth/School_Age_Education_Program_SAEP/

2. Fact
• A study by the Indian government based on data from HIV sentinel survey centers concludes that about 

10% of HIV infections are due to HIV-infected blood, blood products, surgical instruments, and needles.
http://t8web.lanl.gov/people/rajan/AIDS-india/MYWORK/blood.6.00.html-

Corresponding statement 
• Using new syringes and blood that has been tested for HIV help to prevent the spread of HIV.

www.who.int/bloodsafety/en/ -
3. Fact

• Most HIV infections are in the developing world. http://www.unifem.org/gender_issues/hiv_aids/facts_fig-
ures.php

Corresponding statement 
• Ignorance, poverty, malnourishment, unemployment, and gender inequality exacerbate the epidemic.

http://www.unifem.org/gender_issues/hiv_aids/facts_figures.php
4. Fact

• HIV does not spread through touch or by sharing food. 
http://www.amfar.org/cgi-bin/iowa/abouthiv/record.html?record=7

Corresponding statement 
• Knowledge about how HIV is transmitted helps reduce stigma.

http://www.amfar.org/cgi-bin/iowa/abouthiv/record.html?record=7
5. Fact 

• Many women have no choice in matters of safer sex. 
http://www.amfar.org/cgi-bin/iowa/abouthiv/record.html?record=7

Corresponding statement 
• “In Africa, AIDS has a woman’s face“: Kofi Annan. 

www.un.org/News/ossg/sg/stories/sg-29dec-2002.htm
6. Fact

• Condoms prevent the spread of HIV.
http://www.unfpa.org/upload/lib_pub_file/343_filename_Condom_statement.pdf

Corresponding statement 
• Risky sexual behaviors can lead to HIV transmission. http://www.unfpa.org/upload/lib_pub_file/343_file-

name_Condom_statement.pdf
7. Fact

• Many people living with HIV look healthy.
http://www.avert.org/aidsindia.htm

Corresponding statement 
• People with AIDS lose a lot of weight.

http://www.avert.org/aidsindia.htm
(Continued on next page)
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8. Fact
• One ml of blood has thousands of CD-4 cells. An HIV-positive person has fewer CD-4 cells.

http://www.avert.org
Corresponding statement 
• HIV attacks the CD-4 cells in the human body.

http://www.avert.org
9. Fact

• HIV prevalence is the percentage of the living population infected with HIV at a specific point in time.
http://www.who.int/hiv/pub/epidemiology/pubfacts/en/ 

Corresponding statement 
• A reduction of HIV prevalence could be due to a reduction of new infections or the death of people with AIDS.

http://www.who.int/hiv/pub/epidemiology/pubfacts/en/ 
10.Fact

• There is no vaccine for HIV. 
http://www.youandaids.org/About%20HIVAIDS/Safe%20Sex%20Guide/index.asp

Corresponding statement 
• Safer sex behavior is one of the most effective ways to protect oneself from HIV.

http://www.youandaids.org/About%20HIVAIDS/Safe%20Sex%20Guide/index.asp
11.Fact

• AIDS is the name for a number of diseases that people become more susceptible to through HIV infection.
www.aids.org/factSheets/101-what-is-aids.html

Corresponding statement 
• People with AIDS are extremely vulnerable to such opportunistic infections as TB and certain types of

meningitis. 
www.aids.org/factSheets/101-what-is-aids.html

12.Fact
• Of the top 10 countries with percentage of the population below the poverty line, most are in Africa.

http://www.photius.com/rankings/economy/population_below_poverty_line_2006_0.html
Corresponding statement
• Poverty broadens the spread of HIV. Poorer people generally have less access to information about 

preventing exposure to the virus and fewer treatment options once infected. http://www.undp.org/publica-
tions/annualreport2007/HIV_AIDS.shtml
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HAND-OUT 4B: LANGUAGE STYLE SHEET *

HIV/AIDS language can shape public opinion, perception, and attitudes.  Language should be con-
structive, dispel myths and stereotypes, and not contribute to prejudice.  

When writing about HIV/AIDS, choose your words carefully. Use straightforward and nonjudgmental language
that avoids promoting stigmatization and discrimination.

Try not to use Appropriate language
Aids or aids 
AIDS is the acronym for acquired immunodeficiency syndrome.  Use all capital
letters. Using lower case letters is incorrect.

AIDS

AIDS virus
There is no “AIDS virus.“  The virus associated with AIDS is called the human
immunodeficiency virus or HIV.

HIV

AIDS sufferers
Many people living with HIV are healthy and happy. People living with HIV can
have periods of relatively good health. They may object to being portrayed as
suffering. The term implies that they are powerless with no control over their lives.

HIV-positive/ HIV-infected/
person or people living
with HIV or PLHIV

HIV-positive or HIV-infected
AIDS is not a virus or disease but a syndrome of opportunistic infections and
diseases. Thus, one cannot be infected with AIDS.

AIDS-infected

Try not to use Appropriate language
AIDS disease
AIDS is a syndrome that makes one vulnerable to a number of diseases
(opportunistic infections) due to a damaged immune system. AIDS itself is 
NOT a disease.

AIDS

AIDS carrier 
No one carries AIDS. AIDS is the stage where an individual’s immune system is
damaged by HIV, leaving the person vulnerable to opportunistic infections.

Person living with HIV or 
HIV-positive

AIDS patient 
Use “AIDS patient“ only to describe someone who has AIDS and who is, in the
context of a story, in a medical setting. Most of the time, a person with AIDS is
not in the role of a patient.

Person living with HIV or 
HIV-positive

AIDS victims or innocent victims
People with AIDS are not victims. Calling someone a victim implies
powerlessness. 
“Innocent“ is generally used when talking about children who are infected.  This
implies that others living with HIV are “guilty.“

To have AIDS or live with
AIDS
Avoid using descriptive
adjectives.

AIDS victims or sufferers
This term is sometimes used to cover people affected by HIV as well: partners,
parents, caregivers. 
The word “victim“ has negative connotations. Use the less slanted phrase “person
with AIDS.“ And use it only when the person you are referring to actually has
AIDS. A person who is HIV-infected does not necessarily have AIDS.

Person living with HIV or
PLHIV
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* Special thanks to Internews, the Kaiser Family Foundation, the Australian Federation of AIDS Organizations, the
Voice of America, and the African Women’s Media Center for contributions to this style sheet.
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Try not to use Appropriate language
AIDS carrier 
This is a highly offensive and stigmatizing term to many people with HIV and
AIDS. You cannot catch AIDS. This term may also give the impression that people
can protect themselves by choosing a partner based on appearance, or by
avoiding someone known to be living with HIV. It is less stigmatizing and more
accurate to refer to people with AIDS as people with HIV (they’re all infected
with HIV, whether they have progressed to the stage of AIDS or not).

Person or people 
living with HIV or PLHIV 

Catching AIDS
People become infected with HIV (the virus that can lead to AIDS); they don’t
catch AIDS. AIDS cannot be caught or transmitted.  

To become infected with
HIV/contract HIV/
become HIV-positive

AIDS-infected person
People are infected with HIV, not AIDS. AIDS is the name of the syndrome of
illnesses people get as a result of a weak immune system caused by HIV
infection. You can’t get infected with AIDS. 

HIV-infected person

Dying from AIDS
AIDS is not a disease – no one dies of AIDS. People die of a disease such as
tuberculosis (TB) or bronchitis because their immune system is damaged as a
result of HIV infection. 

Dying of HIV-related or
AIDS-related illnesses

Try not to use Appropriate language
Test for AIDS/AIDS testing/AIDS blood test
There is no test for AIDS. The test is a blood test to determine if antibodies to HIV
are present.

HIV antibody test or HIV
test 

Risk group (e.g., unsafe sex, sharing needles)/affected communities
No social, religious, racial, or cultural group is more at risk for HIV disease than
any other group. Erroneously identifying risk groups increases stigmatization
and discrimination. It also lulls people who don't identify with a so-called “high-
risk group“ into a false sense of security. Behaviors put people at risk for
infection, not the groups they belong to.

Risk behavior

Body fluids 
Confusion about the body fluids that can transmit HIV is a common cause of fear
and misunderstanding about HIV and contributes to discrimination against
PLHIV. Explain which body fluids contain HIV in sufficient concentrate to be
implicated in HIV transmission (i.e., blood, semen, pre-ejaculate, vaginal fluids,
and breast milk). HIV cannot be transmitted through such body fluids as saliva,
sweat, tears, or urine.

Blood, semen, 
pre-ejaculate, vaginal 
fluids, breast milk

Risk of contracting AIDS/risk of AIDS infection/transmitting AIDS
AIDS is not a disease. It is a syndrome. No one is at risk of AIDS, nor can anyone
catch AIDS, or transmit AIDS. Only HIV can be transmitted from person to
person.

Risk of HIV infection /
acquiring HIV infection /
transmitting HIV
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Try not to use Appropriate language

AIDS orphans 
Children who have lost either or both parents to AIDS-related illnesses are
orphans. Yet they may or may not be infected with HIV. The term “AIDS orphan“
sets them apart from other orphans even though the same issues affect their
health and well-being. Distinguishing children as “AIDS orphans“ furthers
stigmatization and discrimination.

Children affected by
HIV/AIDS/ children  
infected with HIV 

Battle/war/fight/struggle/time bomb 
War metaphors are often used to describe the process of HIV prevention. These
metaphors give people an inaccurate or exaggerated understanding of
HIV/AIDS. They may also promote stigma by implying that people living with HIV
are “enemies“ in the “war against AIDS.“

Preventing the spread of
HIV or the response to HIV

Scourge/plague 
Avoid using negative and sensationalist terms for HIV or AIDS, which may fuel
panic, stigmatization, discrimination, and hopelessness. 

HIV epidemic or pandemic

Safe sex
No sex with a partner is ever completely risk-free, even when using a condom.
Condoms may greatly reduce but never fully eliminate the risk.

Safer sex

Try not to use Appropriate language

Promiscuous
Avoid using judgmental and accusatory language.

Having multiple partners

Drug abuser/drug addict/junkie 
References to users as “addicts“ or “abusers“ are alienating. Illicit drug use is only
one part of a drug user's life. Terms such as “junkie“ rely on a stereotyped image,
which is not accurate. Injecting with a contaminated needle is what transmits
HIV, not the drug itself.

Intravenous drug user/IV
drug user/person who
injects drugs/injecting drug
user/people who inject
drugs illicitly/person using
illegal drugs

Homosexual 
The word “homosexual“ is not appropriate in many countries and regions of the
world, where men who have sex with men do not necessarily see themselves as
homosexual.

Men who have sex with
men or MSM

Street walker
This term does not represent the employment aspect of sex work. It is
derogatory and misleading.

Sex worker

Prostitute 
This term is derogatory, insulting, and value-laden.

Sex worker
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Try not to use Appropriate language
General population 
The term “general population“ implies that HIV-positive people are not part of
the general population. It artificially divides the world into those who are
infected, or at risk for HIV infection, and those who are not. It falsely implies that
identity, rather than behavior, is the critical factor in HIV transmission.

HIV-negative people, all
(name the nationality) 
people, all Americans, all
East Africans, the Kenyan
population, etc.

HINT to broadcasters: An effective way to monitor one’s own use of language is to ask
someone else to read your writing and comment. In reporting on HIV/AIDS, the most
effective method is to ask a person with HIV to read material and comment. If this is
impossible, the next best method is to ask someone who works with HIV-positive people to
read the material.
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HAND-OUT 4C: LANGUAGE EDITING EXERCISE #1 (FOR TRAINEES)
Please correct the incorrect HIV language in the two examples below: 
Example 1
The government today announced that it will establish a mobile testing unit that will be available in

various areas of Chennai to test people for AIDS.
The unit would be specifically targeted at prostitutes and other high-risk groups.
However, a government representative said that that the general population would also be able to have the test
at the mobile units to find out if they are an AIDS carrier.
In Tamil Nadu the AIDS plague has been largely contained within high-risk populations.

Example 2
A school in Chennai today announced today that it would not allow AIDS-infected orphans to attend classes.
The headmistress of the school said that the young AIDS victims posed a serious risk to the rest of the school
population and that she reluctantly had to deny access to them.
The young children, who all caught AIDS from their parents, will continue to attend private classes at their
orphanage.
A representative for a group representing the rights of AIDS sufferers said that the banning of the children was
unfortunate, since the young sufferers were innocent victims in the AIDS plague. 
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HAND-OUT 4D: LANGUAGE EDITING EXERCISE #1 (ANSWER SHEET FOR TRAINERS)
Example 1
The government today announced that it will establish a mobile testing unit that will be available in
various areas of Chennai to test people for HIV.

The unit would be specifically targeted at sex workers and other groups who regularly engage in high-risk
behavior.
However, a government representative said that that the Indian population would also be able to have the test
at the mobile units to find out if they were infected with HIV.
In Tamil Nadu the HIV epidemic has been largely limited to people engaging in high-risk behavior.

Example 2
A school in Chennai today announced today that it would not allow orphans infected with HIV to attend classes.
The headmistress of the school thinks that children with HIV pose a serious risk to the rest of the school popula-
tion and said that she reluctantly had to deny access to them.
The young children, who were born with HIV infection, will continue to attend private classes at their shelter.
A representative for a group representing the rights of people living with HIV said that the banning of the chil-
dren was unfortunate, since HIV is not transmitted by studying or playing together and that the children had
every right to study alongside uninfected children in mainstream schools. 
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HAND-OUT 4E: HENRY’S STORY (UNCORRECTED VERSION FOR TRAINEES)
Henry doesn’t know when he contracted the Aids virus. He just knows that now he is stuck with it
forever. Worse still, he’ll leave behind two Aids orphans. His brother, too, was an Aids sufferer; the
scourge took him at a young age.

Henry blames it on a prostitute they both knew when they were at university. She must have been an Aids carri-
er. When he finally went for an Aids test, he kind of knew what the outcome would be. The HIV virus was in his
body and was there to stay. 
Risky behavior is the surest way of catching it. If you have sex with an AIDS carrier, you put yourself at risk of
becoming AIDS-infected. There are at least 1 million AIDS patients in Kenya; among these sufferers, 60% are
women. It is because of promiscuity that the plague is still with us. There is a marked increase in Aids cases in
rural areas.     
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HAND-OUT 4F: HENRY’S STORY (ANSWER SHEET FOR TRAINERS) 
Henry does not know when he became infected with HIV. He just knows that now he will live with it
forever. Worse still, he’ll leave behind two children orphaned by AIDS. His brother, too, was HIV-posi-
tive; he died of an AIDS-related illness at a young age. 

Henry blames it on a sex worker/woman selling sex they both knew when they were at university. She must
have been HIV-positive. When he finally went for an HIV test, he kind of knew what the outcome would be. The
virus was in his body and was there to stay.
Most people with HIV become infected through unsafe sex. If you have sex with an HIV-positive person, you put
yourself at risk of infection. At least 1 million Kenyans are HIV-positive, of whom 60% are women. It is because of
unprotected sex that HIV is still with is. There is a marked increase in the incidence of HIV in rural areas. 
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HAND-OUT 4G: HIV IN CONTEXT
HIV: A Development and Human Rights Crisis
From an emerging health problem two decades ago, HIV/AIDS has transformed itself into a devastat-
ing development challenge facing the world today. In many parts of the world, the epidemic's

impact on the entire spectrum of human development has been catastrophic. It has deepened poverty,
reversed achievements in social development, worsened gender inequalities, and eroded the ability of govern-
ments to maintain essential services. It has killed millions of people during their most productive years,
orphaned millions of children, reduced labor productivity, and reversed economic growth.

HIV/AIDS, Marginalization, and Poverty:  The Vicious Cycle
Though the genesis of the HIV/AIDS epidemic has been different in different countries, over the years it has
become starkly clear that globally the bulk of the disease burden is borne by the poor and socially marginalized.
More than 90% of people living with HIV/AIDS are in less-developed countries. Global experience has conclu-
sively established that such poverty-related factors as unemployment, lack of services, power imbalance within
societies, and social marginalization increase vulnerability to HIV.
The worst affected are the countries of sub-Saharan Africa and South and Southeast Asia, which are among the
nations with the lowest human development indices, large pools of poverty, huge gender inequality, social
instability, and so on. Of the 38.6 million people living with HIV/AIDS in the world, more than 24.5 million are in
sub-Saharan Africa and Asia. Within these countries, the least privileged and the marginalized account for the
majority of the infections.

Women: Powerless at the Center of the Epidemic
Women are biologically more vulnerable to HIV than men. Gender inequality also increases their vulnerability by
rendering them powerless and poor. Women are thus rarely in a position to control risk and avoid infection.
Because of their low social status, women lack access to information and services, which hinders preventive
efforts from reaching them. Women who become infected are often victims of violence, both physical and men-
tal. In India, a UNIFEM survey revealed that many HIV-positive women experience neglect by medical staff, who
refuse to touch them or give them injections. On the other hand, when it comes to caring for the HIV-infected
and -affected, women bear most of the burden.

HIV and Human Rights
Many of the people who have been and will be most affected by the epidemic are people who are already in a
socially disadvantaged position. Increasingly, inequalities of gender, race, and wealth are emerging in the
demography of HIV infection, with infection rates increasing disproportionately among women and even more
so among poor women. The people who remain vulnerable are those who are denied the means of protecting
themselves against HIV because of economic need, for example, or powerlessness to control their sexual rela-
tionships. 
Many factors come into play here, including poverty, geographic isolation, inadequate health care and health
education, and cultural values that expose some members of the community to the risk of HIV transmission. This
implies that the need to incorporate human rights concerns into HIV policy has a particular resonance. As
Justice Michael Kirby from Australia’s High Court has said, human rights matter most when they are most under
threat.

Human Rights Law and HIV
Discrimination against people with HIV is a deep and pervasive problem exacerbated by the social and econom-
ic marginalization of those affected by the epidemic. No program to address the epidemic can afford to ignore
the fact that HIV threatens human rights as profoundly as it threatens public health.

(Continued on next page)
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The principles that should guide legal policy on HIV are very simple:
• The law can and must be used to establish a protective and supportive rather than a punitive framework for

people affected by the epidemic.
• Careful and informed ethical debate can guide the evolution of laws related to HIV
• The law can be used actively as an instrument against discrimination (e.g., companies that use someone’s HIV-

positive status as a reason for dismissal can be taken to court and, if found guilty, be asked to reinstate the per-
son or pay damages). 

• Only an informed group of engaged lawyers can successfully tackle the legal and human rights issues 
associated with the epidemic.

The information in this hand-out comes from:
http://www.undp.org/hiv/focus01.htm 
http://www.youandaids.org/Themes/HIV&Development.asp
http://www.youandaids.org/Themes/HumanRights.asp#human
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chapter 5

Training Agendas

Learning objectives
After working through this chapter, the trainer will: 

1. Be able to structure training workshops by using the exercises provided in this manual.

2. Have access to a generic training agenda that can be adjusted.

Why is it important to be able to develop 
good training agendas?
Developing effective training agendas is a skill that comes with considerable practice and
experience. It takes a few workshops to progress to the stage where you become realistic
about time allocations for individual training sessions and are able to design creative, tailor-
made training exercises quickly. But once you’ve mastered these skills, developing training
agendas becomes second nature and consumes far less time.

This chapter provides a generic training agenda that includes all the exercises marked “essen-
tial“ in this manual. The agenda is based on a seven-day workshop. It is not set in stone – it
offers adaptable guidelines. Please note that all Local Voices training provides trainees with
recorders to use during workshops as well with access to computers and internet for the dura-
tion of the training. The training agenda therefore contains several activities that require such
equipment. 

The same type of exercises are generally used by all Local Voices programs, but the amount of
time allocated to teaching certain skills differs depending entirely on context and the training
needs of the local journalists in a particular country. In Kenya, workshops are five days long
because reporters are able to return to the Local Voices office in the week following the train-
ing workshop to produce their stories (the LV office is within walking distance of most media
houses). In Ethiopia, training workshops are six and a half to seven days long, because some
journalists come from distant regions. Even trainees in Addis Ababa find it challenging to
return to the Local Voices office for long periods at a time, so the production days are built into
the weeklong training program. In Nigeria, Local Voices training courses are six days long,
slightly shorter than those in Ethiopia. And in India, most journalists are familiar with sound-
recording equipment and digital editing software; workshops are therefore often shorter than
five days, since little time is needed for refining participants’ recording and editing skills.  
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The generic training agenda in this chapter therefore needs to be adapted for the journalists’
training needs in the country where you are training. In principle, it generally takes at least six
and a half days to seven days to ensure the production of high-quality features. Most inde-
pendent training programs don’t have the luxury of a Local Voices office to which trainees can
return for production (as in the case of Kenya), which is why this chapter focuses on a six-and-
a-half to seven-day training agenda.

Please note that there is no need for you to hire a studio to do interviews. If you don’t have
access to a studio, interviews can be recorded on flash recorders in the corner of a quiet room.
It is also possible to record links/voicers on recorders and transfer them onto computers with
digital editing software. 

The training agenda has been saved on the manual CD so that you are able to adjust it.  

Exercises 
None

Hand-outs
None
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SEVEN-DAY WORKSHOP PROGRAM: DAY 1

9:00 – 9:30 
Arrival and morning tea

Many journalists arrive late on the first day of the workshop. Plan for this by
including 30 minutes for them to arrive on the first day’s training agenda – that
way you won’t end up having to readjust the times of all the other slots later that
day. 
Note: If you would like trainees to fill out a pre-questionnaire, as described in Chapter
13, they should fill it out as close to the beginning of the workshop as possible.

9:30 –    10:00
Workshop opening

Explain the logistics and rules of the workshop (getting there on time, cell
phones off, per diems, etc.). Use one or a combination of the following: 
• The Ten Commandments Exercise in Chapter 6 (15 minutes)
• Ask trainees to make up their own rules and write them on a flipchart
• Explain your organization’s rules for training workshops

10:00 – 10:30 
Introductions

Make sure there’s enough time for everyone to introduce themselves. Use one 
or a combination of the following:
• Mix-up Exercise in Chapter 6 (5-10 minutes)
• Two Truths and One Lie Exercise in Chapter 6 (20 minutes for 10 participants)
• The Quiz Exercise in Chapter 6 (10-15 minutes)
• Go around the table and allow participants to introduce themselves and give

background on their careers and reasons for attending the training workshop

10:30 – 11:15
HIV icebreaker/energizer

The purpose of an HIV icebreaker or energizer here is to introduce participants to
HIV. Use one or a combination of the following: 
• The Housewife and the Sex Worker in Chapter 6 (15 minutes)
• Realizing Your Risk of Contracting HIV in Chapter 6 (30-35 minutes)
• Sexuality in Chapter 6 (30 minutes)
• Create a questionnaire with 5 HIV questions about the country where you’re

training (e.g., “How many people are HIV-positive in [the country]?“). Ask 
trainees to fill it out and discuss the answers afterwards.

11:15 – 11:30 
Break

11:30  – 12:30  
What is the media’s role in
the response to HIV?

The purpose of this session is to get trainees to explore what the news media’s
role is in the response to HIV. Do one of the following: 
• Find the Links: Covering HIV/AIDS in Chapter 4 (1 hour)
• Play an HIV radio feature/clips of a talk show that has had an impact on the

response to HIV and follow it up with a general discussion of the role of the
media in the response to HIV/what makes HIV reporting different? 

• Invite an experienced HIV radio journalist (possibly one of your previous 
trainees) to play a story that has had an impact and start a discussion about 
the role of the media in the response to HIV.  

12:30 – 1:30 
Lunch
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1:30 – 2:30  
Demystifying HIV/What
makes HIV different?

The purpose of this session is to help trainees to develop a more in-depth
understanding of HIV. Do one of the following: 
• Find the Links: Covering HIV/AIDS Exercise in Chapter 4 (1 hour)
• Invite an HIV expert for an hour to answer trainees’ questions – the expert 

should not make a presentation but rather lead an informal session during
which participants may ask any questions they have about HIV (e.g., “Can my
child get infected at school?“ or “How do I know if my partner is HIV-positive?“). 

2:30 – 3:30   
The language we use

The purpose of this session to help journalists understand the importance of
scientifically accurate and politically sensitive HIV language. Do two of the
following bullet points:
• Flash Card Game: Teaching Appropriate HIV Language Exercise in Chapter 4

(essential: 30 minutes), or go through the list of appropriate language provided
in Chapter 4 

• Language Editing Exercise #1 in Chapter 4 (40 minutes)
• Language Editing Exercise #2 in Chapter 4 (40 minutes) 

3:30 – 3:45 
Break

3:45 – 5:15
Interviewing skills 

It’s essential to have a session on interviewing skills prior to the presentation and
interview with the first speaker (the HIV expert). Do a combination of the
following: 
• The Listening Game Exercise in Chapter 8 (20 minutes)
• Avoiding Yes and No Is the Way to Go Exercise in Chapter 8 (40 minutes)
• What Do I Ask? Whom Do I Ask? How Do I Ask? Exercise in Chapter 8 (1 hour)
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DAY 2

9:00 – 9:30 
Preparation for guest
speaker

The purpose of this session is to introduce trainees to the subject the expert will
be addressing; this helps them to better understand the expert’s presentation: 
• Create a questionnaire with five questions about the theme of the workshop. 

For example, if the theme is ART, include such basic questions as “What does 
ART stand for?“ or “Can ART cure a person of AIDS?“ Get trainees to fill out the
questionnaire and discuss the answers. 

9:30 – 10:10
Guest speaker’s
PowerPoint presentation

It is important to work with experts beforehand to ensure the presentations are
relevant to journalists. If that is impossible, communicate clear instructions to the
presenter and emphasize that the presentation should be no longer than 40
minutes, preferably 30 minutes. Explain that journalists like asking questions and
that there will be ample time to share more information during a Q and A session
after the presentation. Also make sure that the expert is aware of the studio
interviews with the journalists and that he or she allocates enough time for the
entire session (about three hours altogether).

10:10 – 10:40 
Q and A with guest
speaker

This is an opportunity for trainees to ask questions about the presentation. These
questions and answers are not recorded – the session happens at the training
table. The purpose of the session is to allow trainees to clarify what is not clear
without worrying about whether or not the answers make for good sound bites.

10:40 – 11:00 
Preparation for interview
with speaker

Divide participants into two groups. Get each group to draw up 10 short
questions to ask the expert. Guide participants toward the questions that will
lead to good sound bites. It’s fine if the two groups have very similar questions,
since they all need the “basic“ sound bites for their features. Allow each
participant to  ask two questions. Be sure to establish the order of the questions
before the interview starts.
Note: The reason why participants interview the expert as well as the case studies at
the training venue is threefold. First, it allows for intensive mentoring for the
preparation and execution of the interviews. Second, it ensures that at least one
sound bite is in the can for the feature that each trainee needs to produce. Finally, it
enables trainers to control the length of interviews. You need three voices in a basic
HIV human interest feature produced at a standard Local Voices training workshop:
an expert, a human face (PLHIV), and a counselor. Ideally, each trainee should do his
or her own interview, but in a group of 10 participants, this is impractical – an expert
or case study can’t do 10 interviews.

11:00 – 11:40
Studio interviews

Get the trainees to sit in a half circle around the expert in the studio (if you don’t
have access to a studio, let them sit in the corner of a quiet room and record the
interview with a flash or minidisc recorder). Be sure each trainee records the
interview. Each group has 10 minutes for its interview. Stick to this time
allocation, or participants will have too much to transcribe.
Note: No break has been scheduled for the morning, since each group will get a 15-
minute break while waiting for the other group to interview.
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11:40 – 12:00 
Discussions on how
interviews went

Ask trainees to share their experience of the interviews – what they did well and
what they could have done better. You can also play back and critique one of the
interviews while everyone listens.

12:00 – 1:00 
How do I select a sound
bite?

The purpose of this session is to help trainees gain the skills to select sound bites
from the interviews they will be doing in the training workshop.
• Listening for Sound Bites Exercise in Chapter 8 (1 hour)

1:00 – 1:15 
The importance of
transcribing

Explain the importance and purpose of transcribing and that trainees will be
expected to transcribe all their interviews, not just the sound bites they will be
using. Explain how to indicate time codes, etc. Show trainees an example of a
transcription. 

1:15 – 2:15 
Lunch

2:15 – 3:45 
Sound recording • Recording Sound Exercise in Chapter 10 (1 hour, 30 minutes)

3:45 – 4:00
Break

4:00 – 5:00 
Introduction to digital
editing

• Transferring Sound into a Computer Exercise in Chapter 11 (1 hour )

Evening: transcribe the
expert’s interview and
choose two good sound
bites

If you did the interview in a studio and recorded it on Adobe Audition, transfer
the interview onto the flash disc or minidisc recorder of each trainee before they
leave for the day. They need to transcribe the interview with time codes for
homework. Those who don’t type fast may prefer to transcribe by hand.
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DAY 3

9:00 – 9:30
Discussion about
transcribing and 
selecting sound bites 

You’re likely to get many complaints about the tediousness of transcribing. Be
sympathetic, but re-emphasize the importance of transcribing. Allow a few 
trainees to read out their two selected sound bites and give feedback.  

9:30 – 10:15 
PLHIV: Giving HIV a 
human face

Invite two case studies relating to the HIV theme of your training workshop. For
example, if the theme is counseling and testing, invite two PLHIV who have 
tested positive for HIV, or if the theme is PMTCT, invite two HIV-positive mothers
who have HIV-negative babies as the result of accessing PMTCT services. 

10:15 – 10:45
Q and A with PLHIV/case 
studies

Allow trainees to ask case studies questions. By now, trainees should understand
why they need to be sensitive to PLHIV (on the first day they attended several
sessions that should have prepared them for this). 

10:45 – 11:00 
Preparation for interviews

Divide participants in two groups. Get each group to interview a case study. 
Guide participants with the questions. It’s fine if the two groups have very similar
questions, since they all need the “basic“ sound bites for their features. Allow
each participant to ask two questions. Make sure to establish the order of the 
questions before the interview starts. 

11:00 – 11:30 
Studio interviews

Get the trainees to sit in a half circle around the case study in the studio (if you
don’t have access to a studio, let them sit in the corner of a quiet room and each
record the interview with a flash or minidisc recorder). Each group has 10 
minutes to interview. Stick to this time frame, or participants will have too much
to transcribe.

11:30 – 11:45 
Discuss studio interviews

Ask trainees to share their experience of the interviews – what they did well and
what they could have done better. You can also play back and critique one of the
interviews while everyone listens.

11:45 – 12:00 Break

12:00 – 1:00
Recording techniques Recording Sound in the Field Exercise in Chapter 10 (1 hour)

1:00 – 2:00 
Lunch

2:00 – 4:00  
Digital sound editing

• Editing and Saving Audio Files Exercise in Chapter 11 (essential, 1 hour, 30
minutes)

• Manipulating Sound Exercise in Chapter 11 (essential, 30 minutes)

4:00 – 5:00 
Transcribing the case 
study interview

Those who don’t manage to finish the transcribing in this session need to finish it
at home or at the hotel that evening.
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DAY 4

9:00 – 12:00 
Scriptwriting
(Include two 15 minute
breaks between exercises)

• An Introduction to Writing for Radio Exercise in Chapter 9 (20-30 minutes)
• Practicing How to Write for Radio Exercise in Chapter 9 (45 minutes to 1 hour )
• What Does a Radio Feature Script Look Like? Exercise in Chapter 9 (20-30

minutes)
• How to Write to Natural Sound Exercise in Chapter 9 (20-30 minutes)

12:00 – 12:15 
Break • Fruit Salad Game Exercise in Chapter 6 

12:15 – 1:15  
Sound recording • Recording Sound in the Studio Exercise in Chapter 10 (60 minutes)

1:15 – 2:15  
Lunch

2:15 – 4:15 
Digital sound editing

• Assembling Edited Audio Files in a Multitrack Session Exercise in Chapter 11 (1
hour, 30 minutes)

• Mixing and Saving/Exporting Audio Files Exercise in Chapter 11 (1 hour, 30
minutes)

4:15 – 5:15 
Doing research for 
your stories

• Do a shortened version of the Teaching Basic Research 
Skills Exercise in Chapter 7.
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DAY 6

9:00 – 6:00/late
Production of stories

By mid-morning on Day 6, start to review scripts. You need to spend about an
hour per trainee for initial reviewing and correcting of a script. Once you and the
trainee are finished with making changes to the script, send the trainee to the
sound technician for help downloading interviews onto Adobe Audition and help
with editing the sound bites. Once all the sound bites have been edited, the
trainee is ready to record his or her voice/links with the help of the sound
technician. Carry on for as long as you can on Day 6: the more stories you finish
today, the earlier the workshop can end the next day. 

DAY 5

9:00 – 9:30 
Preparing questions for 
the site visit

Help trainees with ideas for natural sound and questions for interviews with
counselors. Factor in time for getting to the site, attending a welcoming talk, and
getting back to the training venue. 

9:30 – 10:00  
Signing out and checking
recorders 

Make sure everyone’s recorder works and that the batteries have been charged or
reloaded. Always take along your own recorder as well as a back-up. 

10:00 – 1:00 
Site visit

Trainees have already recorded an interview with an expert and a case study. All
that’s left to record is natural sound and an interview with a counselor or similar
person at the site you are visiting. It is important that you explain this clearly, or
many trainees will end up doing several unnecessary interviews that will be time
consuming to transcribe. Instead, use the site visit as an opportunity to do
intensive mentoring on how to record natural sound and interviews with the
counselor/nurse. Do not allow trainees to attempt to record case studies at the
site, since this can result in officials getting upset because of patient
confidentiality issues. 
Logistically, it works best if you divide participants into two groups and let each
group do an interview with a counselor/nurse, similar to the interviews with the
expert and case studies in the studio. 

1:00 – 2:00 
Lunch

2:00 – 5:00 
Transcribing and scripting

Get everyone to transcribe their site visit interviews, identify sound bites of all the
interviews, and arrange them in logistical order on paper. Then get them to write
links. 
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DAY 7

9:00 – 2:30 
Production of stories

Most trainees will be in an advanced stage of production, and some may have
finished their stories by now. You as the trainer may still have to review one or
two scripts of trainees who work slowly. Every trainee also needs to prepare a
cue/presenters sheet with an intro and questions for a live in-studio guest. 

2:30 – 3:30 
Graduation ceremony

• Give each trainee who successfully completed a radio feature plus
cue/presenters sheet a training certificate.

• If time and energy allow, play a few features and critique them.
• Re-emphasize the rules for receiving equipment grants.
• Have snacks available. 

3:30 – 4:00 
Filling out evaluation
forms

Ask each trainee to fill out an evaluation form. See examples: 
• Hand-out 13A: Radio Training Workshop Evaluation Form 
• Hand-out 13B: Post-training Questionnaire: Testing knowledge
Note: If you’d like trainees to fill out a post-training questionnaire, ensure that they
filled out a pre-training questionnaire at the beginning of the workshop. 

4:00 Training ends
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Icebreakers and Energizers
MIA MALAN

Learning objectives 
After working through this chapter, the trainer will: 

1. Be able to explain the role icebreakers play as training exercises. 

2. Be equipped with HIV-related and general icebreaker exercises. 

3. Be able to adjust the icebreakers in this chapter to accommodate the sensitivities of trainees. 

Why is it important to use these skills to train radio journalists?
Variety is important for successful training; icebreakers help achieve that. When participants
meet for the first time, icebreakers can help them get to know one another. Icebreakers also
help trainers generate interest among trainees in a particular subject as well as renew energy
and concentration. They’re particularly handy for transforming potentially uncomfortable situa-
tions into more relaxed, or sometimes even humorous, environments.   

Training is hard work for participants; if there are not enough enjoyable activities to help them
re-energize, they get tired and can’t concentrate. It’s therefore important to incorporate ice-
breakers into your workshops and to schedule them wisely, such as at the beginning of the first
day or during the afternoon on follow-up days, when trainees tend to get tired.   

This chapter provides a selection of icebreaker activities a trainer can use to teach journalists
about HIV transmission, as well as more general icebreakers that can be used to liven up a train-
ing session. They are not country specific, but you may want to adapt them to better suit local
cultures and sensibilities. These are icebreakers most commonly used in our Local Voices field
offices. All the exercises have been saved on the manual CD, should you like to make changes.

While all icebreakers are optional, they’re strongly recommended.  

How much time do I need to allocate to mastering this skill? 
• One hour in total during formal training days (about 20 minutes per day).

• About 30 minutes during the last two production/mentoring days (about 15 minutes 
per day). 
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Exercises

• Mix-up (5-10 minutes)

• Two Truths and One Lie (20 minutes for 10 participants)

• The Quiz (10-15 minutes)

• The Ten Commandments (15 minutes)

• Fruit Salad Game (5-7 minutes)

• The Housewife and the Sex Worker (15 minutes)

• Realizing Your Risk of Contracting HIV (30-35 minutes)

• Sexuality (targeted at journalists in their twenties) (30 minutes)

Hand-outs

6A The Ten Commandments 

6B Background for Trainer (The Housewife and the Sex Worker Exercise)

6C How Is HIV Transmitted? (Realizing Your Risk of Contracting HIV)
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MIX-UP
LEARNING OBJECTIVES
By the end of this exercise, participants will:
• Know each other’s names 
MATERIALS
• A name card for each participant
• A hat/holder/bag to put the cards in 
HAND-OUTS
None
TIME
5-10 minutes

INSTRUCTIONS
1. Mix up the name tags and put them in a holder/bag.
2. Send the holder around the training table or pass it around the coffee table as trainees arrive; let each

person take one name tag.
3. Ask participants to find the rightful owner of the name tag and find out two interesting things about that

person.
4. When the training group is organized around the table, each person has to introduce the person whose

name tag they picked to the rest of the group by sharing two interesting facts about them.
Note: You can also use this as an icebreaker activity between sessions by using postcards. Cut the postcards in half,
distribute them, and ask all participants to find the other half of their postcard and introduce themselves.

This exercise was developed by consultant trainer Virginia Moncrieff.

EXERCISES

THE DO’S AND DON’TS OF ICEBREAKERS
Icebreakers can:
• Help people to relax.
• Help participants get to know each other.
• Be used as lead-ins before training sessions on HIV transmission.  
Do:
• Make the instructions as clear and simple as possible. 
• Have a back-up plan. If the icebreaker isn’t working, you will need an alternative activity!
Don’t:
• Introduce an icebreaker game that will make others uncomfortable; be alert to the culture and

sensibilities of your trainees. 
• Limit icebreakers to the beginning of a workshop day or session. Use them to re-energize the group

at any time.
• Force people to participate. 

–Mia Malan Internews Senior Health Journalism Advisor
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TWO TRUTHS AND ONE LIE

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Know at least two things about each other. 
• Feel more comfortable with each other. 
• Appreciate one another better.

MATERIALS
None

HAND-OUTS
None 

TIME
Allot about two minutes per participant. For example, if there are 10 trainees, the exercise will take 
about 20 minutes. 

INSTRUCTIONS
1. Get the journalists to sit around a table or in an informal circle. 
2. Ask them to share three things about themselves. Tell them two of the things have to be true and one not.

But the lie must not be obvious. 
3. Start with yourself (the trainer). Try to make the “lie“ not obvious, but as interesting as possible. 

For example: “I was born in Nairobi (true), I have a degree in journalism (lie), and I have worked as a
journalist for 10 years (true).“

4. Ask them to spend about a minute guessing which of your three things are true and which one is not; allow
one minute. 

5. Tell them the truth and then move onto the next trainee. 
For example: “I don’t have a degree in journalism; I studied teaching, and just ended up in journalism
along the way.“

6. Ask the participants to repeat what you’ve done. 
7. Repeat until all trainees have had a chance to share information about themselves. 

This exercise was developed by Virginia Moncrieff and Jaya Shreedhar. It is regularly used in the India Local Voices office.
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THE QUIZ

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Know each other better.
• Interact more comfortably with each other.
• Be energized!

MATERIALS
Cards with 7 to 10 tasks. You need a card with exactly the same tasks for each participant.

HAND-OUTS
None 

TIME
10-15 minutes 

INSTRUCTIONS
A few days before the training: 
1. Do a little research on the town/country in which the training is taking place to find tasks for your quiz – you

need seven to ten tasks. (In-country/national staff are excellent research sources!)
2. The tasks need to be relevant and culturally sensitive to the country where you’re training. 

For example: in Pakistan, trainer Virginia Moncrieff developed the following tasks: 
• “Find someone who likes Ashwaiyra Rai.“
• “Find someone who can name five members of the English cricket team.“
• “Find someone who can sing the last four lines of the National Anthem.“ 
• “Find someone to tell you a funny joke.“ 
• “Find someone who owns a purple piece of clothing.“

3. Write the tasks on all the cards and draw a line at the end of each task for a signature. 
4. Make sure there is a card for each participant. 

During the training:
1. Get everyone to stand up.
2. Ask each trainee to take one card and read the tasks (quietly to themselves). 
3. Explain that each person has to find participants that can answer tasks or perform a required task. Each time

they identify someone to answer a task or perform the task, that person has to sign that he or she has
indeed done so. Encourage lots of noise and energy and movement! This is no time to be mousey!

4. The first person who completes all the tasks has to yell out “Done!“ and gets a small prize. 
5. Get everyone to sit around the training table/coffee table after the session or during a break to go through

the answers.

Note: Local souvenirs work well as prizes!

This exercise was developed by consultant trainer Virginia Moncrieff.
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VIRGINIA MONCRIEFF’S TIPS FOR SUCCESSFUL ICEBREAKERS!

Do your research! One size doesn’t fit all. Make sure you know and understand local cultural, social,
gender, and even religious issues as you plan icebreakers. You can sometimes modify icebreakers,
but they must be appropriate for where you are working!

How you approach the icebreaker makes all the difference. Show lots of energy, enthusiasm, and
commitment. Smile! Show excitement! Be confident! Stand up as you explain the game. Radiate a
feeling that this is going to be so much fun! Your attitude really has an effect on the success of ice-
breakers.

Some icebreakers are just plain old fun and can be almost addictive. “Fruit Salad“ seems to work
even for people who think they are “above“ having fun. It is singularly the simplest but most popular
energizer I have ever used. And it’s just a silly game. (Note: it’s not so good where male-female
touching, even by accident, is an issue.) 

If your enthusiasm doesn’t work on everyone, don’t worry. Some people are just way too cool to play
games. Some people are too shy (and sometimes women may feel restricted). Don’t let their reti-
cence dampen your enthusiasm. Allow people to sit out icebreakers if very gentle encouragement
does not work. Never ridicule, draw attention to, or dismiss anyone who chooses not to join in.

Rewards – a small bar of imported chocolate, a little souvenir pin from your home country, a nice
notebook (nothing expensive) for the “winner“ of a game – are often appropriate. Sometimes just a
round of applause and a cheer is enough.

Most important of all – make sure you use icebreakers. People really do love them and they can
improve your training so much!

–Virginia Moncrieff has consulted for Local Voices on several projects. She spent time with both our
India and Ethiopia projects as a trainer. Virginia is no doubt the queen of icebreakers. 
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THE TEN COMMANDMENTS

LEARNING OBJECTIVES

By the end of this exercise, participants will: 

• Understand the ground rules of the training.

• Be more orderly and attentive during the training session.

• Feel more comfortable with one another and the trainer(s).  

(This is a game to introduce the ground rules of the training session in a fun way.)

MATERIALS

None

HAND-OUTS

Hand-out 5B (The Ten Commandments) 

TIME

About 15 minutes (do not go longer because participants might start to think that it’s a joke). 

INSTRUCTIONS

1. Give each journalist a copy of the hand-out called “The Ten Commandments.“

2. Tell them that the exercise is at the heart of the training and will determine how the rest of the week develops. 

3. In a serious voice, ask 10 participants to each read one commandment aloud and pronounce the words as
distinctly as possible (if there are fewer than 10 trainees, the trainer[s] can also read some of the command-
ments by imitating the voices of court judges).

4. Tell the “readers“ that it’s very important to put as much expression as possible into the words, as these
commandments are very important. 

5. Select a class monitor for commandment eight (see hand-out).

6. The seriousness of the voices and ridiculousness of the old-fashioned wording will sound funny to the
trainees and help them relax and feel more comfortable with each other. 

7. At the end of the exercise, ask trainees to repeat the commandments in “normal“ language and write the
ones they consider most important on a flip chart.

8. Ask everyone to file the hand-out in their training file and keep it with them to refer to throughout the
training.

• Some portions of the commandments can be modified to fit more sensitive environments. In Nigeria, for
example, trainees are comfortable with the wording, but people elsewhere may not be; please adjust
accordingly.

This exercise was developed by Cece Fadope (former Resident Advisor of the Internews/ENHANSE office in Nigeria)
and Anselm Okolo (Media Coordinator). It is regularly used in the Nigeria office. 



The fruit salad game performed by Local Voices trainers at an annual meeting in Nairobi in
August 2007.

ASMA NASEER’S TIPS FOR THE FRUIT SALAD GAME

1. Get everybody in the room to participate. The more participants, the better.

2. Have enough space for people to run around without hurting themselves.

3. Use the names of fruits people are familiar with. Avocado or blueberry will not work in India.

4. The game is best played barefoot.  People could get stepped on while running for the chairs.

5. Anybody taking photos should stand outside the circle where the game is played.

6. Try not to use swivel chairs, which could move when you are trying to sit on them.

–Asma Naseer is the media coordinator of the Local Voices project in India, and a master at playing 
this game.
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FRUIT SALAD GAME

LEARNING OBJECTIVES
By the end of this exercise, participants will:

• Be really refreshed! 

(This is a game to relieve boredom between sessions. It’s ideal when trainees have been transcribing for a few
hours at a stretch.)

MATERIALS
One chair fewer than the total number of people participating in the game

HAND-OUTS
None

TIME
There is no time limit. Ideally the game should be played for 5-7 minutes, which is enough to leave a group
refreshed.

INSTRUCTIONS
1. Put the chairs in a circle. 

2. Ask participants to take off their shoes and put them beneath their chairs. 

3. Ask everyone to sit down on the chairs.

4. The person conducting the game should stand in the center.

5. Give each trainee the name of one of three fruits: APPLE, MANGO, or BANANA.   

6. If the first trainee is an apple, the second trainee is a mango, and the third is a banana. The cycle will start
over with the fourth trainee, who will be an apple, the fifth one a mango, the sixth one a banana, and so
on, until all trainees, as well as the person conducting the game, have the name of a fruit.

7. Call out the name of a fruit (e.g., apple). 

8. All trainees named apple, including the person conducting the game, exchange seats with each other,
leaving one person in the center of the circle. (The rest of the fruits – in this case, the mangos and
bananas – remain seated). 

9. This person then calls out the name of a fruit again; all those named with that particular fruit exchange
seats.

10. When the person in the center calls out fruit salad, all the participants exchange seats.

11. Repeat.

Note: As the game involves running in a limited space, participants should be asked to remove their shoes, to avoid
injuring one another. 

This exercise was developed by consultant trainer Virginia Moncrieff. It is regularly used by the India Local Voices
office.
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THE HOUSEWIFE AND THE SEX WORKER
LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to challenge stigmatized assumptions about the risk of HIV infection for certain populations.
• Better understand why everyone who has unprotected sex is at risk of HIV.
• Understand why it is important to use this information in their stories.

MATERIALS
• Two pieces of A4 paper 
• Marker
• Sticky tape 

HAND-OUTS
Hand-out 6B (Background For Trainer)

TIME
15 minutes

INSTRUCTIONS
Note: Make sure you are familiar with the contents of Hand-out 6B prior to begining this exercise.
1. Use the marker to write SEX WORKER, MS……. (use a common local last name to make the exercise more

appropriate and personal) on the first piece of paper, and HOUSEWIFE, MRS. ….. (use a different common local
last name) on the second piece. Do not show trainees what is on the pieces of paper before the exercise. 

2. Tell participants you’re going to play a game and need two female volunteers. 
3. Ask two volunteers to stand in front of the class and tell them they’re each going to be a character. 
4. Tape the first piece of paper to one of the volunteers. Say: “[name of volunteer] is a sex worker. She works

at a brothel in the city that enforces a policy of 100% condom use. She has many, many clients from all
walks of life. She’s a busy woman!“  

5. Tape the second piece of paper to the second volunteer. Say: “[name of volunteer] has a very different
occupation! She’s a housewife of a very influential army general, General ….. [make up a last name]. She’s a
very loyal wife and would never cheat on her husband. General …. [name] travels regularly, as he has to
visit all the different army camps in …. [name of country]. He has to make sure that everything in the army
works well!“  

6. Trainees are likely to laugh a little at the two characters. Ask the “characters“ to greet the class and ask the
class to welcome them to liven things up a little. 

7. Pose the question: “Which woman – Ms. ….. [name] or Mrs. [name] – is more at risk of HIV infection?“
8. Allow the group to discuss this and to ask the volunteers questions. The objective is to get them to think

about the common assumption that the average woman next door is unlikely to be infected with HIV, but
all sex workers are infected. 

9. Allow trainees to argue about who is more at risk (for about 5-7 minutes). Points to raise: 
• Is the sex worker at risk of HIV infection if she always uses condoms? 
• What if the condoms break? 
• Does the fact that the army general often travels away from home make him more vulnerable to

HIV infection? 
• Does the housewife have control over the traveling husband’s sexual behavior? 
• Would the housewife be in a position to demand that she and her husband use condoms during sex?

(Continued on next page)
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10. In most cases, participants come to realize that – in this case – the housewife with a traveling husband is
more at risk of HIV infection than the sex worker. Explain the reasons to the class.  

Answer:
• The housewife is unlikely to have control over her husband’s sexual behavior when he’s away from

home. She’s unlikely to be in a position to demand that her husband use a condom during every
single sexual encounter between the two of them. 

• In addition to abstinence, condoms are the most effective known way to protect oneself from HIV
infection. According to UNAIDS, condoms reduce the risk of HIV infection by about 90% (see
background document). If the sex worker uses a condom correctly 100% of the time, she should
be able to protect herself against HIV infection to a large extent. It is obviously possible for
condoms to break during sex, but the condom is unlikely to break every single time.

Source: UNAIDS. 2004. Making condoms work for HIV prevention.
http://www.champnetwork.org/media/unaids.pdf

This exercise was developed by Elizabeth Gold and Mia Malan of Internews Network.
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LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to describe the most common way HIV is transmitted.
• Be able to explain why HIV infection is not transmitted via saliva.
• Understand why it is important to use this information in their stories.

MATERIALS
• Gum or lollipops (at least one sweet per participant, preferably more) 
• A chair for each participant

HAND-OUTS
Hand-out 6C (How is HIV transmitted?)

TIME
30-35 minutes

INSTRUCTIONS
1. Get the trainees to sit in an informal circle. They should sit close enough to be able to hand a sweet to the

next person. The trainer should join the circle. 
2. Make sure everyone is comfortable – ask trainees simple questions that will help them to feel at ease with

you (e.g., “Was the traffic heavy this morning?“ or “Did everyone manage to get a cup of coffee this
morning at the training venue?“) 

3. Take the sweets out and pass the packet around the circle. Invite everyone to take a sweet. 
4. Ask participants to each put a sweet in their mouths. You (the trainer) should take a sweet as well.
5. Allow everyone to chew/suck the sweet for 10-20 seconds but not to swallow them. 
6. Ask participants to remove their sweets from their mouths and to hold them in their hands.
7. Ask everyone to swap sweets with the person next to them. (Trainees will naturally be appalled and say

they don’t want to do that.) 
8. Act surprised and ask: “Why don’t you want to swap the sweets? What’s wrong with that?“
9. Allow trainees to state their reasons. The reasons will most likely range from “It’s disgusting and unhealthy“

to “I don’t want to share someone’s bodily fluid or saliva.“
10. Ask why they are not willing to share the sweets, yet they’re willing to share genital parts and bodily fluids

that are far more intimate during sexual encounters. Point out that that is much more dangerous than
sharing saliva. 

11. Let trainees express their thoughts and give them about two minutes to talk to each other about it. 
12. Let them share their views with you for about three to four minutes. 
13. Announce that you would like to talk to them about the different ways in which they can contract HIV and

how to protect themselves against it.  
14. Ask who can tell you the most common way HIV is contracted.

Answer:
Unprotected heterosexual sex with an HIV-infected partner (i.e., sex without a condom). (The virus
can enter the body through the lining of the vagina, vulva, penis, rectum, or mouth during sex.)

(Continued on next page)
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• Men who have sex with men (MSM) are also susceptible to infection, if the partner is HIV-infected.
However, heterosexual sex is the most common mode of infection, because more men have 
heterosexual sex than sex with one another.  

Source: National Institutes of Health (http://www.niaid.nih.gov/factsheets/hi inf.htm) 
• In some countries, injection drug use (IDU) strongly drives the epidemic. For instance, in Guangxi

Province in China, HIV infection among injection drug users accounts for up to 69% of the total
number of reported cases.

Source: Liu, W. et al. 2006. HIV prevalence among injection drug users in rural Guangxi, China. Addiction
101:1493-1498.

15. Once it has been established that the most common mode of HIV transmission is unprotected heterosexual
sex, ask trainees: “Why would it be more dangerous to share genital parts than to share saliva?“

16. Allow the trainees to share their views for three to four minutes. 

17. Share the correct answer with participants. 
Answer:
• Four bodily fluids contain HIV in a high enough concentration to be passed on if even a small

amount of them enters the bloodstream. These fluids are blood, semen – including pre-cum – and
vaginal fluids. During unprotected vaginal and anal intercourse, tiny, unnoticeable cuts or
abrasions in the vagina, anus, or penis can allow infected blood, semen, or vaginal fluids to enter
the bloodstream.  

• Although researchers have found HIV in the saliva of HIV-infected people, there is no evidence
that the virus is spread by contact with saliva. Laboratory studies reveal that saliva has natural
properties that limit the power of HIV to infect, and the amount of virus in saliva appears to be
very low. Research studies of people infected with HIV have found no evidence that the virus is
spread to others through saliva by kissing. The lining of the mouth, however, is vulnerable to HIV,
and instances of HIV transmission through oral intercourse have been reported.

• HIV infection is only possible when a sufficient quantity of the virus enters your bloodstream. For
this to happen with saliva, around seven liters would have to be injected or swallowed. If saliva
enters your mouth through, for example, kissing an HIV-positive person, your own saliva will
dilute theirs and your stomach acids will kill the virus.

Source: National Institutes of Health (http://www.niaid.nih.gov/factsheets/hivinf.htm) and Northern Territory
AIDS and Hepatitis Council (http://www.ntahc.org.au/hivbbvq&a.htm)

18. Briefly mention the other ways to contract HIV.
Answer:
• Through infected blood (e.g., blood transfusions).
• Through contaminated needles (e.g., from injection drug use or needle stick injuries).
• An HIV-infected mother can transmit the virus to her baby during pregnancy, birth, or breastfeeding.

Source: National Institutes of Health (http://www.niaid.nih.gov/factsheets/hivinf.htm)

19. Ask trainees if they think it’s important to share this information with their listeners and why (2-3 minutes).  

20. Let the group share ways in which this can be done (4-5 minutes). 

21. Thank everyone for their openness and distribute a copy of the hand-out.

This exercise was developed by Mia Malan.
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SEXUALITY
(targeted at journalists in their twenties)
LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Realize that different groups of society discuss sexuality in different ways. 
• Understand why sexuality is difficult for some groups to discuss. 
• Understand why it is important to discuss sexuality.

MATERIALS
• Flipchart, easel, and enough paper for group work
• Markers

HAND-OUTS
None 

TIME
30 minutes

INSTRUCTIONS
1. Explain that the group will explore definitions of and messages about sexuality. Acknowledge that it is nor-

mal for some people to feel a little embarrassed or uncomfortable. Point out that in our society, although
we hear about sexuality all the time in music, television programs, and movies, people often do not have
serious discussions about the subject. 

2. Write the word “Sexuality“ on the flipchart. Ask for definitions of sexuality and write the responses on the
board or on newsprint. Encourage one- or two-word answers. Avoid giving your own definition of sexuality. 

3. Tell trainees to work in groups and spend a few minutes thinking about what they have heard about sexuality.
4. Divide into three groups. Each group will have a different assignment. 

• Group One will list what their parents would say about sexuality. 
• Group Two will list what their friends would say about sexuality. 
• Group Three will list what they have seen or heard about sexuality through the entertainment

media: movies, music, magazines, and television. 
5. Give each group a flipchart paper and ask trainees to write down their findings. 
6. After 5-7 minutes, post up the findings and present to everyone else.
7. Have a short discussion of the findings, using the following discussion points: 

• How are the messages from parents, friends, and the media similar? Different? Why do you think  
that is so? 

• Which messages do you agree with? Disagree with? 
• Can you think of any sexuality messages you have heard from other sources, such as religious 

leaders, romantic partners, or health teachers? 
• If you were a parent, what is the most important sexuality message you would give your child? 
• Which of these messages might make a person feel uncomfortable talking about sexuality? 
• Are any of the messages very negative about different kinds of sexuality? How and why?
• Are there messages you think are incorrect and that you want more information about? 

Note: This is an exercise where you have to use some judgment. Trainer Virginia Moncrieff, who has used this exer-
cise frequently, says that the younger the group of training participants (early 20s), the more successful the exercise
is. Please consider the culture and the relations between men and women and other factors before deciding to do
this exercise. 

This exercise was developed by consultant trainer Virginia Moncrieff.
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HAND-OUT 6A: THE TEN COMMANDMENTS
1. I am the ENHANSE/lnternews Workshop on PMTCT [name of the workshop], and while I last thou shalt

have no other thoughts but me. 
2. Thou shalt arrive at the Workshop punctually every day, for punctuality is the soul of business; classes 

begin at 9am sharp.
3. Thou shalt attend the Workshop regularly every day for five days, and thou wilt like the faces you see around

you, whether they be ugly or pretty; if you have reason to complain, do it to yourself, for I am a jealous Judge
who will visit your inequities on your station unto the ninth and tenth generations. 

4. Thou wilt do your homework every day; those who fail to do their homework will be severely punished; if they
be male they shall cut grass, and if they be female they shall sweep the premises and wash the toilets. 

5. Although this is an event for healthy “talkative“ people, where talking is a virtue, over-talking is not permitted,
for it is punishable with indefinite detention; for us, Kuje Prison is just across the road. 

6. This is a participatory and interactive talk shop, and participation is rewarded with a gold-plated certificate, but
no gragra [smartness] of any kind. 

7. It is good to be clever, and clever people will get rewarded, but then cleverness is not the most important thing
here. 

8. Thou shalt not brandish your jism [Nigerian word for phone] at this talk shop, so shut it off or put it on vibrate
mode while classes are in progress, for there are many who have costlier, prettier phones than that ugly thing
you want to brandish; otherwise you will be penalized with a fine of $1 deductible at source; to that end you
will elect for yourselves a class monitor who will write down the names of those who make noise with their
mouths or phones, and those who laugh in vernacular Yoruba, Hausa, Fulfude, Efik, or Igbo [local Nigerian lan-
guages]. 

9. Breakfast is between 8:30 and 9am, and those who cannot take theirs on time will be lashed by hunger, for
there will be no snacking after meal times. 

10. For the five days you are here, I, your judge, will accept no excuses for lateness, nor for why you did not do your
homework, nor for the sins of malingering and roaming about the campus, which are each punishable with 12
lashes of the cane, or a fine of $1 deductible at source, whichever the judge prefers. Period. 

This is an example of the Ten Commandments that the Internews/ENHANSE Media project uses. It was developed by Cece
Modupe-Fadope.
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HAND-OUT 6B: BACKGROUND FOR THE TRAINER
(The Housewife and the Sex Worker Exercise)

Traveling populations and HIV 
Extended or repeated overnight travel away from home and community is associated with HIV infec-
tion. This travel can be divided into three types: voluntary and job-related (truckers, traders, freelance

sex workers); legally required (members of the military, deported immigrants); or coerced (political refugees, traf-
ficked sex workers, persons displaced due to war-related population shifts). Work-related mobility often creates an
imbalance in the ratio of women to men, which facilitates the sharing of sex partners. Extreme examples are truck
stops where female sex workers, vendors, and drink shop owners outnumber the men who may be transiting
through. The reverse is true in military and mining camps, where men greatly outnumber women. 
Mobile populations that regularly cross international borders need access to a complete spectrum of HIV preven-
tion options, including diagnosis and treatment of sexually transmitted infections, affordable condoms and infor-
mation on where to buy them, and information on how to reduce one's risk of infection. Many settings with mobile
populations especially need policy-focused, contextual interventions to foster individual behavior change. One
approach to cross-border HIV prevention is to concentrate interventions at international border crossings because
they are high-risk environments where national prevention programming is weak.

Source: Family Health International
http://www.fhi.org/en/HIVAIDS/pub/fact/mobilepop.htm
How effective are condoms?
The US Department of Health and Human Services and the United Nations Population Fund have gathered com-
pelling international evidence that consistent use of latex male condoms is a highly effective method of preventing
HIV transmission. Scientific research by the US National Institutes of Health and World Health Organization (WHO)
found “intact condoms … are essentially impermeable to particles the size of sexually transmitted disease
pathogens, including the smallest sexually transmitted virus.“ Four meta-analyses of condom effectiveness put the
range at 69–94%. Conclusive evidence from studies of serodiscordant couples (where one partner is HIV-positive
and the other is not) shows that using a condom reduces the probability of HIV transmission during penetrative sex
by about 90%. Thus, the best estimate that may be deduced from all these studies is that condoms used correctly
and consistently reduce the risk of transmission by about 90%. With perfect use, effectiveness may be even higher,
though not 100%. It is important to clarify that an effectiveness of 90% does not mean that HIV transmission will
take place in 10% of sexual acts where condoms are used. In fact, the risk of transmission is much lower. If the risk of
sexual transmission is one in 500 without a condom, it would be reduced to one in 5,000 when a condom is used.

Consistent condom use
A population may use large numbers of condoms, but the impact will be limited if those who need them most do
not do so consistently. There is little evidence that using condoms sometimes (but not always) provides any greater
protection than not using condoms at all. In fact, one study from Uganda found that individuals who sometimes
used condoms were at higher risk of infection than those who never used them, perhaps because they were more
risky in other aspects of their sexual behavior, such as the number of partners they had. In analyzing overall data on
condom use, it is critical to determine who is using condoms. In a situation where overall condom use in general is
high, but condom use is low in those few encounters where it could make a measurable difference, condom promo-
tion must become more focused. This could occur, for example, if those at highest risk of HIV infection have lower
rates of condom use, while people at low risk have higher rates of condom use.

Source: UNAIDS. 2004. Making condoms work for HIV prevention. http://www.champnetwork.org/media/unaids.pdf
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HAND-OUT 6C: HOW IS HIV TRANSMITTED?
(Understanding Your Risk Exercise)

AIDS is caused by the human immunodeficiency virus, or HIV. By killing or damaging cells of the body's
immune system, HIV progressively destroys the body's ability to fight infections and certain cancers.
People diagnosed with AIDS may get life-threatening diseases called opportunistic infections. These

infections are caused by viruses or bacteria that usually do not make healthy people sick. HIV is spread most often
through unprotected sex with an infected partner. The virus can enter the body through the lining of the vagina,
vulva, penis, rectum, or mouth during sex.
Risky behavior
HIV can infect anyone who practices such risky behaviors as:
• Sharing drug needles or syringes. 
• Having sexual contact, including oral sexual contact, with an infected person without using a condom. 
• Having sexual contact with someone whose HIV status is unknown. 
Infected blood
HIV is also spread through contact with infected blood. Before donated blood was screened for evidence of HIV
infection and before heat-treating techniques were available to destroy HIV in blood products, HIV was transmitted
through transfusions of contaminated blood or blood components. Today, because of blood screening and heat
treatment, the risk of getting HIV from blood transfusions is extremely small.
Contaminated needles
HIV is often spread among injection drug users when they share needles or syringes contaminated with very small
quantities of blood from someone infected with the virus.
HIV transmission between patients and health care providers by accidental sticks with contaminated needles or
other medical instruments is rare.
Mother to child
Women can transmit HIV to their babies during pregnancy or birth. Approximately one-quarter to one-third of all
untreated pregnant women infected with HIV will pass the infection to their babies. HIV also can be spread to
babies through the breast milk of mothers infected with the virus. If the mother takes certain drugs during pregnan-
cy, she can significantly reduce the chances that her baby will become infected with HIV. If health care providers
treat HIV-infected pregnant women and deliver their babies by cesarean section, the chances of the baby being
infected can be reduced to 1%. 
Saliva
Although researchers have found HIV in the saliva of infected people, there is no evidence that the virus is spread by
contact with saliva. Laboratory studies reveal that saliva has natural properties that limit the power of HIV to infect,
and that the amount of virus in saliva appears to be very low. Research studies of people infected with HIV have
found no evidence that the virus is spread to others through saliva by kissing. However, HIV can infect the lining of
the mouth, and instances of HIV transmission through oral intercourse have been reported.
Scientists have found no evidence that HIV is spread through sweat, tears, urine, or feces.
Casual contact
Studies of families of HIV-infected people have shown clearly that HIV is not spread through such casual contact as
sharing food utensils, towels, and bedding, or by using the same swimming pools, telephones, or toilet seats.
HIV is not spread by biting insects such as mosquitoes or bedbugs.
Sexually transmitted infections
People with a sexually transmitted infection, such as syphilis, genital herpes, chlamydia, gonorrhea, or bacterial
vaginosis, may be more susceptible to HIV infection during sex with infected partners.
Source: National Institutes of Health, US Department of Health and Human Services. 
Available at: http://www.niaid.nih.gov/factsheets/hivinf.htm
Please note that this is a shortened version of the webpage fact sheet. 
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chapter 7
Teaching Journalists How to Do Research
SANDRA NDONYE

Learning objectives
After working through this chapter, the trainer will: 

1. Be able to train radio journalists in two basic journalism research methods.  

2. Understand why it’s necessary to train journalists to do good research rather than just
provide them with HIV-related information.

3. Understand how Local Voices Media Resource Centers operate. 

Why is it important to teach radio journalists this skill?
Good reporting requires a lot of research. Reporters can’t tell strong stories about issues they
know little about. HIV journalism training should thus equip trainees with the necessary
research skills to gather accurate information for their stories and develop creative story angles.
Merely providing trainees with information for a story produced during a training workshop
does not teach them how to do their own research in the future. 

Some research methods are specific to broadcast journalism. Radio journalists, for instance, fol-
low up on print stories far more often than print journalists themselves, since radio is an imme-
diate medium that can adapt to fresh news angles within a few hours. Print stories often pro-
vide radio reporters with interesting stories.  

This chapter focuses on honing internet skills and developing “second phase“ news angles
from print stories. Please note that Local Voices offices have Media Resource Centers (MRCs)
that journalists use for research. You can read more about MRCs on the next page (“Media
Resource Centers in Local Voices offices“). If you want to know how to create your own MRC, a
manual is included on the CD that accompanies this manual.  

How much time do I need to allocate to teaching this skill in a weeklong
training session?
Total: 3 hours

• 2 hours, 30 minutes during formal training days

• 1 hour per trainee during individual mentoring days

Background 
Media Resource Centers in Local Voices offices

CHAPTER 7: TEACHING JOURNALISTS HOW TO DO RESEARCH
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Exercises 
• Teaching Basic Research Skills (essential, 2 hours, 30 minutes), for programs with Media
Resource Centers

• Setting Up and Running a Media Resource Center (only on the manual CD)  

Hand-outs 
7A Websites with Information on HIV/AIDS
7B Tips for Google Searches 
7C Example of a Contact List of HIV/AIDS Organizations Used in Kenya

Documents available only on Manual CD: 
• Setting up and Running a Virtual Media Resource Center.
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Media Resource Centers in Local Voices Offices
Local Voices offices in countries where Internews has fully developed LV programs (Kenya,
Nigeria, Ethiopia, and India ) have Media Resource Centers (MRCs) where journalists can do
research. MRCs have computers with digital sound editing software for editing stories, high-
speed internet access for internet research, and word processing programs for typing scripts
and transcriptions. MRCs are like “newsrooms“ that journalists from different stations can use to
produce their stories (all trainees have free access to these facilities).  

MRCs also contain many HIV-related publications that are regularly updated. These include
UNAIDS reports, NGO brochures, books about HIV, CDs, DVDs, and copies of stories by LV-
trained journalists. At the Kenya MRC are more than 3,000 publications, all of which have been
entered into a Microsoft Access database that can be searched by subject, author, or key words.
Reporters receive training on how to use this system when they attend radio workshops. This
manual does not include an exercise for database search training on Microsoft Access, since
different offices use different programs. All MRCs also have notice boards with announcements
of media awards, competitions, fellowships, and news releases. 

In addition to a physical space, our India office has a virtual MRC that journalists access on the
internet. If you would like instructions for creating a virtual MRC, see Setting up and Running a
Virtual Media Resource Center on the CD attached to this manual.

CHAPTER 7: TEACHING JOURNALISTS HOW TO DO RESEARCH

Having a Media Resource Center full of handy media-friendly information on HIV
and AIDS has served to improve the quantity and quality of HIV stories on the air.

Journalists know that here they can easily access up-to-date and accurate information when
they come over, e-mail, or call. They can also get quick technical support. It’s always
a hub of activity at the Media Resource Center here.

–Asma Naseer, Media Coordinator, Internews India

“ ”
In addition to what has been listed above, the MRCs also contain: 

1. Contact lists  
The MRCs also contain regularly updated lists of HIV/AIDS organizations that journalists can
contact for interviews (see Hand-out 7A). The lists include the names of the organization, a
brief description, full contact information, and the name of a helpful contact person at the
organization (often a media liaison or public relations officer). Journalists receive a soft copy of
this list to update and personalize as they develop their own contacts.  



Internews Radio Training Manual

100

CHAPTER 7: TEACHING JOURNALISTS HOW TO DO RESEARCH

The HIV/AIDS organizations contact list is a handy and easy-to-use directory for looking for
interviewees. I network with many experts and organizations on a day-to-day basis and have

established very good contacts for our media resource center.

–Anselm Onkolo, Media Coordinator, Internews Nigeria

2. News clipping services 
Each MRC also has a newspaper clippings book. The book contains all HIV-related stories pub-
lished in major newspapers. Each week, LV-trained journalists receive summaries of the stories
by e-mail. 

To create a news clippings book:

Read carefully through daily and periodical newspapers and cut out important stories. Paste
the clippings in a book and include the name of publication, date, and page number beside
the actual article. When the book fills up, write the dates of the first and the last articles on the
cover for easy reference. 

The newspaper clippings are useful as most journalists come to our media resource center to
search them for follow-up story ideas. They say it is really important to have. 

–Meron Seyoum, Internews Ethiopia

To create a weekly clippings summary:

Every week, make a list of the titles of articles clipped out of the newspapers and include a
one-line summary for each. It’s easy to read through the summaries to identify potential stories
for follow-up. 

Every week, I send out a summary of the newspaper clippings on HIV/AIDS stories published
in Kenya, and journalists always tell me that this summary helps them monitor the develop-

ments and trends in HIV/AIDS so they are in touch with what’s going on locally, regionally,
and internationally. 

–Medlene Kinyanjui, Internews Kenya

“

“

”
“ ”

”
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TEACHING BASIC RESEARCH SKILLS 
Note: Please see Hand-out 7B for  additional tips on internet research. 

LEARNING OBJECTIVES
By the end of this exercise, participants will:  
• Understand the importance of research.
• Know how to conduct basic internet research.
• Understand how to creatively follow up on newspaper stories for radio.

MATERIALS
• One computer with internet connectivity for each journalist
• A small prize such as a souvenir, colorful pen, cute notebooks, or small boxes of sweets
• Flipchart
• Marker
• Notebook
• Pen
• At least four different editions of local newspapers with HIV stories, or photocopies of stories

HAND-OUTS
• Hand-out 7A (Websites with Information on HIV/AIDS)
• Hand-out 7B (Tips for Google Searches)
• A contact list similar to the one in Hand-out 7C7

Develop a contact list similar to the one in Hand-out 7C yourself that includes contacts within the country
where you’re training. Start to prepare this list at least one week before the workshop; be sure to get the 
consent of people whose personal or cell phone numbers appear on the list. 

TIME
2 hours, 30 minutes

INSTRUCTIONS
1. Instruct each trainee to choose a computer station and sit at it. 
2. Explain that you’re first going to have a discussion and then work on the computers. 
3. Ask the journalists how they would ordinarily do research for stories and what information resources they

have access to. 
4. Allow each trainee to respond so that you have a good understanding of the nature of the research

facilities or libraries to which they have access. End the discussion after 15 minutes. 
5. Ask trainees: “What do you think is the value of good research?“ 
6. Allow for two or three responses.  
7. Make sure the following points get across:

• Research helps you come up with creative story ideas.
• Research helps you sound authoritative about the subject.
• Research helps you get accurate facts for your stories.
• Research helps you find good interviewees (experts and case studies).

8. Ask journalists to click on the Internet Explorer or Mozilla Firefox icons on their computers to access the
internet.

(Continued on next page)

EXERCISES
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9.  Ask trainees if they know what a search engine is. 
10. Ask those who know to explain what it is to the others. Make sure the following points get across:  

A search engine helps you to do research on a particular subject or to find files or reports on the internet.
Examples of search engines are Google (www.google.com) or Yahoo! Search (http://search.yahoo.com/). 

11. Ask trainees to open both of these websites to see what they look like. 
12. Explain that for the purpose of this exercise, you’re going to use Google. 
13. Instruct the trainees to enter the phrase “HIV counseling and testing“ into the search window. 
14. Ask two or three journalists to share what appears on their screens.  
15. Encourage journalists to take notes as they narrow down their searches to get specific information (e.g.,

“counseling and testing of HIV in pregnancy“).
16. Allow each trainee a chance to briefly share the highlights of their searches.
17. Ask them to do one more search: their own names (if their own work doesn’t appear on the internet, ask

them to use the name of another journalist they know). 
18. Distribute Hand-out 7A (a list of HIV websites) and explain how to use it. 
19. Distribute Hand-out 7B (Tips for Using Google) and go through the bullet points. 
20. Allow trainees to practice some of the search tips on Hand-out 7B, such as entering words with and with-

out inverted commas. 
When you enter “HIV testing“ within quotation marks, only entries with those two words appearing
exactly in that order will appear. If you enter the same words with no quotation marks, you’ll get 
entries with various combinations of that phrase. 

21. Announce that you’re giving everyone a 10-minute break. 
22. After the break, explain that you’re going to move on to a different type of research exercise. 
23. Instruct them to split into groups of three.
24. Ask each group to gather in a different part of the same room. 
25. Hand out a different newspaper edition to each group.

Note: Make sure that each newspaper you distribute contains at least two HIV-related stories. You need to 
start selecting these newspapers a few weeks before the workshop to be sure you have enough. 
Alternatively, you can give each group newspaper clipping books containing a few HIV stories. 

26. Ask each team to find an interesting HIV-related story that they would like to follow up for radio. Give
each group about 15 minutes to identify a story. 

27. Listen to each group’s discussion. 
28. Instruct each group to develop their story idea into a radio feature. 
29. Write the following guidelines/tasks on the flipchart and explain them to the trainees: 

• Do further research by using Google. The radio story has to contain new information; it can’t just
repeat the print story. Provide at least two website addresses found on Google where new
information is available.

• Think of a potential interviewee whose experience would contribute to your story (e.g., for a story
about HIV testing, someone who has been tested recently). Come up with the names of two
organizations that could help you find such a person.

• Include an interview with an expert who is not cited in the print story.
(Continued on next page)
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Note: To save time and avoid disruption, write out the guidelines on the flipchart either before the session 
begins or when groups discuss story ideas.
30. Explain that each group has to develop an interesting story: 

• With a strong news angle. 
• With a beginning, middle, and end. 

31. Announce that the group with the best story idea will get prizes and that each group has about 30-35
minutes to develop their story. 
Note: Small prizes for each group member are better than one prize for the group. Colorful pens or cute 
notebooks work well. 

32. Ask each group to appoint one team member to present the story. 
33. Give each group about five minutes to present their story. 
34. Ask two of your colleagues with journalism experience to serve on a panel to judge the stories. 

Note: If you don’t have colleagues who can help out, you can act as judge.
35. Summarize the two different research methods addressed during this exercise: 

• Internet research
• Using a newspaper to get story ideas 

36. Explain that there are also other forms of research such as reading articles, doing in-depth interviews with
case studies and experts, and so on. 

37. Distribute a list similar to Hand-out 7C that is relevant to the country where the workshop is taking place. 
Note: Hand-out 7C lists HIV organizations that journalists associated with our Kenya office can contact for 
interviews. It doesn’t have to be as extensive as the Kenya list; one or two pages will do. It helps to also e-
mail this list to participating journalists so they’ll have an electronic version to update with their own 
contacts.

This exercise was developed by Sandra Ndonye.
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HAND-OUT 7A: WEBSITES WITH INFORMATION ON HIV/AIDS

www.bbc.co.uk/swahili/highlights/cluster/2005/07/050629_kimasomaso.shtml
www.avert.org
www.wikipedia.com

www.developmentgateway.org
www.aidsalliance.org/publications
www.iavi.org
www.livetoknow.com
www.medguide.org.Zm/aids/aids.html
www.thewellproject.org
www.hivandsrh.org
www.unfpa.org/aids_clock/
www.fhi.org/en/HIVAIDS/
www.unescobkk.org/arsh
www.moh.govt.nz/sexualhealth
www.eldis.org/hivaids
www.medicalnewstoday.com/medicalnews.php?newsid=36002 
www.intelihealth.com/IH/ihIH/WSIHWOOO/333/8013.html 
www.infoforhealth.org/ 
www.unfpa.org/publications/detail.cfm?ID=256
www.who.int/reproductive-health/rhl/rhl_partners.html 
www.prb.org/
www.rho.org/htm/hiv_aids_special_focus.htm

Note: This list is not exhaustive.

Source: This list was compiled by Peris Wakesho, Youth Program Officer, Hope Worldwide-Kenya.
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HAND-OUT 7B: TIPS FOR GOOGLE SEARCHES

• Be specific about what you are searching for. For example, if you are looking for apple, be specific
that it’s the fruit you would like to know about.  Type something like apple nutrition. If you type in
apple on its own, you will get everything from the actual fruit to Apple computers, leaving you 

with a lot to sift through.

• Instead of typing your query in the form of a question, type it in the form of an answer and use an asterisk (*)
for the word you don’t know. For example, instead of asking “how many calories does an apple have?“ type in
“an apple has * calories.“ 

• You can double your search effectiveness by simply using the “search within results“ link at the bottom of any
Google results page. This will help you narrow your results to find the really relevant pages.

• To save you clicks, Google offers an “I’m Feeling Lucky“ button that takes you directly to the page that would
appear at the top of your results.

• Bear in mind that searching on singular nouns will give you different results from plural nouns.  For instance,
searching for apple will yield different results from apples. 

• The order of your search words matters. The first word is considered most important, followed by the second,
and so on – so select your first word carefully.

• To stay speedy and focused, leave out such “little“ words as I, where, how, the, of, an, for, from, it, in, and is,
because Google ignores them. If such words are critical for your search – for example, “The King“ for entries
about Elvis – use quotation marks to indicate that “The“ should be part of the search.

• Google ignores most punctuation except apostrophes, hyphens, quotation marks, and two periods in a row
(e.g., 400..600 thread count or 200..300 watt bulbs). On the other hand, Google recognizes many spelling varia-
tions. For example, if you enter bowtie, it will search for both bowtie and bow-tie.

• Instead of using the word not, use the dash/minus sign (-) to indicate that you don’t want a certain term to
appear in your results.  The minus sign must appear directly before the word or phrase you want to exclude.
Put a space before the minus symbol and not after. For example: “Arthur Obel  –Pearl Omega.“

Source: These guiding tips were extracted from Google: The Missing Manual, by Sarah Milstein et al. 2004.
Sebastopol, CA: O’Reilly Media.
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HAND-OUT 7C
Example of a contact list of HIV/AIDS organizations used in Kenya

Note: Only one page of the HIV/AIDS contact list in Kenya has been provided to avoid duplication.
The actual list consists of about 25 organizations and generally includes: 
• The name of the organization

• The organization’s contact details (address, phone numbers, e-mail addresses, website)
• Contact names of spokespeople and media coordinators
• A summary of what the organization does

Kenya AIDS NGO Consortium (KANCO)
Chaka Road off Argwing Kodhek Road
P.O. Box 69866-00400, Nairobi
Tel: 2717664/2715008/0722-203344/0733-333237 Fax: 254-2-714837
E-mail: kenaids@iconnect.co.ke; kanco@kanco.org
Website: www.kanco.org
Contact names: Allan Ragi (Director), Evelyn Kibuchi (Communications Officer, Nairobi), and Patrick Mwai
(Resource Center Manager, Mombasa)
KANCO is a national network of NGOs/CBOs and religious organizations involved or interested in HIV/AIDS and
STI activities in Kenya.
KANCO also runs HIV/AIDS Resource Centers that can be useful to journalists (story research) in Nairobi and
Mombasa.

National AIDS and STD Control Program (NASCOP)
P.O. Box 19361, Nairobi
Tel: 2729502/49
Contact Names: James Kalola (Communications) and Carol Ngare (National VCT Coordinator)
NASCOP is the national AIDS and STD Control Program, under the Ministry of Health. It is a good source of 
statistics, information, and materials on government policies and guidelines relating to HIV/AIDS. It is advisable
to make your requests for interviews/studio guests through the director’s office.

The National AIDS Control Council
Landmark Plaza (opposite Nairobi Hospital), 9th Floor, Argwings Kodhek Road 
P.O. Box 61307 - 00200, Nairobi
Tel: 254 (020) 2896000
Website: www.nacc.or.ke
Contact name: Peter Mutie (Communications Manager) or Alice Natecho 
The National Aids Control Council, NACC, is the government’s technical advisory body on HIV and AIDS pro-
grams in Kenya. It is advisable to make your requests for interviews/studio guests through the director’s office.
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chapter 8

Teaching Journalists How to 
Do Radio Interviews
IDA JOOSTE

Learning objectives
After working through this chapter, the trainer will: 

1. Be able to explain why research, critical thinking, and good listening are important for
preparing for and conducting interviews.

2. Be able to demonstrate different interviewing styles, including special approaches for inter-
viewing people and children infected with or affected by HIV. 

3. Be able to train journalists to recognize good sound bites for features and news. 

Why is it important to teach radio journalists this skill?
Journalists are in the privileged position of asking questions on behalf of their audiences.
Journalists thus have the responsibility to:1

• Ask the right questions (research).

• Use an appropriate tone (different styles of interviewing).

• Make maximum use of the medium (radio).

Journalism can be described as asking good questions to produce good answers. Many key
journalistic skills come together in a radio interview, whether for information-gathering pur-
poses or for a live or recorded interview. Without good interviewing skills and the ability to
select good sound bites, no radio journalist can tell compelling HIV stories. 

This chapter contains exercises to train journalists about how to approach different styles of
interviewing, including a hard exposure interview to investigate an issue, an informational inter-
view, or an emotional interview, which reveals the interviewee’s state of mind. Exercises in this
chapter help trainers illustrate the importance of good listening, proper preparation, and
appropriate tone for interviews. The goal is to teach trainees how to listen for sound bites for
different formats. 

The Pope is visiting your country and you have the privilege of interviewing him. Once the
excitement is over, your heart races … what should I ask him? The answer is simple: Go find a

Catholic and ask what he/she wants to know from the Pope – then ask that question! 

–Ian Masters, Broadcasting Controller, Thomson Foundation

1 Source: Broadcast Journalism, Techniques of Radio & TV News, 2nd ed, Andrew Boyd, Focal Press, 1993.

“ ”
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How much time do I need to allocate to teaching this skill in a 
weeklong training session?
3 hours, 45 minutes 

Exercises
• The Listening Game (essential, 20 minutes)

• Avoiding Yes and No Is the Way to Go (optional, 40 minutes)

• What Do I Ask? Whom Do I Ask? How Do I Ask? (essential, 1 hour)

• Live Interview Simulation (optional, 30 minutes)

• Listening for Sound Bites (essential, 1 hour)

• Interviewing Adults and Children Affected by HIV/AIDS (optional, 30 minutes)

• View Interviewing Skills Tape (essential, 45 minutes)

Hand-outs 
8A Interviewing Styles 

8B Considerations for Interviewing People Affected by HIV/AIDS

8C Considerations for Interviewing Children Affected by HIV/AIDS

8D Consent Form

8E Take-home Notes Based on Interviewing Skills Tape

QUICK TIPS FOR LIVE IN-STUDIO INTERVIEWS
• Invite live studio guests at least two days (48 hours) before the day of the interview.

• Thoroughly brief your guests on the topic and angle for the interview, and encourage them to
prepare well. 

• Discourage guests from arriving at a live interview with written notes and answers to questions.
Listeners can always tell when someone is reading, which kills spontaneity and the natural flow of
the interview. 

• Get your guests to arrive at least 20 minutes before going on air.

• Call to check on your guest an hour or two before the interview. Last-minute cancellations do
happen, so give yourself time to figure out quick alternatives.

• Get the name and title of your interviewee right! Write them down clearly so you don’t forget.

• Listen carefully and follow what the interviewee says. This helps you develop instant follow-up
questions or paraphrase an earlier question if the answer isn’t satisfactory or clear.

–Sammy Muraya and Freddy Muriithi, Internews trainees from Kenya
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Sound on Manual CD
• The Court Case

• PMTCT Breastfeeding

• Sex Worker

Additional reading material
• Cohler, David Keith. 1994. Broadcast Journalism: A Guide for the Presentation of Radio and

Television News. New York: Prentice Hall.

• www.unaids.org/unaids/document/humright/3797.html 

• http://www.ifj.org/en/articles/childrens-rights-and-media-guidelines-and-principles-for-
reporting-on-issues-involving-children

• www.unicef.org/media/media_tools_guidelines.html 

CHAPTER 8: TEACHING JOURNALISTS HOW TO DO RADIO INTERVIEWS 
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JON COHEN’S TIPS FOR INTERVIEWING SCIENTISTS

• Move from the general to the specific. Ask what the big picture is, and then dive into the
details.

• Do your homework. Read a few of their papers ahead of time and see if they have a website.
When you read papers, don't get lost in the details. It often helps to read the last paragraph
first to understand why they did the study.

• Don't pretend to understand things that confuse you. Ask sources to explain them to you as if
you were a child, because that's how you're going to have to translate it for your audience.

• Ask who their chief competitors are, and then contact those people.

• Ask who funds their work and let your audience know about any conflicts of interest.

• Try to observe them at work, whether it's with test tubes or with people taking part in a study.
That will make the scientists, and the story, come to life.

• Ask them what common mistakes journalists make when they report about their work.

• Do not fear complexity. Assume that you can understand anything if you have the right
teacher. If one scientist confuses you, go to another.

• Ask which scientific questions most interest them.

• It’s easy to get things wrong, so follow up to double-check facts. Everyone appreciates accura-
cy, and scientists are sticklers about details.

• Understand that scientific information is not all equal. Some data are more convincing than oth-
ers. Keep in mind the size of the study (the number of people or animals studied, for example),
the statistical significance (did the study have enough “power“ to make it probable that the
results are not due to chance?), whether supporting or conflicting data from other labs are avail-
able, and whether the experiment is controlled (did they test the hypothesis against neutral
conditions?).

• Don't speculate, and don't quote people speculating. “Speculate“ in science is a four-letter
word.

• Exceptional claims require exceptional evidence. If it seems too good to be true, it probably is.

• Most experiments fail. Keep that in mind when you listen to a scientist enthusiastically
describe work that's in progress.

• Just because someone has a PhD or an MD doesn't mean that what he or she says is accurate.
Verify the claims with others, just as you would any source.

• Conflict is the engine of all great stories. In science, conflict often is ideas hitting each other. A
new finding is interesting because it challenges the status quo. Use that tension to drive narra-
tives.

• Don't quote people stating facts. Put facts into your own voice, and let their voices add color,
emotion, and even drama.

• At conferences, pay attention to what people in the audience say at the microphone after a talk.
If lots of people line up with comments, the speaker probably said something newsworthy.

–Jon Cohen has reported on HIV for twenty years. He works as Science Magazine’s HIV correspon-
dent and has authored several books.
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THE LISTENING GAME

LEARNING OBJECTIVES

By the end of this exercise, participants will:

• Realize that listening is an active skill – and an important part of interviewing.

• Appreciate that the shorter the version of a story, the more it has to be broken down to essential facts. 

• Know each other better.

MATERIALS

• Chairs (if you don’t have chairs, use the floor)

• A clock or watch 

• Enough space to allow everyone to break up into pairs and sit opposite each other

HAND-OUTS

None

TIME

20 minutes

INSTRUCTIONS

1. Explain the game to the group: “The following game is called the ‘Listening Game.’ It is designed to get
journalists to listen more actively and to interview better.  As journalists we think that we are good
listeners – but we are often so busy that we sometimes do not listen actively, and therefore don’t get all
we need for the story.“

2. Ask the group: “Which is easier – listening or speaking?“

3. Field the answers (most people say listening is easier).

4. Say: “For this game I am grouping you into number ones – ‘speakers’ - and number twos – ‘listeners’. “

5. Count out the participants so that each gets a number one or a number two. 

6. Ask the speakers and listeners to join up in pairs with their chairs placed at 45 degree angles to each other. 

7. Explain to the participants that first the speakers will talk for two minutes uninterrupted by the listeners. 
The topics can include: 

• What I love about my job in HIV journalism or communications.

• The challenges in my work on HIV. 

• What I thought about HIV the first time I heard about it. 

8. Explain that the listeners may not interrupt or take notes, but must verbally summarize the main points
that the “speakers“ covered in half the time. 

(Continued on next page)
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9. Ask for feedback from the participants on how they found the game, what they discovered from it, and
whether it was hard to listen and summarize. For a larger group, only ask two or three participants; for a
smaller group, the trainer can ask each pair for their feedback in front of the group.

10. Announce that the game will be repeated with the roles of the speakers and listeners reversed. 

11. Let the participants repeat the game with each participant playing the opposite role of “speaker” and “listener.”

12. Ask the group: “After doing this exercise, which do you think is easier? Listening or speaking?“

13. Listen to the group’s feedback. (Most trainees say that listening is harder than they thought – or that both
listening and speaking are hard.)

14. Say: “Although we have two ears and only one mouth, we are often better at using our mouths than our ears!“

Note: You can also use this as an icebreaker activity at the start of the session. The “interview” questions could be
about the trainees introducing themselves. In the feedback, the “listener” will tell the group more about their
interviewing partner, and thus the whole group gets to know each other better.  

This exercise was developed by the Internews Mekong training team: Lyndal Barry, Dr. Bach Thi Minh Hang, Cheat
Sotheacheath, Siv Cheng, Aung Htun U, and Soe Soe.

Waheed Solanke of RayPower FM, Lagos, talks to a child affected by HIV.
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AVOIDING YES AND NO IS THE WAY TO GO

LEARNING OBJECTIVES
By the end of this exercise, participants will:
• Understand the importance of avoiding Yes/No questions.
• Learn the habit of phrasing open-ended questions that start with Who, What, Where, and so on. 
• Realize that Why and How questions give the most depth of information.  

MATERIALS
• A bell or siren (if none is available, the designated trainee can say “boo-boo“ at the required time)
• Two flipcharts with felt marking pens 
• A prize for the winning group, such as a packet of sweets (otherwise, a round of applause will do) 

HAND-OUTS
None

TIME
40 minutes

INSTRUCTIONS
1. Tell the group that they will be divided into two groups, which will each have an opportunity to ask only

five questions of a person they have always wanted to interview. (You could vary this and make it a key
personality linked to a story theme; e.g., if it is about celebrities getting involved in HIV/AIDS campaigns,
the “exclusive“ interview could be with Richard Gere).  

2. Tell the group to nominate a helper, who will make certain verbal signals if any questions seem like wasted
opportunities.

3. Divide the group into two and tell them they will compete to see which group has the best questions.    
4. Explain to the helper that any questions eliciting a Yes or No response are wasted opportunities and to

ring the bell or shout “boo-boo“ if such questions are asked. Ask the helper to keep a score of the number
of “boo-boos“ for each group.   

Note: This is a competitive exercise. The group with the fewest “wasted opportunities” or “boo-boos” gets a prize,
and of course they will get the best interview.     

5. Emphasize to the two competing groups that any wasted question is a wasted opportunity for them to 
get as much information as possible and to get maximum answers for their audience.

6. Explain that you will play-act as the interviewee, and will answer all questions literally.
7. Give the two groups the opportunity to each work out the five key questions, by letting them each select 

a facilitator who must elicit questions from the group, write them down, and decide on the five best
questions, which they write on flipcharts. 

8. Now let the first group ask their questions.
Note: From experience, there are bound to be close-ended questions among the five questions.

9. Every time a close-ended question is asked – for example, “Do you think you will raise more awareness for
HIV/AIDS through your work?“ – stubbornly answer with a simple Yes or No.

10. When such questions are asked, your helper should ring the bell or shout “boo-boo.“
11. Repeat the exercise and let the second group ask the questions.
Note:  The “stubborn” answers and bell or “boo-boo” from the helper have a humorous effect and pretty soon it will
be obvious to the group that the close-ended questions did not yield much of an answer. 

(Continued on next page)
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12. Ask the helper to announce the winning group (the group with the fewest “boo-boos“).
13. Invite the winning group to the front to receive a prize to loud applause. 
14. Ask the winning group members to explain why they won.

Note: Their answer could be something along the lines of: 
“We won, because we had the fewest questions to which you answered ‘yes’ or ‘no’. “ The answers we got gave
useful information.”

15. Expand on the answer given by giving a comprehensive outline along these lines:
Answer: 
Questions to which the person can answer Yes or No are not useful. Interviewees who are not
talkative may well give you such a one-word response, which means you did not phrase the
question to get good information (and a possible sound bite) out of the interviewee. Questions
that can give you Yes or No as an answer are called close-ended questions. 

16. Ask the group if they know what open-ended questions are and if they can give examples from the
questions asked earlier. 

17. Elicit answers, and summarize by expanding on their answers (total of 30 minutes up to here).
Answer: 
Open-ended questions elicit broader answers. For example, “What is your HIV awareness campaign
about?“ will give you good, usable information for a sound bite.

18. Now ask the joint group to list the five Ws and an H in journalism. 
19. If the trainees don’t know the full answer, give them the answer.

Answer: 
Who, What, Where, When, Why, and How questions. 

20. Ask the entire group to put six questions to you (the interviewee), starting with the five Ws and an H
above. 

21. Answer each question concisely.
22. Make a point of giving illuminating answers for the Why and How questions.

Answer: 
For example, to “Why do you do this awareness work?“ the answer could be “I do it, because I want
to be able to tell my grandchildren I did something about one of the world’s major challenges.“
To “How is it possible for you to dedicate this much time to it?“ respond “It is a sacrifice – every year
I have to give up one movie role (that is about $25 million) to make time in my schedule for travel
and social appearances.“ 

23. Ask them what they notice about the Why and How questions. 
24. If there are no satisfactory answers, summarize this session by saying:

Answer:
Note how the Why and How questions take the answers to a next level. Any story should answer
the Who, What, When, and Where questions – those are the absolute basics. But the answers to Why
and How give us insights that make the story worth telling. They are also the cornerstones for more
in-depth and investigative reporting. 

This exercise was developed by Ida Jooste.
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NAME OF EXERCISE
What Do I Ask? Whom Do I Ask? How Do I Ask?

LEARNING OBJECTIVES
By the end of this exercise, the participants will:
• Know the basics of good interviewing.
• Know different interviewing styles.
• Be able to choose interviewing styles appropriate for different applications. 

MATERIALS
• Flipchart 
• Felt writing pens

HAND-OUTS
Hand-out 8A (Interviewing Styles)

TIME
1 hour

INSTRUCTIONS
1. Start a discussion with trainees, asking them to say what makes for a good interview.
2. Ask for a volunteer to write all the answers on a flipchart.
3. Probe the trainees further by asking if they can name different types of interviews.

Answer:
The BBC tells its trainees there are three basic types of interview:
a) The hard exposure interview, which investigates a subject.
b) The informational interview, which puts the audience in the picture.
c) The emotional interview, which aims to reveal an interviewee’s state of mind.

4. Tell the trainees they will get a hand-out later in the session that summarizes key facts about interviews
but, for now, you are interested in their thoughts. 

5. Ask them to attempt to describe the three basic types of interview.
6. Guide them through the answer. If necessary, discuss the following (the same information is available in

Hand-out 7A): 
Answer:
a) An investigative or hard exposure interview aims to get behind the facts of what and why

something happened and to discover what caused it.  The interview can then explore what can be
done to prevent a recurrence. It may also ask who stands to gain from an action.

b) An informational interview provides information and background. One type of informational
interviewing is the hard news interview, which is usually short and to the point, dealing only with
important facts. In features, informational interviews go beyond the main point to explain the
facts and the how and why of the story.

c) An emotional interview attempts to lay bare someone’s feelings, to enable the listeners to share
in a moving event.

7. Distribute Hand-out 8A to the group.
8. Ask someone to read through the exercise on Hand-out 8A.

(Continued on next page)
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9. Now divide the trainees into their original two groups.
10. Ask the groups to appoint a facilitator and to prepare one of each of the three kinds of questions

described in the hand-out.  
11. Let the two groups take turns presenting their questions.

Answer:
a) I would interview the hospital administrator, the patient’s doctor, and the patient.
b) Hard exposure interview (administrator): Why did this happen? What procedures do you follow

when ordering drugs? Why weren’t you able to predict this? How would you describe your
administration process? What assistance are you going to give to patients? 
Informational interview (doctor): What happens if patients do not get their drugs on time? Why
is it important for your patient to get her drugs?
Emotional interview (patient): How does it feel to be in this position? Are you able to make
alternative plans?  

Note: Point out that the emotional interview might be too sensitive an experience for some interviewees and
that it’s important to be perceptive and pull back if necessary.  

12. Encourage the group to read through the other notes on Hand-out 8A. 

This exercise was adapted from the chapter “The Interview” by Ida Jooste of Internews Network, in Broadcast
Journalism: Techniques of Radio & TV News, 2nd ed., edited by Andrew Boyd, Focal Press, 1993. 

DO’S AND DON’TS FOR VOX POPS
Do: 
• Alternate young and old.

• Alternate male and female.

• Reflect a cross-section of views.

• Begin and end with strong comments. 

• Make good use of humorous remarks.

Don’t:

• Use an interview just because you did the interview. Some comments do not contribute to the story.

• Use vox pops just because you couldn’t get informed views.

• Use vox pops if everyone interviewed has the same view on a controversial topic. 

Ida Jooste, Kenya Internews Country Director  and Eliza Barclay, consultant trainer
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LIVE INTERVIEW SIMULATION

LEARNING OBJECTIVES
By the end of this exercise, participants will:
• Be better equipped to do a live interview.
• Know which interviewing pitfalls to avoid.

MATERIALS
• Full recording studio, if available
• Two chairs 
• Flipchart and writing pens

HAND-OUTS
None

TIME
30 minutes

INSTRUCTIONS
1. Ask trainees if anyone has done live interviews, or would like to do them.
2. Ask them to list some of the points to consider when doing a live interview. 
3. If the answers are not comprehensive, point out the following:

Answer:
• The interviewee may be nervous, so put him or her at ease.
• The interviewee is not likely to know much about live interviews. Explain as much as possible

about the process, duration, how to speak into the microphone, and so on. 
• Before the interview, chat with the interviewee about the subjects you want to discuss, but do not

give away the direct questions – that will take the spontaneity away.
• Tell the interviewee how much time there is for the interview and how best to break that time

down (e.g., “that is roughly time for four questions with brief to-the-point answers“).
• Progress from point to point.
• Listen well.

4. Arrange chairs and microphones to simulate the setting of a real interview.
5. Make sure the trainees know how to use the recording equipment; if they don’t, teach them some basics.
6. Remind them to not make such noises as “hmm“ and “ahh,“ which come across as unprofessional on air.
7. Role play as an interviewee and let the trainees take turns interviewing you, or let them break into groups

of two and interview each other.
8. If possible, record some interviews to play back and evaluate.  
9. Allow the group to discuss their experiences and/or play back the recorded interviews.
10. Wrap up the discussion by writing some tips emerging from their experiences and your own insights on

the flipchart. These should include:
Answer:

• Chat with the interviewee beforehand to establish rapport and discuss the course of the interview.
(Continued on next page)
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• Make sure the interviewee is aware of broadcasting basics, such as not ruffling papers, switching
off cell phones, and speaking up – but not shouting – into the microphone. 

• Have an interview structure outlined, including the key questions. 
• Listen to the interviewee’s answers and ask follow-up questions, but stay on course with the

questions you want answered.
• Progress from point to point to maintain the interview’s logical flow. 
• Find an elegant way to wind up the interview; for example, “briefly ...“ or “one last point.

This exercise is an adaptation by Ida Jooste of Internews Network of ideas in Broadcast Journalism: Techniques of
Radio & TV News, 2nd ed. Andrew Boyd, Focal Press, 1993. 

“I always make sure that the interviewees are comfortable with the issues I want to discuss
with them. I also remind them that they may get questions that are not related to the topic
being discussed and may be very sensitive. I learned my lesson a few years ago when I had a
psychologist in the studio during a one-hour hour HIV-related program. A listener called in
and asked him whether it was possible for a HIV-positive mother to give birth to an HIV-neg-
ative child. I was astonished when, instead of saying he was not familiar with the topic, the
psychologist bluntly said no. Since I had already reported on prevention of mother-to-child
HIV transmission, I politely interjected to explain how a HIV-positive mother can reduce the
chances that her baby will be born with HIV.”

Kenyan journalist Sammy Muraya. Mr. Muraya won the CNN African Journalist of the Year
Award in 2006.
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LISTENING FOR SOUND BITES

LEARNING OBJECTIVES
By the end of this exercise, participants will:
• Have developed an ear for good actuality.
• Know how to distinguish between which good sound bites are good for news and which are good for features.

MATERIALS
• Sound system: laptop with speakers
• Notepads or paper to write on
• Pens or pencils

HAND-OUTS
None

SOUND
The sound files on the manual CD labeled: 
• The Court Case
• PMTCT Breastfeeding
• Sex Worker

TIME
1 hour

INSTRUCTIONS
1. Make sure that the laptop and speakers have been connected and that you’ve set up the manual CD to

play the sound files referred to above. 
2. Ask the trainees if they use actuality and natural sound in their news and feature pieces. 
3. Tell them you would like to illustrate what a difference good natural sound and good sound bites make.
4. Play the sound file marked “The Court Case“ and ask for comments.
5. Emphasize the power of hearing a view “from the horse’s mouth“ and how much credibility that gives the

news package.
6. Point out the following: 

The two sound bites used give value and credibility to the news story about victimization in the
workplace of a person living with HIV. The lawyer comments on two pertinent issues, represented in
the two sound bites: (a) the doctor’s disclosure of his patient’s status, which is a breech of the right
to privacy, and (b) how, despite the rarity of reinstatement, this is a unique case involving a breach
of constitutional rights.

7. Ask the group to note that the two sound bites contain hard news.  
8. Now play the sound file marked “PMTCT Breastfeeding“, which has six sound bites.
9. Ask for comments.
10. Tell the group to note there are six sound bites by three different interviewees.
11. Point out the following: 

The sound bites illustrate context, background information, and opinion rather than hard news.
For example, Philomena speaks three times. She provides her personal history and says it is good
for people 

(Continued on next page)
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to know their status so that they can access PMTCT services. Dr. Govedi describes how the drugs
work and comments about the role of stigma. This is background information, not hard news.
Finally, Fred encourages men to be more involved in PMTCT.

12. Tell the participants that these kinds of sound bites (and some sound effects) are typical for a feature. They
provide background, context, information, and emotional appeals, rather than hard news.      

13. Now tell the participants you would like to show how they use their interviews to gather such sound bites
in their radio story.

14. Ask them to imagine they are the journalists and producers who put together the two pieces and ask:
What had to happen for them to get those sound bites?

Answer:
For the news story:
• The journalist or producer had to set up and do an interview with the lawyer, which was crucial for

the news angle of the court case story.  
• He or she had to ask pertinent and pointed questions to elicit succinct, newsy sound bites.
• He or she had to listen for the sound bites (sometimes as the person is talking) to be able to

weave them into story.
For the feature story:
• The journalist or producer had to set up three interviews with three different people, each

providing unique background for the story: the wife, the husband, and the doctor.
• He or she had to ask contextual questions for background information; the different answers from

different speakers were important for a well-rounded feature. He or she had to listen for good
sound bites (sometimes as the person was talking) to weave into the story, bearing in mind the
need to avoid repetition. 

15. Tell the group: “Now I would like us to listen to an unedited interview.“

16. Play the sound bite marked “Sex Worker“.

17. Ask the group if they could hear: 
• Bits of interview that were boring and unsuitable for use.
• Bits of interview that were more interesting, and bits that made a point succinctly.    

18. Now tell the group what a sound bite is: 

Answer: 
The portion of an interview or snatch of actuality selected for inclusion in a story. 
• Ask them how they think sound bites for a news piece and for a feature piece would be different. 
Answer: 
• In a news piece, sound bites should encapsulate the main points of the argument, expressing the

strongest opinion or reaction. 
• In a feature piece, you can also include some actuality for emotional effect as well as portions of

interview that give background or context.

Sources: 
Boyd, Andrew. 1993. Broadcast Journalism: Techniques of Radio & TV News, 2nd ed. Focal Press.
Cohler, David Keith. 1994. Broadcast Journalism: A Guide for the Presentation of Radio and Television News,
Prentice Hall.

(Continued on next page)
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19. Now divide the group into two: “the short beeps“ and the “long beeps.“ The “short beeps“ should give a
short beep every time they think they hear a sound bite for news and the long beeps should give a long
beep every time they think they hear a sound bite for a feature. 

20. Play the sound bite marked “Sex Worker“ again – this will be fun! The group will be beeping constantly.
Answer:
There should be more bites usable for feature than for news.

21. Ask the group to describe what made them “feel“ a comment was worth a short beep or long beep. 
Answer: (as above) 
• In a news piece, sound bites should encapsulate the main points of the argument, expressing the

strongest opinion or reaction. 
• In a feature piece, you can also include some actuality for emotional effect as well as portions of

interview that give background or context. 
Ask the group to specifically identify the news and feature beeps in the sound bites. 
Answer: 
NEWS: “Sex with a condom, they pay less and without condom, they pay more. With condom you
know, with condom, it’s not like without condom. So, without condom, you are risking, ja … and
they have hm … somebody is risking also, so you just charge more.“
FEATURE: “Men don’t believe that there’s HIV … and AIDS. Most of them, they don’t believe.“
FEATURE: “I used to sell cabbages, OK vegetables, ja … sometimes you have spent the money and
then they get perished. They don’t make ends meet. I decided to quit.“

22. Wrap up the session by emphasizing that this skill is developed over time and assure the group that they
will develop an ear for a “good sound bite“ —even as the words are being spoken.  

23. Encourage them to listen to packages (e.g., BBC Outlook) and to listen specifically for the sound bites and
actuality used. 

This exercise was developed by Ida Jooste and Benjamin Kiplagat of  Internews Kenya 

Sources: Broadcast Journalism. Techniques of Radio & TV News, 2nd ed – Andrew Boyd, Focal Press, 1993.
Broadcast Journalism. A Guide for the Presentation of Radio and Television News, David Keith Cohler, Prentice
Hall, 1994.
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INTERVIEWING ADULTS AND CHILDREN AFFECTED BY HIV/AIDS

LEARNING OBJECTIVES
By the end of this exercise, participants will:
• Be aware of considerations for interviewing HIV-positive adults. 
• Be aware of considerations for interviewing vulnerable children and/or those affected by HIV. 

MATERIALS
None

HAND-OUTS
• Hand-out 8B (Considerations for Interviewing People Affected by HIV/AIDS)
• Hand-out 8C (Considerations for Interviewing Children Affected by HIV/AIDS)

TIME
30 minutes

INSTRUCTIONS
1. Ask the group if anyone has interviewed an adult or a child who is either HIV-positive or affected by

HIV/AIDS.
2. If any have, ask them to describe the experience. 
Note: This is an informal discussion that aims to draw as much out of the trainees as they have to offer. It may
emerge that they are already quite resourceful and knowledgeable about the subject or that they do not have prior
experience in nor display the required sensitivities for interviewing people affected by HIV. Be guided by answers
from the group. Experience shows that groups can vary quite significantly.

3. Ask trainees to name what they think some special considerations are for interviewing adults who 
are HIV-positive.
Answer: 
• They have the right to dignity and privacy. 
• HIV-positive interviewees are invaluable to our stories because they give HIV a human face. In a

society where stigma is still rife, it takes courage to talk about one’s HIV status. That courage
demands respect.

4. Tell the trainees there is a hand-out with guidelines and additional reading material on the subject.  
5. Ask the trainees if they think HIV-positive people should be paid for granting interviews.

Answer:  
It can happen that an “HIV industry“ develops in a society. Some unscrupulous HIV/AIDS 
organizations may demand money for interviews. This affects the credibility of a story and can put 
the story out of reach for news organizations that cannot afford to pay. Therefore, HIV-positive 
people should not be paid for interviews. 

6. Ask trainees if they think it is acceptable to give HIV-positive interviewees food or another useful item. 
Answer: It is acceptable to give interviewees food or a household item after the interview has been 
granted, as a token of appreciation. This is a matter of choice. Experience will tell one when it seems 
appropriate to give a needy family some food. This is more than acceptable, as the family or 
interviewee has volunteered their time. However, money or food items should never become a 
bargaining tool for interviewing, as this may affect the credibility of the story.  
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7. Now repeat the process described in 1, 2, and 3 above to ask questions about interviewing children who
are vulnerable to and/or affected by HIV. 
Answer: It is important that children’s voices be heard, but only if an adult caregiver has given
informed consent. Children under 18 are too young to decide if their identity should be revealed.
Even if consent is given, do not reveal his or her HIV status, unless it is evidently in the child’s best
interest. Avoid perpetuating the stereotype of a vulnerable child, who is an “innocent victim“ of
HIV/AIDS. Do not use such terms as “sufferer“ or “child victim,“ and in your interaction with the
child, don’t appear overcome by sorrow. A child may read this as a confirmation that his or her
circumstances are overwhelmingly sad. 

8. Distribute Hand-outs 8B and 8C and encourage the group to read more about rights and special
considerations for interviewing HIV-positive adults and children affected by HIV. 

This exercise was developed by Ida Jooste.
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VIEW INTERVIEWING SKILLS TAPE  

LEARNING OBJECTIVES
By the end of this exercise, participants will:
• Know the  basics of interviewing.
• Get to know some technical tips for more effective, professional interviews.

MATERIALS
• A copy of any of the following videos:

- “The Radio Interview,“ produced and directed by Christopher Singh for Radio Africa Network, Rothwell,
Leeds
-  “Basic Radio Skills: The Radio Interview“ (2000) available at
http://movies.yahoo.com/movie/1802824639/info or http://www.firstlightvideo.com/Radio_Production.html 

• Playback equipment and speakers

HAND-OUTS
• Hand-out 8D (Consent Form)
• Hand-out 8E (Take-home Notes Based on Interviewing Skills Tape)

TIME
45 minutes

INSTRUCTIONS
1. Tell the participants they are about to view a tape that highlights interviewing skills.
2. Ask them to play close attention, as there will be a short discussion afterwards.
3. Play the tape. 
4. Ask trainees what they thought of it, and what the most important points were. 

Answer:
Interviews are useful tools that allow opinions to be expressed. They provide information a listener
needs to know. The interviewing format is a good way of involving experts. Before doing an inter-
view, do proper research so listeners can feel confident about the story you are telling them. Be sure
to prepare the interviewee and to instruct him or her not to make unnecessary noises. Interview peo-
ple who can speak with authority on the topic, as well as those who have interesting stories to tell. 
Ask open-ended questions that provide full answers. If you plan to record the interview, make sure
there is good sound balance between the interviewer and interviewee’s voice. If it is a telephone
interview, make sure you have a good connection.  
A good interview is one that is relevant to the listener. If the interviewer listens well, the follow-up
questions will help the interview flow.
There is a sacred triangle between interviewer, interviewee, and listener. Consider the role and
importance of all three. Keep control of the interview while being polite and respectful.
Make sure you have a thorough knowledge of all your recording equipment and the use of different
microphones. 

5. Distribute Hand-outs 8D and 8E and explain the importance of using consent forms.

Source: “The Radio Interview,“ produced and directed by Christopher Singh for Radio Africa Network, 
Rothwell, Leeds.
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HAND-OUT 8A
Interviewing: Tips and Styles

Most information in radio news and feature stories originates from some kind of interview –a chat in
a bar, a phone call, a recording. These interviews turn what your interviewee knows and thinks into
information accessible to your audience. 

Five Quick Tips
• You are the bridge between the expert and the layperson.
• The four Ws: Who, What, Where, and When are essential for the factual information of a story.
• The fifth W, Why, and the How questions take the story to the next level. They deepen the story and make

people think.
• Good background research ensures you are in control of the interview.
• The more you research the topic, the more new information you will draw out of the interviewee.

Interviewing Styles 
1. The hard exposure interview, which investigates a subject
2. The informational interview, which puts the audience in the picture 
3. The emotional interview, which aims to reveal an interviewee’s state of mind 

Exercise
Below is a scenario. Draw up a list of questions to adequately cover the story. 
A patient on ARVs is waiting in line at a hospital to see her doctor for her regular check-up and to receive her
next month’s treatment. She is tired and looks depressed. She has walked far to get to the hospital. Just before it
comes to her turn, the hospital administrator walks into the waiting room, announces that the hospital has run
out of supplies, and apologizes. Someone comments that this confirms the fact that the administration staff is
inefficient, because they don’t order enough medications to meet patient needs. The patient is clearly upset. 
1. Whom would you interview for an HIV/AIDS radio news feature?
2. List at least one question appropriate for each of these types of interviews listed above.

CHAPTER 8: TEACHING JOURNALISTS HOW TO DO RADIO INTERVIEWS
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HAND-OUT 8B
Interviewing People Living with HIV

In 1994, the African Network on Ethics, Rights and HIV published the Dakar Declaration, comprising
10 principles guiding the response to HIV/AIDS, including responsibility, involvement, partnership
and cooperation, non-discrimination, and confidentiality. 

The UNAIDS and UN Commission on Human Rights guidelines outline similar principles (see
www.unaids.org/unaids/document/humright/3797.html). 

Tips to avoid pitfalls and make the most of your interview:

• Check and double-check whether the person is comfortable with revealing his or her identity.

• If you use a pseudonym, stick with the same one in follow-up interviews with the person.

• Never ask: “So how did you become HIV-infected?“

• Never ask: “Does this make you feel depressed, suicidal?“ Instead, ask: “How does this make you feel/how do
you think attitudes about stigma have changed over time?“

• Do not appear shocked at anything the interviewee tells you. It is difficult enough to talk about sexuality.

• Do not ask questions that clearly make the interviewee uncomfortable.

• Talking openly about HIV is becoming increasingly common. One can no longer interview someone simply 
because they are HIV-positive – the story and interviewee need to reveal more than that. 

• HIV-positive interviewees, just like any other, should not be paid for interviews. This guarantees that the
interview is done freely and ensures credibility. 

• Recognize that some interviewees are very poor and have sacrificed their time to be available for an interview.
You may want to buy them some food after the interview is over. This way, you avoid turning the interview
into a “deal.“ 

• Ensure that you have informed consent from the interviewee. It is not strictly necessary to fill out informed
consent forms; sometimes this erects a barrier between interviewer and interviewee. Some people or
organizations may insist on it. Your own judgment should also tell you when you think it is necessary. 

(Please refer to the Informed Consent Form, Hand-out 8D)
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HAND-OUT 8C
Interviewing Children Affected by HIV/AIDS

If your story is about children who are affected in one way or another by HIV/AIDS, there is no doubt
that the sound of a child’s voice will enhance your story. But there are many pitfalls with
interviewing children, particularly vulnerable children.

The following guidelines will help you make the most of the interview:
• Do not violate a child’s right to dignity or privacy. Children under 18 are too young to decide if their identity

should be revealed. Discuss this with the child’s adult caregiver. Even if consent is given, do not reveal his or
her HIV status, unless it is evidently in the child’s best interest.

• Avoid perpetuating the stereotype of a vulnerable child as an “innocent victim“ of HIV/AIDS. Do not use such
terms as “sufferer“ or “child victim,“ and in your interaction with the child, don’t appear overcome by sorrow. A
child may read this as a confirmation that his or her circumstances are overwhelmingly sad. 

• First launch into some general questions about issues that interest children. 
• Children respond well to direct questions about their daily lives.

Example: Instead of asking a child heading a household, “What does it feel like to have to be like an adult?“ you
could ask: “Tell me about the things you do every day for your brothers and sisters.“ The fact that a young voice
is talking about doing adult chores will create the effect you are after.

• Children deserve to have their voices heard about matters that affect them, including HIV/AIDS, but don’t rely
on a child’s version only. They are often too young to understand the full context of their circumstances.

Additional reading material 
http://www.ifj.org/en/articles/childrens-rights-and-media-guidelines-and-principles-for-reporting-on-issues-
involving-children

www.unicef.org/media/media_tools_guidelines.html
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HAND-OUT 8D
Audio Interview Consent Form

SUBJECT’S NAME DATE

SIGNATURE OF SUBJECT PARENT OR LEGAL GUARDIAN (IF SUBJECT IS UNDER 18) 

ADDRESS (PLEASE PRINT) ADDRESS, IF DIFFERENT FROM MINOR’S

I permit ....................................................................................................... to write, record, own, and broadcast my voice for
news and feature purposes. I acknowledge that the stories or recordings taken on this date then become the
sole and exclusive property of ...........................................................................................
I release ........................................................................... and its representatives from any and all claims that might arise
from use of these images and recordings.

If subject is under 18 years old, a parent or legal guardian must write the minor’s name as the subject and grant
permission by signing on the appropriate line. 
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HAND-OUT 8E
Take-home Notes Based on Interviewing Skills Tape:

General
• Interviews are useful tools that allow opinions to be expressed. 
• They provide information a listener needs to know. 

• The interviewing format is a good way to involve experts in the story. 
• Interview people who can speak with authority on the topic and those who have interesting stories to tell. 

Ready
• Before doing an interview, do proper research so listeners can feel confident about the story you are telling

them. 
• Prepare the interviewee and instruct him or her to not make unwanted noises. 

Steady 
• If you recording an interview, make sure there is good sound balance between the interviewer and

interviewee’s voices. 
• If it is a telephone interview, make sure you have a good connection.  
• Make sure you have a thorough knowledge of all your recording equipment and the use of different

microphones.                                               

Go
• Ask open-ended questions that will provide full answers. 
• A good interview is one that is relevant to the listener and gives good information about a topic. 
• If the interviewer listens well, the follow-up questions will help the interview flow.
• There is a sacred triangle between interviewer, interviewee, and listener. Consider the roles and importance of

all three. 
• Keep control of the interview, while being polite and respectful.
• Be relaxed and enjoy the interview – you are in the privileged position of speaking to a person with useful

information!

Source: “The Radio Interview,” produced by Radio Worldwide, Rothwell, Leeds.
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chapter 9

Teaching Journalists How to Write for Radio
MIA MALAN

Learning objectives
After working through this chapter, the trainer will: 

1. Be able to explain why it is important to teach scriptwriting skills.

2. Be equipped with generic scriptwriting exercises.

3. Be able to develop country-appropriate scriptwriting exercises.

Why is it important to use these skills to train radio journalists?
Scriptwriting skills are key to successful radio journalism. If journalists can’t write compelling
radio scripts, they’re also unlikely to be able to write competent news bulletins or intros for live
programs. Unless they’ve had good training, many journalists never learn the difference
between broadcast and print writing in college or on the job. Some journalists who work in
resource-limited settings may have never done a radio feature before attending your training.
They need to develop their scriptwriting skills, starting with basic scriptwriting principles. 

A good radio feature is built on story-telling skills. Access to accurate HIV information doesn’t
necessarily enable journalists to tell compelling stories. Trainees need to be armed with the
skills to transform HIV facts into human interest features that the public can identify with. 

This chapter provides lesson plans and exercises that will enable journalism trainers to teach
basic scriptwriting skills, story structure, and effective use of natural sound. Most of the exercis-
es are based on HIV story examples and are specific to Kenya. All of the lesson plans, exercises,
hand-outs, and natural sound examples have been saved on the manual CD, which allows you
to change the names of characters and places to sound more familiar to the journalists you are
training. For you as a trainer, it will be helpful to translate Hand-outs B and C into a local lan-
guage, if trainees don’t feel comfortable writing their scripts in English. 

How much time do I need to allocate to mastering this skill? 
• 3 hours during the workshop days 

• 1-2 hours per trainee during the last two production/mentoring days

Exercises 
• An Introduction to Writing for Radio (essential, 20-30 minutes)
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• Practicing How to Write for Radio (essential, 45 minutes to 1 hour )

• What Does a Radio Feature Script Look Like? (essential, 20-30 minutes)

• How to Write to Natural Sound (essential, 20-30 minutes)

• Conducting the Orchestra (optional, 30 minutes) 

• Advanced Scriptwriting Exercise (optional, 30-40 minutes) 

Hand-outs 
9A Why Writing for Radio is Different

9B Radio Feature Scriptwriting Exercises for Journalists 

9C Radio Feature Scriptwriting Exercise Answer Sheet for Trainers 

9D Example of a Radio Feature Script (use this along with the “Kakuma’s Women: Living in Fear”
story on the manual CD) 

9E Advanced Scriptwriting Exercise

9F Orchestra Script

Sound 
• Kakuma’s Women: Living in Fear

• FX of children playing outside

• FX of children playing outside with voiceover

• FX from hospital outpatient area

• FX from hospital outpatient area with voiceover

This is what’s most important to me, when it comes to writing radio scripts. I always try to
write the strongest possible intro. After all, if you have a weak, boring intro, how on earth do

you expect a listener to listen to your story? It sounds obvious, but I continue to come across editors
who suggest putting the most boring information you have in the intro, in order to save the “best”
information for the actual body of the story. Second, and related to the above: I always try to write a
potent ending, to end with a punch. Again, I so often come across even senior radio journalists who
write throwaway conclusions. Is this the final impression you want to leave a listener with, a boring,
useless conclusion that creates nothing but the sound of your own voice?
Having a bad ending means you’ve filed a bad story, end of story. Literally.

–Darren Taylor, Africa Features Reporter, Voice of America, Washington, DC. Mr. Taylor was one of the
chief truth and reconciliation correspondents of the South African Broadcasting Corporation in the late
1990s and won the prestigious S.A. Pringle Journalism Award for his work on it.

“
”
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  AN INTRODUCTION TO WRITING FOR RADIO

LEARNING OBJECTIVES

By the end of this exercise, participants will:  

• Be able to describe the differences between listening to radio, watching television, and reading newspapers.

• Be able to explain the writing implications of these differences. 

• Understand why it is important to use a radio-specific writing style.

MATERIALS

• Flipchart 

• Marker

HAND-OUTS

None 

TIME

20-30 minutes 

INSTRUCTIONS 
1. Tell participants that they’re going to discuss the differences between radio, television, and print. 
2. Ask one participant to take 4-5 minutes to write down a few ideas from other participants. 
3. Ask the person to flip to a new flipchart page. Tell him or her to draw three vertical columns, marked

“Radio,” “Television,” and “Print” on the flipchart. 
4. Ask trainees if they think newspaper writing is the same as writing for broadcast (radio or television).  
5. They’re likely to answer “no.” Ask them why it’s not the same. Allow them to discuss this for 2-3 minutes. 

Answers you are likely to get include: 
• “Radio and television sentences are shorter than newspaper sentences.”
• “Radio and television have presenters and newspapers don’t.” 
• “There are many radio and television news bulletins a day, but only one (and in some cases two)

editions of a newspaper a day.”
Make sure that you get across that radio is for listeners, television for viewers, and newspapers for
readers. This may sound like a simple concept to get across – but it has many implications.

6. Tell the person who writes on the flipchart to write “listeners” below “radio,” “viewers” below “television,”
and “readers” below “newspapers.” 

7. Ask trainees to think about the implications of these terms. The person who writes on the flipchart needs
to jot down words or phrases under each medium (radio, television, or print). 
Get the following concepts across (combine them with the responses of participants): 
• When we read newspapers, that’s all we do. It’s not possible to engage in other activities while you

read (other than coffee drinking or eating). But when you listen to the radio, you don’t look at the 

(Continued on next page)

EXERCISES
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radio; you almost always do other stuff while listening to the radio, such as knitting, doing the
dishes, paging through a magazine, cleaning the house, or preparing a meal. In the case of
television it’s not possible to engage in as many activities, because you have to view the pictures.
Implication: Because people almost never sit down and listen exclusively to the radio, their ability to remember
information is less than for newspaper readers or television viewers. It’s therefore important to keep radio as
simple and focused as possible. Listeners can’t absorb as much information as readers can. Radio features and
news bulletins need to contain significantly less information than newspaper stories.

• Radio is immediate; television and print are not nearly as immediate.
Implication: Hourly news bulletins change all the time; it’s therefore unnecessary to give all the information in
one news bulletin (people won’t be able to remember it and there won’t be enough time, because news bulletins
have time limits). If you prepared a radio feature a week in advance to introduce a talk show, and breaking news
changes the context of the feature, you would have to edit it or adjust the intro to reflect those changes. 

• You can’t assume that listeners and viewers are literate, but readers are always literate.
Implication: Information on radio and television needs to be simpler than information in newspapers. Radio
reports need to be simple enough for illiterate people to understand them.

• Readers have the opportunity to read at their own pace, while listeners and viewers must depend
on presenters. 
Implication: To cater to listeners’ needs and to help them absorb information, radio journalists need to write in
short sentences. They also need to cut out unnecessary information. For example, newspaper stories might say
“2.89 million people in the country are infected with HIV,” while radio stories would say, “almost 3 million people
in the country are infected with HIV.” Presenters also need to speak clearly, with appropriate intonation and
pauses, or listeners may not understand the information being presented. 

• Readers can go back to a story and reread it if they didn’t understand it or if they forgot something.
Listeners and viewers can’t rewind the radio or television, unless they taped the program. 
Implication: Viewers and listeners get only one opportunity to understand something, particularly in the case of
features. It’s therefore imperative to present a limited number of facts in the simplest way possible.

• Readers follow words and still pictures; viewers follow visuals and sound; listeners have only sound
to follow.
Implication: Sound is what makes radio what it is. If sound is not used properly and creatively, radio doesn’t
work. Radio is not the newspaper read aloud on air. Sound bites spoken with emotion in the voices of real
people are much more powerful than a mere newspaper quote. You can paint a picture with sound, particularly
with natural sound. If you know how to use sound well, you can make people feel they’re at the scene of the
story.  

• In the case of newspapers, we write in the “written language” we learned at school; in the case of
broadcast stories, we write in the “talking language” we use in everyday conversation. 
Implication: In radio we use “talking words” instead of “writing words.” For example, we will say “home” instead
of “residence,” “buy” instead of “purchase,” and “take part” instead of “participate.” In some ways it’s unnatural
to write for radio, because when we put words down on paper, we automatically get into “print writing mode”
as we were taught to write at school. Radio journalists need to always be conscious about writing in “talking
language.”

8. Ask the person who jotted down the points on the flipchart to verbally summarize them in a minute  
or two. 

9. Explain to participants they will get the opportunity to practice all these principles in another exercise.

This exercise was developed by Mia Malan.
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PRACTICING HOW TO WRITE FOR RADIO

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to describe the most important radio scriptwriting principles.
• Be able to apply radio scriptwriting principles to the sentences given in this exercise.
• Understand why it is important to use these principles when writing radio feature scripts.

MATERIALS 
• Flipchart  
• Marker
• A pen for each trainee

HAND-OUTS
• Hand-out 9B: (Radio Feature Scriptwriting Exercises for Journalists)
• Hand-out 9C: (Radio Feature Scriptwriting Exercises Answer Sheet for Trainers)

TIME 
Between 45 minutes and 1 hour
Note: The time needed for this exercise depends on the skills and background of the trainees. In our Local Voices
Kenya office, this exercise generally takes about 1 hour to complete; in our India office it takes about 45 minutes.

INSTRUCTIONS 
1. Make sure that you have Hand-out 9C (the exercise sheet with the answers) at your disposal. 
2. Distribute copies of Hand-out 9B (the exercise sheet without the answers); ask trainees to put it aside

momentarily.  
3. Explain to participants that they will be learning and practicing the principles of scriptwriting. 
4. Point out that this exercise requires quite a bit of concentration and can potentially be draining, but that

it’s very necessary. 
5. Explain that you don’t expect them to be able to write a perfect script after this session, but that you do

want them to understand why you correct certain things in their scripts during mentoring.
6. Write the following example on the flipchart (the first example on the hand-out). 

“The woman, who is a graduate of Nairobi University, likes books.”
7. Ask participants how many ideas the sentence has. 
8. Explain that it has two ideas and that this sentence has to be split in two for radio:

“The woman is a graduate of Nairobi University. She likes books.”
9. Introduce each new writing principle in the same way – by writing it on the flipchart first. It will help you if

you first write each example on a different page (before the session starts), so that there is more time for
explanation during the session.

10. Follow Hand-out 9C for specific training instructions and for the different writing principles, as well as for
the answers and explanations you will provide to trainees. 

11. Ask trainees to repeat the different writing principles aloud throughout the session to make sure they
remember them. Do this in the form of a game by saying that you would like to see who can remember
the most principles. 

This exercise was developed by Internews Senior Health Journalism Advisor Mia Malan. Ms. Malan developed all the
exercises that refer to the hand-outs related to this exercise. Some of the writing principles come from a hand-out
given to her by the former Internews Director of Radio Training, George Papagiannis.  
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WHAT A RADIO FEATURE SCRIPT LOOKS LIKE
Note: This exercise works well after trainees have practiced writing for radio. It helps them understand
how all the principles fit together. 

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Understand the structure of a radio feature script.
• Be able to explain the difference between a link, a sound bite, and an intro.
• Understand the importance of time codes and transcribing. 

MATERIALS
• Speakers
• Laptop

SOUND
“Kakuma’s Women: Living in Fear” from the manual CD 

HAND-OUTS
Hand-out 9D (Example of a Radio Feature Script)

TIME
20-30  minutes 

INSTRUCTIONS
1. Make sure the “Kakuma’s Women: Living in Fear” in Chapter 9 of the manual CD is ready to play, using 

a laptop and speakers.
2. Distribute Hand-out 9D. 
3. Ask trainees to follow the script as you play the story. 
4. Allow them 4-5 minutes to discuss what they think of the story.  
5. Explain that a lot of work goes into a good radio script. 
6. Explain the following by referring to the script below (Hand-out 9D):

• There are different fonts on the script. 
• Using different fonts for different functions makes it easier to find time codes and FX (a term that refers

to natural sound).  
• Presentation is easier if the links look different from the sound bites. 

7. Point to the time codes. Ask everyone to find two more time codes. 
• Explain that time codes are important because they help us find a sound bite within the raw material in 

a very time-efficient way.
• Explain that “Track 1, 2:15-2:40” at the beginning of the script means that the battlefield sound was

recorded on Track 1 between 2 minutes 15 seconds and 2 minutes 40 seconds. It was recorded on a
minidisc recorder, which is why it refers to a track.  

• Explain that you need to transcribe every word of your interviews to get accurate time codes and good
sound bites. Explain what transcribing is and how to do it.

• Explain that “Adobe Audition Mary 1” refers to the English voiceover that was recorded on Adobe
Audition and saved under the file name “Mary 1.” 

8. Point to the following instruction at the beginning of the script: 

(Continued on next page)

Internews Radio Training Manual



Internews Radio Training Manual

137

CHAPTER 9: TEACHING JOURNALISTS HOW TO WRITE FOR RADIO

FX: BATTLEFIELD SOUND  (hold in background and then fade out)
Explain that it is important to provide instructions for the editing of natural sound so that sound
technicians will understand what you want to do with the sound. 

9. Ask everyone to find two more instructions in the script for the use of natural sound and discuss this for
two to three minutes.

10. Point out that each sentence starts on a new line. Explain that it’s easier to present a script that way. 
11. Point to the short sentences (radio scriptwriting style). Ask participants to read the first link (the first bit

under “MURAYA, PRESENTER”) aloud to themselves. 
12. Ask them how many ideas are in each sentence. 

Answer: Each sentence has only one idea. 
13. Refer to the sound bites. 

Explain that a good sound bite is typically between 15 and 20 seconds long. Point out that the only
reason why sound bites have longer time codes in this story is because they’ve got English
voiceovers. In such cases you need a longer bit of the sound bite because the vernacular voice
needs to play alone for a few seconds and then dip under the voiceover. Once the English voiceover
has ended, the vernacular sound bite needs to play alone again for a little bit – refer to the story
that you played and ask trainees if they noticed that.

14. Ask them to read the first link to themselves again, followed by the sound bite. 
Explain that the sound bite does not repeat the link and that it should never do that. Explain that
the only way to prevent repetition is to transcribe sound bites. Also point out that the power of
radio lies in sound and that the sound bites of a feature story should be selected from
transcriptions; only then should the links/script be written, not the other way around. 

15. Play the story again and ask trainees to follow it on the script. 
16. Ask participants if they have any questions. 

This exercise was developed by Internews Senior Health Journalism Advisor Mia Malan. The script was written by
Sammy Muraya, who formerly worked for Metro FM at the Kenyan Broadcasting Corporation. Sammy’s story won
the CNN African Radio Journalist of the Year Award in 2006. He was one of Ms. Malan’s trainees.

“When I started working full-time in radio, I had a great mentor. He was an experienced editor in his
early sixties with a white beard, humble but delighted to share his script-writing wisdom with every-
body willing to listen. There is one thing he taught me that sticks in my mind and that I have passed on
many times: When you write a feature script and you are not happy with a specific phrase or para-
graph, don’t spend hours re-phrasing it. Just delete it and write a new one; it makes the script so much
better.
“Make it clear that we write for the ear. Our listeners can’t go back a page or rely on an image.
Therefore we have to tell a story that creates images in their heads and appeals to their senses. Train
people to focus on one main topic, no matter how interesting the side aspects might seem. You can
use mind mapping to help them lay out their stories. Make them use spoken language to keep the
script simple. Ask them to think of one listener only and tell the feature to that very person (thinking of
mums has proven quite successful!). Make them test their script by reading it aloud – it helps to get rid
of useless phrases and complicated words. And, finally, feature writing is a great thing to do. Share the
fun of it. If people see you excited, they will want to try it for themselves.”

–Judith Johnson has worked in radio since 1996 and has trained journalists in Europe and Africa for many
years. Although she’s received many offers to work in TV, she’s never given up her love for radio because
“radio is movies in your head.”
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HOW TO WRITE TO NATURAL SOUND
LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Understand what is meant by “the script should fit the sound.” 
• Write scripts that work well with two natural sound scenarios.
• Understand the impact of using natural sound better.
MATERIALS 
• Sound system with speakers
• Notepads/paper to write on
• Pens or pencils
HAND-OUTS
None 
SOUND
• The sound bites on the manual CD that have been labeled: 

- FX of children playing outside
- FX of children playing outside with voiceover
- FX from hospital outpatient area
- FX from hospital outpatient area with voiceover

TIME
20-30 minutes
INSTRUCTIONS 
1. Make sure each trainee has a notepad/paper, pencil, or pen. 
2. Ask the group what the purpose of photographs in a newspaper is. You may get the following answers: 

• They illustrate a news story. 
• They add color and atmosphere to the written report.
• They transport the reader to the place where the story is happening. 
• They help to highlight an aspect of the print story. 
Mention these points if the participants don’t express them. Explain that natural sound is to a radio story
what a photograph is to a print story. In radio you should write to natural sound: 
• In a way that introduces your characters. 
• To describe the place where your story is happening. 
• To set the tone and ambience for your story. 
Explain that sounds speak for themselves. You therefore don’t have to describe the sounds to the listeners
(e.g., “a door has just opened”).  Instead, say it in a more indirect way (e.g., “a young girl just entered the
room”). 

3. Tell trainees you are going to illustrate the use of natural sound by playing them an example.
4. Play the natural sound example of the voices of children playing outdoors with the voiceover.
5. Ask the group for feedback. During discussion, be sure to reinforce the following concepts: 

• Natural sound helps you introduce your characters. 
• Natural sound helps you describe the place where your story is happening.
• Natural sound helps you set the tone and ambience of your story.

(Continued on next page)
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6. Explain to the trainees that you’re going to ask them to write to natural sound themselves. 
7. Tell them you are going to play a short recording and that you want them to listen to it carefully. 
8. Play the sound bite marked “FX from hospital outpatient area”.
9. Give the participants five minutes to write to the natural sound they just heard.
10. When they are ready, ask for a volunteer to read out his or her script as you play the sound again. 
11. Ask for feedback from the group.
12. Do the same with the next volunteer. If it’s a big group, select four volunteers only.
13. Summarize the main points of writing to natural sound.
14. Play the sound bite labeled “FX from hospital outpatient area with voiceover” as an example of natural

sound that has been mixed with a voiceover (the voiceover is the script that was voiced – it was written to
the natural sound). 

15. Play the sound bite called “FX of children playing outside” to the trainees. 
16. Ask them to think about what script would fit that natural sound. 
17. Tell them you are going to play the example with a script that has been voiced. 
18. Play the sound bite “FX of children playing outside with voiceover.”
19. Ask for their feedback on it. 
Note: If you have more time, you can repeat the whole exercise with the FX of the children playing outside. If your
time is limited, just do the exercise with one of the sound bites and use the second one to play to trainees as an
example to reinforce what they’ve learned. 

This exercise was developed by Mia Malan and Jaya Shreedhar. 

“As soon as you’ve recorded all your interviews and sounds, sit at your computer and transcribe what
you’ve captured. If you’re rushing to deadline, transcribe quickly in point form. But if you’ve got more
time, transcribe your recordings properly. They’re a record of what actually happened and you may
need to refer to or use them again in the near or distant future. Transcribing allows you to re-listen
carefully, deeply, and differently to what you’ve actually collected. It forces you to re-evaluate what
you initially may have thought was a good sound bite but isn’t really. It helps you to focus your story
and to crystallize its flow. It also helps you not to echo or parrot in script and words what you want
your interviewee to say in their own words and in sound. It helps you to tighten your writing, script,
and story. If your broadcaster works in more than one language, the transcribed sound bites will help
your colleagues process your story quickly for their audience/s. Transcribed stories can also very
quickly be converted into online or web stories, in which your sound bites can automatically become
the ‘quotable quotes’ in writing.”

–Angie Kapelianis is a specialist radio journalist at the South African Broadcasting Corporation (SABC).
She was one of the chief truth and reconciliation correspondents of the South African Broadcasting
Corporation in the late nineties and won the prestigious S.A. Pringle Journalism Award for her work on it.
She’s won the CNN African Radio Journalist of the Year Award twice. She’s trained journalists in South
Africa, Kenya, and Uganda. 
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CONDUCTING THE ORCHESTRA
Note: This exercise works well as the last scriptwriting exercise – do it after you’ve done all the other required
exercises. It will help journalists understand how all the individual scriptwriting skills they were taught fit
together. 

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to write to sound.
• Understand how to incorporate natural sound and sound bites into their scripting.
• Be familiar with the creative process involved in weaving together script, natural sound, actuality, and sound

effects. 

MATERIALS
A stick for the conductor (anything you can find – even a pen will work)

HAND-OUTS
Hand-out 9F (Orchestra Script)

TIME
30 minutes

INSTRUCTIONS
1. Distribute Hand-out 9F.
2. Explain that this is an exercise that demonstrates how all the individual scriptwriting skills taught so far fit

together in a radio feature script.  
3. Ask everyone to read through the script in Hand-out 9F – give trainees about seven minutes to do so. 
4. Ask the trainees to note transcriptions of FX and upsounds/sound bites. All the FX is in BOLD CAPS

ALONG WITH INSTRUCTIONS.
5. Explain to trainees that they will each be assigned a role to act out within the script. Explain that it will

work like an orchestra: Each of them will represent an instrument or sound.  
6. Assign roles to the trainees:

• a sheep sound
• driving vehicle sound
• busy market sound
• an HIV test being opened
• papers being exchanged (signing)
• a broadcast anchor, who reads the intro
• a reporter/presenter, who reads the script
• a person who reads the sound bites
• a producer (the “conductor” in this case), who has overall responsibility to execute all of the sounds 

listed above
7. Give the conductor/producer a stick to conduct with.

(Continued on next page)
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8. Ask the person to stand at the head of the table “in front of the orchestra.”  The “orchestra” is the “trainees”
or ”instruments” who have all been assigned roles. 

9. Tell the producer/conductor that all these sounds are at his or her disposal. The producer must make it all
come together, like a perfect piece of music. The producer is the orchestra conductor and must cue in the
different sounds/speech at the correct time.

10. Let all the role players practice their sound/speech or voiceover reading. Now give it a try, with the 
producer cueing in the different sounds as in the script.

11. Let the group repeat this several times, until it sounds well polished.

12. Introduce nuances to the production by letting the conductor fade up or fade down certain sounds (e.g.,
market sounds) to the appropriate level.

13. Voila! A radio feature disguised as an orchestral masterpiece!  

This exercise was developed by Ida Jooste and Ann Mikia from the Kenya Local Voices Team.

GIVING HIV A HUMAN FACE – FRAMING YOUR STORIES   

Many people think of AIDS as something that could never happen to them or their loved ones. When
they read HIV stories with statistics of infection rates, they believe those statistics don’t relate to them,
but to the “other people” out there.  
But we, as journalists, can change that.  
If we give our HIV stories a human face, readers will find it easier to relate to the epidemic. Including
people infected with or affected by HIV in your stories helps your audience realize that AIDS is a reality
that affects everyone, including themselves. 
It is important to choose a case study that your audience will be able to relate to. For instance, if your
readers are from Chennai and they are from the middle class, you should look for someone from that
area that middle-class people will be able to identify with. 

Here are two examples: 
• If you do a story on prevention of mother-to-child-transmission (PMTCT), include an HIV-positive

couple that has successfully used PMTCT drugs and as a result have an HIV-negative baby. NGOs in
your area should be able to help you find such a couple. This will help people relate to the challenges
such parents face and provide them with “living proof” that there are available treatments that work. 

• If you do a story on stigma and discrimination in schools, include an example of a child with HIV who
has experienced discrimination. You can change the name of the child to protect his or her identity.
Build your entire story around this child – it will help readers to relate to the challenges the child faces
and think about the implications of their actions in the schools that their own children attend.   

Finally: HIV stories don’t all have to be doom and gloom. They can be sources of hope and inspiration.
We can tell the stories of many PLHIV who have overcome obstacles and are living lives we all can learn
from. 

–Mia Malan, Senior Health Journalism Advisor, Internews
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ADVANCED SCRIPTWRITING EXERCISE
LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to apply the basic principles of radio scriptwriting to the paragraph in this exercise. 
• Understand why it’s necessary to apply scriptwriting principles. 

MATERIALS
• A pen or pencil for each trainee
• A piece of paper or notebook 

HAND-OUTS
Hand-out 9E (Advanced Scriptwriting Exercise)

TIME
30-40 minutes 

INSTRUCTIONS TO CARRY OUT THE EXERCISE:
1. Distribute Hand-out 9E.
2. Explain that the hand-out contains a badly written paragraph that needs to be rewritten in radio style. 
3. Ask one trainee to read the paragraph aloud to the class.  

When thinking about the most effective method of ensuring the full return to health of children
suffering from diarrhea, it is most certainly vitally important that one remembers to do something
extremely quickly before the child in question becomes dehydrated and starts to lose body fluids
which can result in the child becoming very weak indeed. It is recommended by doctors and health
experts throughout around the world that the child should be given a special drink in order to
facilitate rehydration. The drink is extremely easy to make as its ingredients are easily obtainable by
most people no matter where they live. The rehydration drink consists, simply, of one liter of boiled
water mixed with half a teaspoon of ordinary, plain salt–no other kind is necessary–to which one
must add eight teaspoons of sugar. It is of extreme importance to encourage the child to take small
sips of this special liquid frequently throughout the day without forgetting to do so to ensure that
the child in question can recover his or her full health as soon as it is possible to do so.

5. Repeat the main principles of good radio scriptwriting (one idea per sentence; write in the active voice,
eliminate unnecessary information). 

6. As trainees rewrite the paragraph in radio style, they should ask themselves: 
• Does it make sense? 
• Does it flow? 
• Can the listener follow what's being said?  
• How well does this story work for radio as written? 
• What are the problems with the script? 

7. Tell trainees to also bear in mind the following: 
• Use short, simple sentences so the script makes sense when read aloud.
• Change long words to short words. Leave out any words or any details that aren't necessary.
• Think about just one listener and write for that person in a clear, friendly way.

(Continued on next page)

Internews Radio Training Manual



Internews Radio Training Manual

143

CHAPTER 9: TEACHING JOURNALISTS HOW TO WRITE FOR RADIO

• Make sure the first sentence draws listeners in and makes them want to know more.
Note: There’s no single way to rewrite the story. While it’s important to follow the guidelines listed above, trainees
should be allowed to have individual writing styles. This exercise attempts to get them thinking about using short,
simple sentences.

8. Below is the corrected script:
Children with diarrhea could lose body fluid and become very weak.
You should act fast to ensure that they regain their full health.  
Health experts say it is important to give the child a special drink.
It can help replace the lost body fluid. 
The drink is easy to make.
And the ingredients are easy to get.  
Mix half a teaspoon of salt and eight teaspoons of sugar, in one liter of boiled water. 
Dehydrated children must be encouraged to take the liquid throughout the day.
It will help them recover fast.  

This exercise was developed by Josephine Kamara from our Local Voices Program in Nigeria. Ms. Kamara discovered
the badly written paragraph a few years ago when she was training VOA (Voice of America) stringers. The corrected
script was produced by Ms. Kamara.  
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HAND-OUT 9A: WHY WRITING FOR RADIO IS DIFFERENT 

• When we read newspapers, that’s all we do. It’s not possible to engage in other activities
while you read (other than coffee drinking or eating). But when you listen to the radio, you
don’t look at the radio; you almost always do other stuff, such as knitting, doing the dishes,

paging through a magazine, cleaning the house, or preparing a meal. In the case of television, it’s not
possible to engage in as many activities because you have to view the pictures. 

Implication: Because people almost never sit down and listen exclusively to the radio, they are less able to remember
information than newspaper readers or television viewers. It’s therefore important to keep radio as simple and
focused as possible. Radio features and news bulletins need to contain significantly less information than
newspaper stories.

• Radio is immediate; television and print are not nearly as immediate. 
Implication: Hourly news bulletins change all the time. It’s therefore unnecessary to try to give all the information in
one news bulletin (people won’t be able to remember it and there won’t be enough time, since news bulletins have
time limits). If you prepared a radio feature a week in advance to introduce a talk show, and breaking news changes
the context of the feature, you would have to edit it or adjust the intro to reflect those changes. 

• While you can’t assume that listeners and viewers are literate, readers are always literate.  
Implication: Information on radio and television needs to be simpler than information in newspapers. Radio reports
need to be simple enough for illiterate people to understand them.

• Readers have the opportunity to read at their own pace, unlike listeners and viewers, who depend on
presenters. 
Implication: To cater to listeners’ needs and help them keep the facts straight, radio journalists need to write in short
sentences. They also need to cut out unnecessary information. For example, newspaper stories would say “2.89
million people in the country are infected with HIV,” while radio stories would say “almost 3 million people in the
country are infected with HIV.” Presenters also need to speak clearly, with appropriate intonation and pauses, or
listeners may not understand the information presented. 

• Readers can go back to a story and reread it if they didn’t understand it or if they forgot something.
Listeners and viewers can’t rewind the radio or television, unless they taped the program. 
Implication: Viewers and listeners get only one opportunity to understand something, particularly in the case of
features. It’s therefore imperative to present a limited number of facts in the simplest way possible.

• Readers follow words and still pictures; viewers follow visuals and sound; listeners have only sound to
follow. 
Implication: Sound is what makes radio what it is. If sound is not used properly and creatively, radio doesn’t work.
Radio is not the newspaper read aloud on air. Sound bites that allow listeners to hear the emotion in the voices of
real people speaking are much more powerful than a quote in a newspaper. You can paint a picture with sound,
particularly with natural sound. If you know how to use sound well, you can make listeners feel they’re at the scene
of the story.  

• For newspaper stories, journalists use the “written language” they learned at school. In the case of
broadcast stories, they use the “talking language” of everyday conversation.
Implication: In radio we use “talking words” instead of “writing words”: “home” instead of “residence,” “buy” instead
of “purchase,” and “take part” instead of “participate.” In some ways it’s unnatural to write for radio, because when
we put words down on paper, we automatically get into “print writing mode” because that is how we were taught to
write at school. We need to always be conscious to write in “talking language.”
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HAND-OUT 9B: RADIO FEATURE SCRIPTWRITING EXERCISES FOR JOURNALISTS 
Each numbered sentence in bold is an important principle for radio scriptwriting. This
exercise will teach you how to apply and practice each principle. 
GENERAL GUIDELINE

Will your mother or friend understand this story? If you were telling this story to your mother or friend,
how would you say it?
1. Use one idea per sentence.  
Example sentence: 
The woman, who is a graduate of Nairobi University, likes books. 
The sentence above has two ideas: 
Idea 1: The woman graduated from Nairobi University. 
Idea 2: She likes books. 
The example sentence was written in newspaper style and not radio style. In radio style, it’s better to use a
separate sentence for each idea. 
EXERCISE
Write these in radio style:
• The woman from Kenya likes buying flowers. 

• The woman fears there will no food for supper. 

• Many  of the old pictures have good memories. 

• The woman with five children fears she will have no money for her children’s Christmas gifts. 

• HIV-positive Robert was only able to start high school at 20, because no school wanted him. 

2. Always write in the active voice. 
Sentences in the active voice are shorter and clearer than passive-voice sentences. 
What is active vs. passive voice?
Active: The boy kicked the ball. 
Passive: The ball was kicked by the boy. 
Active-voice sentences start with the subject (the doer in the sentence); passive-voice sentences start with the
object (the thing that something is being done to). 
EXERCISE
Write these in the active voice:
• The child was taken to school by her mother. 

• The towels were washed by the school girl.  

• The girl was told by her father that he was HIV-positive. 

• The memory book was made by the mother for her child.

3. Use simple “talking” words. 
Use simple “talking” words, words that you would use when you speak to a friend or even a child.

(Continued on next page)
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EXERCISE
Correct the following sentences by replacing unsuitable words with “talking” words:
• Robert commenced with high school at the age of 20. 

• The towels were washed by the school girl. 

• Kamau arrived at his residence. His residence has a circular roof.      

• HIV tests are executed in a specific way.     

• The people in that village despise each other.   

4. Eliminate unnecessary information.
Just because you’ve got facts at your disposal doesn’t mean they are essential or even relevant to your story. In
radio, you have to eliminate as many facts as possible, because listeners can’t absorb as many facts as readers.
Remember that people can read a newspaper article again to refresh their memories; in radio that’s not possible.
EXERCISE
Eliminate the unnecessary information in these sentences:
• Rescuers discovered a 47-year-old man from Nairobi after he spent many days lost in the woods. 

• The blond woman fetched her child from school.     

• The 20 resolutions were arrived at after deliberations by 150 MPs from all political parties at the end of a two-day
HIV/AIDS workshop at a Mombasa hotel.

5. Don’t use too many numbers or names.
If your audience can’t go back to hear a story again, it stands to reason that you should keep numbers in a story
to a minimum. Simplify whenever possible.
Round off wherever you can: e.g., $950,000 becomes “nearly a million dollars.”
Personalize numbers for your audience: e.g., 20% of people becomes “one in five people.”
EXERCISE
Change these sentences to make the statistics suitable for radio: 
• According to UNAIDS, 3.87 million people died of HIV-related illnesses between 2006 and 2008. 

• The government says only 45% of Kenyans with HIV have access to the treatment they need to live longer. 

6. Link statistics or important facts to the appropriate authorities.
You cannot say, “In Kenya, 350 people a day die of HIV-related illnesses,” without linking the information to a
source. You have to tell people where you got this information. Bear in mind that more than one study has been
done on HIV mortality and that different institutions may use different figures. 
EXERCISE
Find three important facts about HIV/AIDS in Kenya. Present them in a radio-friendly way.

7. Always make sure the script fits the sound that you’ve recorded, not the other way around. 
Select the sound bites that you would like to use and then write the links. Don’t write a script and then try to throw
sound bites in between, or your script will simply repeat the sound bites and lose much of its integrity and power.
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HAND-OUT 9C: RADIO FEATURE SCRIPTWRITING EXERCISES FOR JOURNALISTS 
Note: These exercises were developed for Kenyan journalists, using Kenyan names and referring to
towns and practices in Kenya. For the best effect, change those names to ones that are appropriate
for the country where you’re doing the training. 

Each numbered sentence in bold is an important principle for radio scriptwriting. This exercise will help you
apply and practice these principles. 
GENERAL GUIDELINE
Would your mother or friend understand this story? If you were telling this story to your mother or
friend, how would you say it?
1. Use one idea per sentence.  
Note: There are obviously some cases when more than one idea can be used in a sentence. However, the
best way to get this idea across to journalists who are new at scriptwriting is to tell them that a sentence
ALWAYS has to have only one idea. Once they’ve mastered this concept, you as the trainer can introduce
the exceptions to the rule.  But that’s not likely to occur until you’re mentoring trainees with their post-
workshop stories. It will take several stories (approximately four) before a trainee is ready to learn the
exceptions to the rule. 
Example sentence: 
The woman, who is a graduate of Nairobi University, likes books.
The sentence above has two ideas: 
Idea 1: The woman graduated from Nairobi University. 
Idea 2: She likes books. 
For radio, the example sentence has to be split up into two ideas. The example sentence has been written in
newspaper style and not radio style. In radio style, it’s better to use a separate sentence for each idea. 

EXERCISE
Write these in radio style:
The woman from Kenya likes buying flowers.
Answer: The woman is from Kenya. She likes buying flowers. 

The woman fears there will no food for supper.
Answer: The woman is scared. There will be no food for supper. 
Notes: 
• Explain that the word “because” is rarely necessary in radio scripts because you can get the same effect by

pausing when presenting. 
• Explain that words sometimes change; in this case, “fears” changed to “scared.”

Many of the old pictures have good memories.
Answer: There are old pictures. They have many good memories. 

The woman with five children fears she will have no money for her children’s gifts.
Answer: The woman has five children. She is scared. She may not have money for her children’s gifts. 
Note: Explain that the third sentence does not start with “because,” since a pause when presenting will have the
same effect.

HIV-positive Robert was only able to start high school at 20, because no school wanted him.
Answer: Robert is HIV-positive. He started school at 20. No school wanted him. 
Another way of rewriting this information to create more suspense is to use the sentences in a different 
order: Robert started school at 20. No school wanted him. He is HIV-positive. 
Note: Explain the effect of using the sentences in a different order to trainees. 

(Continued on next page)
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2. Always write in the active voice. 
Sentences in the active voice are shorter and clearer than passive-voice sentences. 
What is the active vs. the passive voice?
Active: The boy kicked the ball. 
Passive: The ball was kicked by the boy. 
Active-voice sentences start with the subject (the doer in the sentence); passive-voice sentences start with the
object (the thing that something is being done to). 

EXERCISE
Write these in the active voice:
The child was taken to school by her mother.
Answer: The mother took her child to school. 

The towels were washed by the school girl. 
Answer: The school girl washed the towels. 

The girl was told by her father that he was HIV-positive.
Answer: The father told his daughter that he was HIV-positive. 
Note: Note the change from girl (passive voice) to daughter (active voice). 

The memory book was made by the mother for her child.
Answer: The mother made a memory book for her child. 

3. Use simple “talking” words 
Use simple “talking” words, words that you would use when you speak to a friend or even a child.

EXERCISE
Correct the following sentences by replacing unsuitable words with “talking” words:
Robert commenced with high school at the age of 20.
Answer: Robert started high school at the age of 20. 

Kamau arrived at his residence. His residence has a circular roof.
Answer: Kamau arrived at his house/home. It has a round roof. 

HIV tests are executed in a specific way.
Answer: HIV tests are done in a certain way. 

The people in that village despise each other.
Answer: The people in that village hate each other. 

4. Eliminate unnecessary information.
Just because you’ve got facts at your disposal doesn’t mean they are essential or even relevant to your story. In
radio, you have to eliminate unnecessary facts because listeners can’t absorb as many facts as readers.
Remember that people can read a newspaper article again to refresh their memories, but that’s not possible for
radio listeners.

EXERCISE
Eliminate the unnecessary information in these sentences:
Rescuers discovered a 47-year-old man from Nairobi after he spent many days lost in the woods.
Answer: Rescuers discovered a man from Nairobi after he spent many days lost in the woods. 

(Continued on next page)
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Note: Explain that while ages almost always get mentioned in print stories, it’s not the case for radio. If
the man was 80 (very old) or was a young child, the age would be relevant, because you wouldn’t expect
an old man or young boy to survive in the woods. 

The blond woman fetched her child from school.
Answer: The woman fetched her child from school. 
Note: Explain that the woman’s hair color didn’t change anything about the way she fetched her child
from school. However, if the story was about hair color, or the description of a criminal sought by police,
it would have been relevant. 

The 20 resolutions were arrived at after deliberations by 150 MPs from all political parties at the end of a two-day
HIV/AIDS workshop at a Mombasa hotel.
Answer: MPs made 20 important decisions at an HIV/AIDS meeting in Mombasa. 
Note: This sentence was taken from a newspaper story in a Kenyan daily. It is a tricky sentence to fix and
requires the trainees to combine everything that they’ve learned up until now. It takes a while to do with
a group (about 7-10 minutes), but it is well worth the time, because it makes journalists realize that a
simple sentence is usually more powerful than one packed with information. If trainees struggled with
the easier exercises and you’re running short of time, you can leave out this sentence.
Step 1: Remove the unnecessary words and phrases:
“after deliberations”: this is unnecessary, because it’s obvious that MPs deliberated (you can’t arrive at
resolutions without deliberating) 
“from all political parties”: MPs generally represent different parties
“at the end of a two-day”: it’s obvious that decisions are generally made at the end and not at the beginning
or middle of a workshop; most government workshops in Kenya last between two and four days, so specifying
that it was two days long is stating the obvious
“at a … hotel”: almost all government workshops in Kenya take place at hotels, so it’s unnecessary to mention
the hotel location; furthermore, the fact that it was held at a hotel made no difference to the decisions made 
The sentence now reads: The 20 resolutions were arrived at by 150 MPs at an HIV/AIDS workshop in

Mombasa. 

Step 2: Change the “print/jargon” words to “talk” words
“resolution” becomes “important decisions: you can’t assume that the average Kenyan radio listener will
know what a resolution is, particularly people who live in rural villages; it’s therefore better to use an easier
phrase that means more or less the same thing
“workshop” becomes “meeting”: workshop is NGO jargon that doesn’t tell radio listeners much; “meeting” is a
much simpler word
The sentence now reads: Twenty important decisions were arrived at by 150 MPs at an HIV/AIDS meeting in

Mombasa. 

Step 3: Change the sentence to the active voice: 150 MPs made 20 important decisions at an HIV/AIDS

meeting in Mombasa. 

Step 4: Make the sentence more focused for radio
Having two sets of figures in one radio sentence is generally more than the average radio listener can
absorb, particularly if they also have listen to what the 20 decisions were. MPS generally don’t make
resolutions unless a quorum is present. It’s therefore not crucial to mention that 150 MP made the
resolutions.
The sentence now reads: MPs made important decisions at an HIV/AIDS meeting in Mombasa.  

(Continued on next page)
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5. Don’t use too many numbers or names
If your audience can’t go back to hear a story again, then it stands to reason that you should keep numbers in a
story to a minimum. Simplify whenever possible.
Round off wherever you can: $950,000 becomes “nearly a million dollars.”
Personalize numbers for your audience: “one out of five people” instead of “20% of people.”

EXERCISE
Change the statistics to suitable ones for radio in these sentences: 
According to UNAIDS, 3.87 million people died of HIV-related illnesses between 2006 and 2008.
Answer: Almost four million people died of HIV-related illnesses in the past two years. 
Note: This manual was published in 2008. If, for instance, you’re using this exercise in 2009, change the dates to
2007 and 2009 so they correlate with the year you are conducting the workshop.

The government says only 45% of Kenyans with HIV get the treatment they need to live longer. 
Answer: The government says less than half of Kenyans with HIV get the treatment they need to live
longer. 

6. Link statistics or important facts to the appropriate authorities
You cannot say that 350 people a day in Kenya die of HIV-related illnesses without linking that information to a
source. You have to tell people where you got this information. Remember that more than one study has been
done on HIV mortality and that different institutions may use different figures. 

EXERCISE
Find three important facts about HIV/AIDS in Kenya. Present them in a radio-friendly way.
Note: Ask trainees to find these facts on the internet or in publications you provide. In Kenya we usually hand
out a fact sheet at the beginning of the workshop. 

7. Always make sure the script fits the sound that you’ve recorded, not the other way around. 
First select the sound bites that you would like to use and then write the links. Don’t write a script and then try
to throw sound bites in between or your script will lose integrity and power. 
Note: Another exercise in this chapter teaches journalists how to write to natural sound. That is why this
exercise doesn’t go into detail on this matter.  
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HAND-OUT 9D: KAKUMA’S WOMEN: LIVING IN FEAR
Sammy Muraya
FX: BATTLEFIELD SOUND  (hold in background and then fade out)
Time code: Track 1, 2:15-2:40 (vernacular voice); Adobe Audition: Mary 1 (English voiceover)

MURAYA (PRESENTER):
War has driven them out of their countries.
They now live in the Kakuma refugee camp.
The camp is far away from Nairobi.
Almost a thousand kilometers. 
The camp houses tens of thousands of refugees. 
They’re all from war-torn East African countries.  
Most of them are from Sudan and Somalia. 
Rape cases in the camp are extremely high.

FX: Start with vernacular voice, dip and keep behind voice over, then bring the vernacular voice up toward the end.
Time code: Track 1, 2:15-2:40 (vernacular voice); Adobe Audition: Mary 1 (English voiceover)
MARY (VOICEOVER BECAUSE SOUND BITE IS NOT IN ENGLISH OR KISWAHILI):
Three men broke into my house at around 3am and they had guns and they forced me to open the door
for them. And they told me they wanted money. I told them that I did not have any. And then I tried to
plead with them not to hurt me. But to no avail. They told me that if I did not have money they were
going to rape me. I pleaded even more. And as I was doing so, one of the men tore off my clothes and
started raping me, as the two other men kept watch with their guns ready to shoot any refugee who tried
to help me. 
MURAYA (PRESENTER):
Mary is a mother of four. 
She encountered this ordeal two years ago. 
Before the rape she had only three children. 
Now she has four. 
The last born is a handsome boy.
But to her eyes he is a nightmare. 
A nightmare that she must face for the rest of her life. 
She got this baby from one of the rapists.

FX: STREET SOUNDS (keep for 5 seconds and then dip sound under voice; fade out eventually)
Time code: Track 2, 3:23-3:45 (vernacular voice)
MURAYA (PRESENTER): 
One of the many food collection points in Kakuma.
People here are not allowed to work. 
They’re foreigners without working permits. 
Refugees get their food from the World Food Program. 
They collect it from these points. 
But it’s rarely safe to walk there, particularly at night. 
Jane and Alice are sisters.  
A few months ago, they had to fetch their ration.  
Along the way, they were stopped by 5 Dinka boys.  
The sisters tried to fight them. 
But to no avail. 

(Continued on next page)
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FX: Start with vernacular voice, dip and keep behind voiceover, then bring the vernacular voice up toward the end.
Time code: Track 3, 4:13-5:03 (vernacular voice); Adobe Audition: Jane 1 (English voiceover)
JANE (VOICEOVER BECAUSE SOUND BITE IS NOT IN ENGLISH OR KISWAHILI):
One of the men sodomized me. Then when he was through he called on to one of his other friends who
raped me. When they were finished, they told me to run and so I ran so fast. So, I did not even think about
my sister at that time. All I wanted was to get away from those beasts.

MURAYA (PRESENTER): 
Jane ran for her life. 
Bystanders took her to a hospital to be treated. 
Her sister Alice was not as lucky. 
Her hospital had no doctor.

Time code: Track 1, 2:15-2:40 (vernacular voice); Adobe Audition: Alice 1 (English voiceover)
FX: Start with vernacular voice, dip and keep behind voiceover, then bring the vernacular voice up toward the end.
ALICE (VOICEOVER BECAUSE SOUND BITE IS NOT IN ENGLISH OR KISWAHILI): 
When I went to hospital all I was given was Panadol. I was told to wait for the doctor who was not around
at that time. I waited and waited and then I asked about the doctor again. And I was told that he was
busy in a meeting and so I had to go home.

MURAYA (PRESENTER): 
Alice never went back to the hospital. 
No doctor did a rape examination on her.
She’s not the only one. 
Mary, whom we heard of earlier in this story, also ended up without someone to attend to her.  

Time code: Track 5, 4:15-2:26 (vernacular voice); Adobe Audition: Mary 2 (English voiceover)
FX: Start with vernacular voice, dip and keep behind voiceover, then bring the vernacular voice up toward the end.
MARY (VOICEOVER BECAUSE SOUND BITE IS NOT IN ENGLISH OR KISWAHILI): 
I went to hospital and I was told that they were still on holiday and so I could not receive any treatment. I
was angry and so I did not go back.

MURAYA (PRESENTER): 
Mary, Alice, and Jane are very likely to have contracted HIV during the rapes.  
Some people believe the HIV rate in Kakuma to be as high as 60%.  
But none of these three women know their HIV status. 
The stigma attached to HIV keeps them from going for tests. 

Time code: Track 5, 4:15-2:26 (vernacular voice); Adobe Audition: Alice 2 (English voiceover)
FX: Start with vernacular voice, dip and keep behind voiceover, then bring the vernacular voice up toward the end.
ALICE (VOICEOVER BECAUSE SOUND BITE IS NOT IN ENGLISH OR KISWAHILI): 
I don’t want to go for a HIV test, because if I learn that I am HIV-positive people in the camp will know
and they will begin pointing fingers at me saying, “There is the HIV-positive woman” … and I will have no
friends in this camp and I don’t want that.

(Continued on next page)
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FX: Start with vernacular voice, dip and keep behind voiceover, then bring the vernacular voice up toward the end.
Time code: Track 5, 4:15-2:26 (vernacular voice); Adobe Audition: Mary 3 (English voiceover)
MARY (VOICEOVER BECAUSE SOUND BITE IS NOT IN ENGLISH OR KISWAHILI): 
Right now people already hate me in the community. I have no friends. No one talks to me and the worst
thing is that no one, no one wants to hold my baby. It would be worse if they were to find out that I am
HIV-positive.

MURAYA (PRESENTER): 
Stigma at the Kakuma refugee camp is so bad that out of almost one hundred thousand people living in the
camp, only one has gone public about his HIV-positive status. 
Like most of Kakuma’s residents, Mary, Jane, and Alice prefer living in the dark.  
Living without knowing whether they are HIV-positive or not. 
HIV-related stigma stands between them and an HIV test.
This report was prepared for A Stitch in Time by Samuel Muraya.
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HAND-OUT 9E: ADVANCED SCRIPTWRITING EXERCISE
The paragraph below is not suitable for radio. Rewrite the paragraph in radio style. 
GUIDELINES
Ask yourself:

• Does it make sense? 
• Does it flow? 
• Can the listener follow what's being said?  
• How well does this story work for radio as written? 
• What are the problems with the script? 

WRITING TIPS
• Use short, simple sentences so that the script makes sense when read aloud.
• Change long words to short words. Leave out any words or details that aren't necessary.
• Write in the active voice. 
• Think about just one listener and write for that person in a clear, friendly way.
• Make sure the first sentence draws listeners in and makes them want to know more.
When thinking about the most effective method of ensuring the full return to health of children suffer-
ing from diarrhea, it is most certainly vitally important that one remembers to do something extremely
quickly before the child in question becomes dehydrated and starts to lose body fluids which can result
in the child becoming very weak indeed. It is recommended by doctors and health experts throughout
around the world that the child should be given a special drink in order to facilitate rehydration. The
drink is extremely easy to make as its ingredients are easily obtainable by most people no matter where
they live. The rehydration drink consists, simply, of one liter of boiled water mixed with half a teaspoon
of ordinary, plain salt--no other kind is necessary--to which one must add eight teaspoons of sugar. It is
of extreme importance to encourage the child to take small sips of this special liquid frequently through-
out the day without forgetting to do so to ensure that the child in question can recover his or her full
health as soon as it is possible to do so.

Internews Radio Training Manual

H
A
N
D
-
O
U
T
S



Internews Radio Training Manual

155

CHAPTER 9: TEACHING JOURNALISTS HOW TO WRITE FOR RADIO

HAND-OUT 9F: ORCHESTRA SCRIPT
INTRO: 
According to the Centers for Disease Control Kenya has more than 400 centers for voluntary
counseling and testing, also known as VCT. 

They’re all around the country.
Quite a few are in rural areas.  
At a VCT center you can get your results within 45 minutes. 
Everything is confidential and good counseling is provided. 

Antony Ngige visited a mobile VCT center and filed this report. 

SCRIPT: 

FX: TRACK 7, 4:15 (MOVING VEHICLE – PLAY FOR 2-3 SECONDS AND THEN DECREASE SOUND LEVELS AND KEEP
UNDER VOICER)

It's Thursday morning, 9 o'clock.

I am on my way to Mweiga, a rural town in Nyeri District. 

FX: BRING VEHICLE SOUND UP FOR 3 SECONDS…THEN KEEP UNDER VOICE…)

I have a special mission.

I will be visiting a mobile VCT center.

It will be there for three days.

FX: MIX CAR SOUND WITH MARKET NOISE AND KEEP MARKET NOISE UNDER VOICE (MARKET SOUND – TRACK 2, 3:10)

First, I stop at the local market.

A counselor, Stanley Ngara, is telling people about the VCT tents he and his colleagues have put up

FX: TRACK 2, 3:40 SHEEP BLEATING AT THE MARKET. INTRODUCE SHEEP SOUND WITH MARKET NOISE STILL IN THE
BACKGROUND.  KEEP THE MARKET NOISE GOING BEHIND THE SOUND BITE AND VOICER THEREAFTER. 

Track 1, 7:45-8:05 Come and listen to us! Today we have come here to give you good news, have you
people heard about VCT? Now we are here to give you a message. For those who don’t know, a VCT
center is a place where can go to learn how to protect yourself from being infected with HIV.  You can also
get to know your status. If infected, you get to know how you’re going to survive while eating well, just
like that lady has told us, how to live positively with it. If not infected, you will learn how to protect
yourself and your partner.

FX: TRACK 2, 4:14 VILLAGERS FOLLOWING STANLEY. MANY PEOPLE ARE FOLLOWING STANLEY. 

Villagers are following Stanley.

He has a huge VCT puppet with him.

FX: TRACK 2: 5:20 VILLAGERS ADMIRE THE PUPPET. 

Villagers love the puppet.

Almost no one has been to a VCT center.

There is no VCT close to the village.

(Continued on next page)
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But today things will change.

The crowd has already started throwing questions at Stanley's VCT puppet.

Track 9, 6:35 – 53 
Villager: How does one get help if positive?
Stanley: Good question!  First, you have to know your status. Second, when tested and found infected
you don’t start medication immediately, one has to go to the clinic, you get counseled and also tested for
something we call CD4 count. Then the doctor prescribes for you when to take medication, so in the
general hospital you will get all this information.
Villagers seem to be ready to join Stanley at the center.

It's just a 10-minute walk from the market.

FX TRACK 8, 13:12 STANLEY CALLING THE CROWD

Please come all!  At the St. Joseph Brothers Church Hall. Take action and control! Be tested – it’s free of
charge and very confidential! 
At the St. Joseph’s Brothers Hall, camping tents have been put.

People will get tested and counseled inside of the tents. 

Francis Ngunjiri has decided to get tested.

He has no problem with me joining him inside the tent for the session.

Track 9 1:05 – 1:20 (Lucy) Welcome to the VCT tent! Please come inside. 

FX track 9 2:34-50 ZIP OF TENT OPENING, LUCY THE COUNSELOR WELCOMING A CLIENT, AND THEN CLOSING THE
ZIPPER AGAIN. THE CLIENT’S FOOTSTEPS TO A CHAIR FOLLOWS AND HE SITS DOWN.

Track 9, 4:15-30
Lucy, the counselor: Your session will take about 45 minutes after. We will first pre-counsel you, then test
you for HIV if you feel comfortable with it, wait for your results, and then post-counsel you. I’d like you to
feel as comfortable as possible and free to ask whichever question you’d like to. 

Track 9, 4:45-5:05
Client: Thank you. I came here today because I wanted to know of my status. If I’m positive, I'll know what
to do and get treatment so that I can live like any other healthy person.
Lucy takes her client through the pre-test counseling session.
She tells him more about VCT and how an HIV test works. 
I realize the client has now become more relaxed.
He looks ready for the test. 
It will take 15 minutes before the results are out. 

FX TRACK 10, 2:00 – 2:10 CONTAINER/GLOVES BEING PUT ON 
FX TRACK 10, 1:53-54 (HIV TEST KITS BEING OPENED)

Track 11, 2:15 – 2:30 9 (Lucy) This is the time for testing, the test takes 15 minutes, I will take some blood
from your finger, it’s a little painful. We will wait for the results, but before we do that I mentioned that
we have a form, whereby it has got a few questions, and I request your mother’ s name, then you sign for
me. (Continued on next page)
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FX, TRACK 11:3:06 – 3:16 SOUND OF THE CLIENT TAKING THE PAPER FROM LUCY AND SIGNING
Track 11, 2:30 - 45 (Lucy) Before we do the testing I will show you how to interpret your results. In VCT it’s
the client who reads the results so that you can be confident that they’re indeed true. 
Track 11, 2:45 – 3:05 (Lucy) If you are negative we don’t need to use another test kit. Because the first one
we are using is very sensitive, it will pick up if there is any infection. So it’s accurate and you can trust the
results.
Everything at VCT centers is confidential. 
I therefore have to leave the tent so that Francis and Lucy can have a look at his results in private. 
After the test, he however joins me under a nearby tree.  

Track 12: 5:12-25 (Client) I was just tested and I'm HIV-negative. I'd like other young people here in
Mweiga to come and get tested, because even if you are positive, that’s s not the end of the world. Many
positive people have lived for long. You just have to maintain good nutrition and get antiretroviral
treatment and use it correctly. If you know you've had unprotected sex, then it’s important to just go and
get tested.

As we talk, more people are coming in and the counselors get busier. 
On my way out of St. Joseph’s Brothers, Stanley decides to see me off.
I see that he is upbeat.
He’s happy because the locvals are coming to get tested in big numbers.
Knowing their HIV status will help the people of Mweiga to make informed choices about life. 
Antony Ngige, Mweiga Village, Nyeri.  

This script was written by Antony Ngige, who worked for Kameme FM, a private Kenyan radio station that broadcasts
in English and Kikuyu. Mr. Ngige wrote the script during an Internews workshop in September 2005. He and his fellow
trainees went to Mweiga village in Nyeri to report on a mobile VCT center operated by Liverpool VCT Center in Nairobi. 

Radio thrives on evocative, imaginative, fresh, and crisp writing. Become your own
photographer or camera person in the field. What do you see? Force yourself to describe it as

succinctly as possible and capture that in writing. Ask yourself how you will remember the event, the
day, and the person or people you’ve interviewed or recorded.  Write that down and make it an
important part of your script and story. A good radio story is like a journal or diary, capturing the
essence of what happened or who said what. But it’s often void of the ego of the ‘I.’ And, yes, there are
and will be times when stories told in the first person are the most effective. But don’t let the ego of
the ‘I’ lock out or exclude your listener. We can never paint the whole picture, but we can focus on
parts of the picture that stand out for us. Pay attention to the detail, but paint your story in broad
strokes, so that you leave something to the imagination of your listener. Avoid loaded and subjective
adjectives. Instead, focus on the power of active verbs. Avoid becoming formulaic and predictable in
your writing. Strive to find new ways of saying what you see and hear, especially when
stories or events such as anniversaries, parliamentary sessions, or strike seasons recur.

–Angie Kapelianis is a specialist radio journalist at the South African Broadcasting Corporation (SABC).
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chapter 10

Teaching Journalists How to Record 
Good, Creative Sound
SONYA DE MASI

Learning objectives
After working through this chapter, the trainer will: 

1. Be able to explain the importance of training journalists to record good sound in radio.

2. Be equipped with instructions and exercises for teaching journalists to record good, clean,
creative sound.

3. Understand why the instructions in this chapter need to be adjusted to the knowledge levels
of trainees. 

Why is it important to teach radio journalists this skill?
Radio is powerful because it can reach a large audience in an immediate and accessible way.
Part of its attraction is the ability to create a community of listeners. A good story, told well, is
one thing, but a good story, told well with creative and appropriate use of sound, can make all
the difference. Without pictures and sometimes even without words, radio can transport the
listener to a place, elicit an emotional response, suspend reality, and create the illusion of a
shared experience – even if just for a moment. 

The use of sound to supplement story telling is what distinguishes radio from other forms of
journalism. With very limited resources – a microphone, a recording device, and headphones –
radio journalists have the tools to capture the essence of an experience or event. They are then
in a position to recreate it for their audience. Recording good sound is one of the most funda-
mental and important skills for any radio journalist, including those who regularly report on
HIV. If you can encourage journalists to think about sound as an integral part of their story
telling, you are on your way to helping them appreciate the challenges and the rewards of
making their HIV stories compelling and powerful.  

If HIV journalism workshops don’t equip radio reporters and presenters with strong sound-
recording skills, they won’t succeed in empowering the trainees to tell good HIV stories either.
The Local Voices workshops therefore include sound technicians as co-trainers, working closely
with the journalism trainer.

This chapter provides lesson plans and exercises to enable a journalism trainer to guide jour-
nalists through the process of capturing sound and saving audio files to ensure they have the
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best-quality raw sound with the equipment they have at their disposal. These are the exercises
we most commonly use in our Local Voices field offices. All the lesson plans and exercises have
been saved on the manual CD, should you decide to adjust them or make changes.   

How much time do I need to allocate to teaching this skill in a 
weeklong training? 
Four hours in total: 

• 1.5 hours for the use of recording equipment

• 2.5 hours for recording exercises

Exercises 
• Recording Sound (essential, 1 hour, 30 minutes)

• Recording Sound in the Field (essential, 1 hour)

• Adjusting a Room for Good Sound Recordings (optional, 30 minutes)

• Recording Sound in the Studio (essential, 1 hour)

• Breathing Exercise (optional, 30 minutes)

• Recording Natural Sound (optional, 1 hour)

Hand-outs 
10A Recording Tips

10B Vox Pops

10C Voice and Presentation Tips 1

10D Voice and Presentation Tips 2

10E Script for Presentation Exercise

10F Recording Natural Sound

Sound (on manual CD)
• A School for All Children (a radio feature with creative use of sound by Anne Waithera) 

• Popping

• Off-mic 

• Cable noise

• Wind

• Bad background sound
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RECORDING SOUND

LEARNING OBJECTIVES
By the end of this exercise, participants will:  
• Be able to operate a recording device (the model you provide to trainees for the workshop).
• Understand the basic principles of capturing sound.

MATERIALS
• Digital recording device (minidisc or flashdisc): one for each trainee
• Microphone: one for each trainee
• Headphones: one set for each trainee
• Laptop with good external speakers

SOUNDS
• A School for All Children (a radio feature with creative use of sound by Anne Waithera) 
• The following sound files (prepared by the Internews Kenya Technical Manager Benjamin Kiplagat) 

- Popping
- Off-mic
- Cable noise
- Wind
- Bad background sound

HAND-OUTS
• Hand-out 10A (Recording Tips)
• Operating guides or manuals from the internet (if necessary) – all the website links are listed under #4 in this

exercise

TIME
1 hour, 30 minutes

INSTRUCTIONS 
Training journalists in the proper recording of sound requires only one facilitator. This could be the sound
technician trainer in your Local Voices office if he or she is skilled enough to deliver the training alone, in the
local language. However, the sessions might also benefit from the input of both the journalism trainer and the
sound technician, to enable the journalism trainer to assess the trainees’ skill levels and contribute to the
training dynamic. This is a decision that is best made by the local team at the time of training.
1. Make sure you’ve set up the manual CD on a laptop with good external speakers. 
2. With the trainees gathered in the training facility, introduce the broad topic of recording sound. Ask

participants: “What is the difference between radio and print?“ 

Answer: Listeners do not have a visual reference for stories, so radio journalists must “draw
pictures“ with sound. 
You can revisit issues raised in previous sessions, such as principles learned in the scriptwriting session.
One example is how listeners, unlike readers, cannot return to something earlier in the story, so sound
must be appropriate for the story setting or the listener can become confused or distracted. Take the
opportunity to talk about the use of sound in radio and why it is critical to gather good, clean sound.

(Continued on next page)

EXERCISES
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3. It helps to demonstrate the use of sound in radio. Play “A School for All Children“ on the manual CD. 
Note: If available, play a feature in the local language.
The focus is on production values, not the language or scripting. Ask participants to listen for the following:
• How many different natural sounds have been used in the story? (If you had not explained what

natural sound is at this point in your training, please remember to do so before asking trainees to
listen for natural sound.)

• Have the sound bites been recorded clearly? Ask them to note the sound bites that could have
been recorded better.

• Was the presenter’s voice recorded clearly?
Encourage group discussion of these issues for about 10 minutes.  

4. Distribute Hand-out 10A (Recording Tips). 
5. Make sure you have the following bad recording examples on the manual CD at hand: 

• Popping
• Off-mic
• Cable noise
• Wind
• Bad background sound

6. Carefully go through each point on the hand-out.
7. Play the following bad sound examples when discussing points 2 and 3 (“Choose an appropriate location“

and “Prepare the location“) on the hand-out:
• Wind
• Bad background sound
Use the “Wind“ and “Bad background sound“ examples to show trainees what recordings sound like in
inappropriate recording environments. Engage the group with questions such as:
• What’s wrong with this sound?
• Has this ever happened to you? 
• What’s the solution?

8. Play the following bad sound examples when discussing point 4 (“Watch the microphone position“):
• Off-mic
• Cable noise
• Popping

9. Use the bad sound examples to illustrate to trainees what recording sounds like if the microphone is not
held correctly. Engage the group with such questions as: 
• What’s wrong with this sound? 
• Has this ever happened to you? 
• What would be the solution?

10. Illustrate what an “off-mic“ position looks like and how cable noise happens by moving the cable of the
microphone slightly. Explain what popping is.

Answer: A B or P that explodes into the microphone.
(Continued on next page)
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11. Discuss the rest of the hand-out points. 

12. Give everyone a 5- to 10-minute break to stretch their legs. Explain that you’re going to teach them how
to record good sound after the break. 

13. Call trainees back to the session. 

14. Distribute a recording kit (recorder, microphone, and headphones) to each trainee so they can become
familiar with the equipment. 

15. Explain the basic functions, including headphone input, how to adjust headphone volume, recording
input levels, microphone jack, and how to load and remove the sound card or minidisc. For supporting
materials (in English), some of the most popular digital recorders were at the time of publishing available
at the following sites:

http://www.samsontech.com/products/relatedDocs/H4_manual.pdf  for the Zoom H4 flashdisc

http://www.usersmanualguide.com/sony/minidisc_walkman for a range of Sony minidisc models

http://www.sharpusa.com/products/TypeManuals/0,1083,57,00.html has a range of Sharp minidiscs

http://www.d-mpro.com/users/getdownload.asp?DownloadID=293 for the Marantz PMD660

http://www.olympus.co.jp/en/support/imsg/vtrek/download/manual/ for Olympus flashdiscs

Note: Make sure that you are familiar with the user instructions of the recording device you’re teaching trainees to
use so you can respond to questions and perhaps troubleshoot later. Print the manual and highlight the most
important and basic functions. You will not be able to teach trainees everything about the device, and it is unlikely
they will ever need all the functions, especially with the more modern equipment. You may choose to put together a
simplified manual based on the manufacturer’s instructions to enable a new user to refer to the basic functions:
recording, saving, marking tracks, and transferring sound. Some trainers make PowerPoint slides diagramming
some of these functions. While PowerPoint demonstrations are not an ideal teaching method, projecting images on
a screen can sometimes help ensure that everyone can identify the correct element as you demonstrate.

16. Encourage each trainee to connect all the relevant equipment (headphones and microphones). You can
use the previously mentioned PowerPoint display or, for low-tech environments, a flipchart. Demonstrate
first and then encourage trainees to do the same. 

17. Move around to check on all participants. Repeat instructions as often as necessary to encourage
progress; less-experienced trainees may need several opportunities to master the equipment. There’s no
firm rule, but keep in mind that new technology can be challenging. Many journalists might still be using
extremely low-tech equipment (cassette recorders) and could find a brand new, late-model flashdisc a bit
daunting. 

18. Allow trainees at least 15 minutes (but as long as is necessary) to become familiar with the equipment. 

19. Ask participants to divide into pairs to work together. Encourage them to interview each other. If they
can’t think of questions to ask, propose:  

• Why did you want to become a radio journalist?

• What did you have for breakfast?

• How did you get here today?

Note: Some journalists may already be skilled at recording but unfamiliar with the equipment you are training
them on.

(Continued on next page)
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20. Make sure that you and/or the sound technician check the sound quality of the trainees’ recordings by
listening to the recordings through headphones. If you identify poor recording, including popping, poor
levels, or off-mic speech, demonstrate for the whole group what these sound like. More experienced
journalists and those who have had some formal training will likely only need to be reminded of the
principles of good recording cited in Hand-out 10A.   

21. Allow each person to identify the problem in his or her recording and propose a solution. The answer to
most of these problems is to change location (an exercise later in this chapter demonstrates how to
improve the acoustics of a room). Most journalists just need to be reminded that they need to control the
interview: If the location isn’t working for them, they should delay recording until everything is right. Turn
things off, move closer, move somewhere else, wait – these are the most simple tools for ensuring a good
recording. This part of the exercise can be covered in about 30 minutes. 

22. Revisit the following key points with the entire group: 
• Watch levels. The level meter should not exceed 0 dB or the sound will distort.
• Switch off the air conditioner before recording or there will be a steady and distracting hum in the

background. 
• Record in a room with curtains or in a corner; sound recorded in sparsely furnished rooms (like

clinics and hospitals) will sound hollow. 
• Wear headphones when recording. This is not optional.
• Watch your microphone position. It should be three to five inches from the speaker, a little off-

center. Don’t move the cable or your hand against the microphone, or cable noise will result.
• For noisy environments, record at least one minute of the ambient sound to soften editing.

This exercise was developed by Sonya De Masi with reference to the training methods of Solomon Teferi, Local
Voices Ethiopia Sound Technician, and Benjamin Kiplagat, Technical Manager  of the Local Voices Program in
Kenya. Mr. Kiplagat also prepared the sound examples for this exercise.  
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RECORDING SOUND IN THE FIELD
Note: This exercise should always be done AFTER the “recording sound“ exercise. In our
Local Voices offices, our sound technicians generally teach this exercise.

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to record good clean sound on location.
• Understand how sound might be used effectively in a feature.

MATERIALS
• A digital recording device (minidisc or flashdisc) for each trainee
• One microphone for each trainee 
• A headphone set for each trainee

HAND-OUTS
Hand-out 10B (Vox Pops)

TIME
1 hour

INSTRUCTIONS 
1. Send everyone on a mission called “Ten Minutes in the City“ (or town, village, camp).
2. Trainees have 10 minutes to gather as much sound as they can to illustrate an aspect of the environment

outside the training facility. The goal is not to bring back a random collection of sounds but rather
something that will illustrate a place, a group of people, an event, or a situation. Quality, not quantity, is the
goal.

3. Everyone should return at an agreed time that the facilitator sets. It’s useful to interrupt this session with a
tea break to give you time to process the recordings and prepare them for playback.  

4. While the trainees take a break, load recordings into the computer. This is done more quickly with a
flashdisc, which transfers immediately, than with a minidisc. If a tea break is not feasible, and trainees used a
minidisc, ask someone with sound experience to help (limit recordings to three or four) and discuss how the
exercise went: where, what, what worked, what didn’t. 

5. When you play back the recordings, try to include everyone in the discussion. It is not necessary to play
back everything, or entire single recordings. Your purpose is to get the group to discuss what they are
hearing. Propose ways the sound might or might not be useful in a story. Discuss the challenges of
identifying sound that is useful, appropriate, and relevant in a story.

6. It is likely that there will be wind noise, mic and cable sound, low levels, distortion, and inaudible or unclear
audio, as well as some brilliant finds. Explain what’s good, what’s bad, and how to correct what’s wrong.
Encourage trainees to give their input. 

7. Distribute Handout 10B (“Recording Vox Pops“) and talk through the key points, including what a vox pop is
and what it’s used for. 

Note:  If you distribute this at the beginning of the session, it’s likely the journalists will focus on this rather than just
on sound. It’s therefore better to distribute it at the end of the session. Take the opportunity to ask trainees whether
they have used vox pops before and what their experiences were in gathering them.

This exercise was developed by Sonya De Masi with reference to an exercise by training consultant Virginia
Moncrieff (“Ten Minutes in the City”). The Internews in-country sound technicians in Kenya and Ethiopia also
contributed to the development of this exercise. 
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ADJUSTING A ROOM FOR GOOD SOUND RECORDINGS
Note: This exercise should always be done AFTER, never before, a session in which the
principles of good sound have been explained. This exercise requires trainees to apply
the knowledge they learned in a previous session. 

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to appropriately adjust the training room for good sound recording.
• Understand how to adjust other rooms, such as hospitals, for optimum recordings.

MATERIALS
Note: Most training rooms have air conditioners, fluorescent lights, a huge table, and sometimes pillows on the
chairs. If the pillows are not detachable, then provide a tablecloth, towel, or piece of material. 
• Air conditioning that is turned on
• Fluorescent lights that are turned on
• A huge training table without a tablecloth
• Pillows or material

HAND-OUTS
None

TIME
30 minutes 

INSTRUCTIONS 
1. Explain that this exercise will help you evaluate how well the group understands how to adjust a room for

good sound.  
Note: It is important to have already addressed all the good sound recording principles in a previous session. If
you have not done so, then first address the effects of: 
• Air conditioning on sensitive microphones (it results in a loud “sshh“ sound in the background).
• Fluorescent lights on recordings (it results in a loud “zzz“ sound on the recording, even though the ear

can’t detect it).
• Large reflective surfaces on sound (it sounds hollow, as if you’re recording in an empty room).
If you have not already addressed the solutions to these problems in an earlier session, do so now:  
• Ask interviewees to turn off the air conditioning. If that’s not possible, ask if the interview can be con-

ducted in another room or outside the building.
• Ask interviewees to turn off the lights.  Although you don’t want total darkness, it’s better to do an inter-

view in a dimmed room than a room with all the lights on.
• Tell interviewees that fabric absorbs sound and can improve the sound that can be recorded in an empty

or sparsely furnished room. For example, covering a large table, or part of the table, with a tablecloth or
even pillows (if that’s all that you’ve got) will improve the quality of the recorded sound of your 
interview.

• The sound quality of an interview is better when recorded in a corner rather than the middle 
of a room.

(Continued on next page)
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2. Tell trainees that you would like them to prepare the training room for an interview and that there are
quite a few things that need to be adjusted to ensure good-quality sound. 

3. Explain that you will leave the room for 10 minutes while they prepare it, and that you would like to
return to a room with creative solutions. 

4. Tell them they may ask the receptionist or someone else to help them find the light switches. (Make sure
you’ve informed that person that such requests may be made and ask them to play along.) 

5. Instruct the journalists to appoint a spokesperson who will explain the solutions and adjustments to you
on your return.

6. Try to get the trainees enthusiastic about this exercise; make them feel that you’re really excited to see
what they’re going to come up with. Tell them there may even be a small prize for good work!

7. Leave the room. 
8. Return after about 10 minutes.
9. Ask the spokesperson to explain the changes to the room. 
10. Determine if they’ve done everything necessary for good sound recording and explain why or why not. 
11. If not all necessary adjustments have been made – for instance, putting a tablecloth or small pillows from

the chairs on the table – explain that the table is still going to lead to a bad recording and that they have
to adjust it while you’re in the room. Let them do it; don’t do it for them. 

12. Remind the participants that during the site visit they’re likely to end up in a room that they will need to
adjust for recording.

13. Congratulate the trainees on their solutions and give each a small gift, such as a mini chocolate, a few
sweets, or a colorful pen. 

This exercise was developed by Mia Malan.

“I developed this exercise while I was the Resident Advisor in Kenya from 2003-2006. I found that
merely explaining the principles of good sound recordings didn’t stick in trainees’ minds unless they
were compelled to apply them prior to going on a site visit. When students get the opportunity to
apply the solutions prior to a site visit, they return with much better sound. Our training room in
Nairobi had air conditioning, fluorescent lights, and a large conference table without a tablecloth – all
the makings of a bad sound recording! So it worked well for this exercise. Most hospitals have record-
ing environments that need similar solutions – rooms without carpets or curtains or something to
absorb the sound. 
“After doing this exercise with a group of trainees, I accompanied them on a site visit to an HIV testing
center at a local hospital. They were really creative when trying to fix the counselor’s room for a record-
ing! There were two cloth banners that were used in an HIV march a few days prior to our visit. The
journalists asked the counselor if they could use one to hang over the window to absorb sound and
another to put on the table at which she was sitting. They also asked her to turn off the fluorescent
lights and stood in a circle around the counselor so that there was even more sound absorption. The
reporters eventually got great sound from a “bad“ recording room. In addition to this, they were able
to provide proper explanations for these adjustments so the counselor understood why they were
making them.“ 

–Mia Malan, Senior Health Journalism Advisor, Internews Network 



168
RECORDING SOUND IN THE STUDIO
The purpose of this activity is to help journalists become familiar with and comfortable
in a controlled recording environment. This is useful when recording links for narration
or a studio interview, with a guest or during a telephone interview. Microphone tech-
nique is important here, as are delivery and presentation skills. The principles remain 
the same even if no studio is available for recording links in a script, since you will still
need a space with good acoustics. 
Note: It’s helpful if the facilitator of this exercise knows how to make presentations; in some cases,
the sound technician may not have had this experience. 
LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to record good, clean sound in the studio.
• Feel comfortable recording narration or an interview in a studio.

MATERIALS
• Flipchart
• Marker
• Recording studio or a room in which you can record with a flash or minidisc recorder (a studio is ideal)

(Continued on next page)

Kenyan journalist Nandika Amatieku from Radio Waumini voicing her radio feature’s script
in the Local Voices studio in Nairobi.
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HAND-OUTS
• Hand-out 10C (Voice and Presentation Tips 1)
• Hand-out 10D (Voice and Presentation Tips 2)
• Hand-out 10E (Script for Presentation Exercise)

TIME
1 hour 

INSTRUCTIONS 
1. Instruct trainees to gather in a group in the recording space/studio. 
2. Initiate an open discussion on what a journalist tries to achieve during the broadcast. Encourage trainees

to respond; you’re looking for at least half to express their views. Use a flipchart to encourage responses.
This discussion should be at least 15 to 20 minutes long, given how important studio recording is to radio.
Raise the following goals of good broadcasting if they weren’t raised during the discussion:
• To get people to listen
• To communicate your message
• To bring a script to life
• To speak so you are understood
• To sound as if you are talking to a person, not reading a script

3. Reiterate the importance of being comfortable and relaxed when recording. Make sure everyone
understands how to:   
• Address the microphone (three to five inches away, slightly off-center).
• Sit upright, feet flat on the floor.
• Breathe naturally, but perhaps more softly than normal. 
• Hold the script still (no rustling of papers).
• Do NOT touch the microphone or bump/tap/drum fingers on the table.
• Place a glass of water if needed to clear your throat (leave it well away from electronic equipment).

4. Explain why journalists need to attempt to sound as natural as possible. 
Note: Novice journalists often adopt a very unnatural delivery style in the studio (or when recording links) and the
sooner they abandon this habit, the better. In places where government-owned media dominate, very formal
delivery is often the tradition. Listeners prefer to hear the journalist or presenter speak naturally, which
communicates diversity, authenticity, and originality. Encourage journalists to be themselves so they are more likely
to develop a sustainable on-air identity and, with it, their own dedicated audience. 
5. Distribute Handout 10C and discuss the seven points addressed for about 10 minutes. Allow trainees to

expand on the seven principles. 
6. Hand-out 10E. Ask everyone to read the short script on the hand-out aloud to themselves, trying to sound

as natural as possible. 
7. Ask a volunteer to read the script in the studio while being recorded. 
8. Play back the recording. 
9. Ask participants for comments. 
10. Repeat the exercise with one more volunteer. 
11. Distribute Hand-out 10D, relating it to the two recordings that were just played. 

This exercise was developed by Sonya De Masi. 
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BREATHING EXERCISE
Note: Nervousness can cause all sorts of presentation challenges. The throat muscles
may contract, raising the tone of voice, while at the same time breathing becomes deep-
er and more audible. When you are not relaxed, you make more mistakes. The following
exercise gets people moving (and often laughing) and gets journalists to focus on their
breathing, something most will never have done before.

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to focus on the correct way to breathe.
• Be able to consciously relax to achieve better presentation.

MATERIALS
Training space (large enough for everyone to lie on the floor)

HAND-OUTS
None

TIME
30 minutes

INSTRUCTIONS 
1. Explain to trainees that this exercise may make them feel tired at first. Eventually, though, they will begin

to notice that it takes less effort to breathe as the exercise helps them learn to coordinate the diaphragm
and abdominal muscles. 

2. Explain that you are going to help everyone find out if they’re breathing correctly.
3. Ask trainees to place their hands on their belly buttons. Explain that this area should expand first when

they breathe in and then spread upward until their chests expand (they should not lift their shoulders or
push their stomachs out). 

4. Explain that you’re about to show everyone how to test if they are breathing properly. 
5. Ask everyone to lie flat on their backs.
6. Ask trainees to place their hands at their waist, fingers pointing toward their belly buttons. Instruct them

to focus on filling up their stomachs from the bottom to the top by taking a slow deep breath.
7. Explain that the aim is not to fill themselves to bursting but to inhale enough air so that they can feel the

difference between a shallow breath and a deep breath from the stomach.
8. Tell trainees that they should feel their stomachs rise and their hands being raised gently up and outward

until their feel their chests expanding. The expansion is not only at the front of the body but also at the
sides and back.

9. Ask them to breathe out slowly to a count of five. 
10. Repeat the exercise 10 times.
11. Let everyone sit up straight and ask: “Why did we do that exercise?“ Allow time for responses and/or

discussion among the group.
Answer: Because breathing is one of the most important things to get right and is central to how
you will sound on radio. And how you sound makes all the difference to your audience.

(Continued on next page)
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12. Explain that it is natural to be nervous before going on air. Too much tension will make the muscles in the
neck and throat tighten, which will strangle the voice and increase its pitch. Breathing will be more audi-
ble than might be desirable, and your mouth may become dry (which also doesn’t sound very good).

13. Point out that your reading will speed up if you are not relaxed. As it does, you are more likely to trip over
words and get flustered when you make a mistake, which, in turn, will cause more mistakes.

14. At this point you should discuss posture when using a studio to record narration, present a program, or
interview a studio guest. The key points include:
• Sit up straight. Slouching contracts the diaphragm and leads to breathlessness and lack of clarity.
• Feet should be flat on the floor.
• Don’t wear jewelry on your wrists that will make sounds when it touches the table.
• Don’t eat in the studio. 

This exercise was developed by Sonya De Masi.
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RECORDING NATURAL SOUND 

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to describe what natural sound is.
• Be able to choose the right equipment and locations for recording natural sounds. 
• Be able to record clean, usable, and realistic natural sound from a specified location.

MATERIALS
• One digital recording device for each trainee
• Omnidirectional microphones (external or built-in) for each trainee
• One headphone set for each trainee 
• A busy street with heavy vehicle and pedestrian traffic
• A laptop with good external speakers on which sound can be played back 

HAND-OUTS
Hand-out 10F (Recording Natural Sound)

TIME
1 hour

INSTRUCTIONS 

1. Have the participants randomly seated around a training table. 

2. Encourage chatting. The mood should be easy and relaxed (very informal). You as the trainer should take
part in the chatting. Do this for two to three minutes.

3. Call the room to order. Act as if you were about to make a very important announcement: “May I have your
attention, please … there is something you have to listen to… “ Keep the participants in suspense to
emphasize the silence.

4. Instruct the participants to carefully listen to the silence for about 30 seconds. 

5. Ask the trainees what that “silence“ sounds like to them. Allow for three or four responses. 

6. Alert them to the fact that the room is NOT entirely silent. Ask them to listen to which other background
sounds they can hear (e.g., a humming air conditioner, telephones ringing, traffic noise from the street, the
sound of each others’ breathing). 

7. Explain that although we may think a room is silent, there is always some background sound that our ears
tend to ignore in order to focus on conversations. But good microphones ALWAYS detect these sounds.  

8. Ask trainees: “What is natural sound?“ Allow for three or four responses. 

Answer:   It is sound that is “natural“ to any given environment. For example, at a school you would
expect to hear sounds of children running, screaming, and laughing. Without such sounds, you
might as well be in a monastery. Natural sound is therefore sound that gives a true audio picture of
any place. 

9. Explain that you’re going to give them a practical exercise to do. 
(Continued on next page)
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10. Give each participant a recorder and microphone (they must know how to use a minidisc recorder at this
point).

Ask participants to record themselves saying their names and stations. Example: “This is Benjamin
Kiplagat. 

11. Let them do this individually to avoid recording other people’s voicers as background noise on the
recordings. Start at one point of the table and instruct one journalist at a time to record while the others
are listening.

12. Ask participants to listen to their recordings over their headphones.

13. Take trainees outside. 

14. Ask participants to record traffic noises by pointing their microphones toward the traffic. Remind them to be
dead quiet themselves, or their own voices will also be on the recording. 

15. Instruct trainees to record at least three minutes of traffic noise.

16. Announce that you have one more thing that you’d like everyone to record. 

17. Instruct trainees to record exactly the same sign-off they did inside the training room (the sign-off recorded
under #10 of this exercise). 

18. Move to a less busy side of the street and repeat the same exercise. 

19. Take trainees back into the office/studio/training room. 

20. Download two or three recordings on a laptop and line them up for playback.

Note: You don’t have to download everyone’s recordings – listen to two or three trainees’ recordings. Explain to
trainees that it will take about 15 minutes to download the sound and that they can take a short break while you and
the trainees whose recordings you are downloading are busy with it. Ask the trainees who are on a break to NOT leave
the office. 

21. Play back the recordings. 

22. Ask participants to compare the sign-offs in the different recording environments.

23. Ask them: “What is the main difference between the street and office recordings?“  

Answer:
• The office recording has fewer background sounds than the street recording.

• The “street voice“ is more often than not at a higher pitch than the office voice. Explain that due to the
higher noise level in the street, reporters tend to raise the pitch of their voices to compete to be heard.

• The background noise on the recordings made on the busier side of the street tends to overpower the
sign-off, so it’s better to record on a quieter side of the street.

• The microphone picks up sound indiscriminately, unlike our ears, which tend to select only what is
interesting or relevant for a particular purpose.

• The street noise sounds alive and makes you feel like you’re “there“ as you listen to it. 

24. Explain why it is sometimes necessary to mix street sounds with voicers recorded in the studio to create the
illusion of being in the street. 

Explanation:  In some situations we can record sign-offs or links in a place where there is natural sound in
the background. But in many cases this is impractical, since you cannot always control the background 

(Continued on next page)
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noise levels and happenings at the scene. To get around this problem, you can record your sign-off or
voicer in the studio and, when you edit your piece, mix it with the natural street sounds that you recorded
when you edit your piece. In this way, you are able to manipulate the sound levels. Natural sound that
you hear in features is often “unnatural“ in the sense that it was recorded separately from the recorded
voicer and “unnaturally“ mixed/blended in so that it sounds “natural.“ 

25. Caution trainees against misplacing and misusing natural sounds.   

• You can only use natural sound in the manner above if you have the real natural sound from the place
you are reporting to be. For example, you can’t use street noise sounds from Cambodia on a generic
sound CD and say you’re in Nairobi; listeners will be able to hear that it sounds different and it won’ t be
credible.

• You need to record enough natural sound at any location (at least 1.5 minutes). You can’t record only 10
seconds, then repeatedly copy and paste that section to form a strip of long natural sound and expect it
to sound natural.

• If you interviewed someone in an environment with natural sound in the background and you want to
later replace that question, do NOT rerecord the question in the studio and drop it into the interview. It
will sound entirely different because the studio recordings sound different from field recordings. 

26. Play back one of the three minutes of street noise recordings.  

27. Ask the participants to identify the section that best represents the sounds of the street. 

28. Let them explain why they made that choice.

29. Explain that it wouldn’t have been possible to make that selection if a long strip of sound had not been recorded
continuously. 

30. Ask if anyone has questions. 

31. Distribute Hand-out 10F. 

32. Read through Hand-out 10F with participants.  

This exercise was developed by the Technical Manager of our Local Voices Program in Kenya, Benjamin Kiplagat. 

“Radio without ambient sound, natural sound, or sound effects is like TV without pictures –
meaningless and boring!  When you’re out in the field, listen through your headphones for the natural
sound that grabs your ear and record it. You’ll get a different sound depending on where you point
your microphone. If you hold your microphone up in the air during a protest march, all you’re going to
get is noise! But if you point your microphone toward the mouth of a woman crying, you’re going to
capture an unforgettable, intimate, and personal emotion. Listen for different and defining sounds.
Track your sound on your recording device and, if possible, make a note of where exactly that sound is
on your recorder. Make the sound effects you’ve recorded the golden thread of your story that weaves
in and out of your script and sound bites.”

–Angie Kapelianis, Specialist Radio Correspondent of the South African Broadcasting Corporation (SABC) 
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HAND-OUT 10A: RECORDING TIPS  
1. Check your equipment.

Check and test you equipment before you go out. Take extras of everything. You cannot be 
over-prepared. Replace batteries. Make a test recording. Have your equipment set up to record 
before you go into an interview; label and load your minidisc or prepare your flashdisc recorder.

Set your recording levels.
2. Choose an appropriate location.

If you are interviewing a doctor, try to do it at the clinic rather than in a coffee shop. If you are interviewing a
factory worker, try to do the interview at the factory. This will ensure your sound is appropriate, relevant, and
engaging. It will help you tell your story. Make an exception when the environment is too noisy, in which case
you record the interview somewhere quiet and then get your interviewee to show you around.

3. Prepare the location.
Set the scene for the interview before you start. Curtains and cushions can improve the acoustics of a room
with an echo. Turn off the air conditioner. Close the door. Listen for fluorescent light hum or the radio and
turn them off if necessary. Listen for traffic noise. Listen for wind. Change location if there is too much
background sound. Remember that background music makes it difficult to achieve a seamless edit. 

4. Watch the microphone position.
Optimum position is about three to five inches from the speaker’s mouth (about the distance from the tip of
the thumb to little finger when spread out) and slightly off to the side to avoid pops. Place the mic a little
closer if they speak softly, farther away if they are loud. Do not let the interviewee hold the microphone;
chances are they will hold it too close (resulting in popping) and will likely move their hands (resulting in
mic/cable noise). Remember to move the mic up to your mouth when you ask a question. You may choose to
edit these questions out later, but sometimes it can be good for the journalist to be present in the interview.
If you do not properly record your questions, you limit your options for putting the story together later. 

5. Watch your levels.
The level should be peaking but should never exceed zero (i.e., go into the red). If the levels are too low they
can be improved slightly, but electronic hiss will also increase. If the levels are too hot (high), the audio will be
distorted and nothing can save it. It’s much better to get good sound the first time without trying to modify it
later during editing. It helps to record interviewees identifying themselves by name and position. At this time
you can set the levels (ask them how their day has been going if you need more). In this way you have a
record of who the interview is with so it never gets lost, as well as recorded evidence that they agreed to the
interview in the first place.

6. Wear headphones.
Using headphones when recording is not optional. They help you identify and avoid wind noise, popping,
background interference, and cable noise. If you hear a sound in your headphones, it will be in your recording.

7. Do not respond verbally.
If you speak over the interviewee or interrupt you may not be able to edit this out. You will be restricting your
production options later. Try to respond only in nonverbal ways: eye contact, smiles, nods, silent responses.
Don’t be afraid of silence; sometimes people just need time to think and will follow with something brilliant
and unexpected.

8. Record background sound.
Listen to the sounds at your recording location. Sometimes recording in a noisy environment can be exactly
what you want to create a sense of place. But you should then record at least one full minute of this sound
uninterrupted by speech, standing quite still and capturing the full spectrum of sound but nothing in
particular. This can be useful for editing later, smoothing out the transition from clips to narration. You cannot
record too much of this natural sound.

9. Label everything.
It helps if you are organized and keep your tapes and files labeled appropriately so you know what they are.
You never know when you might want to refer to the original. This isn’t always possible (especially when
resources are limited), and you certainly don’t want to keep hard copy of everything you record. But if the
interview is very important or special, you might want to retain a hard copy (on CD or minidisc) in addition to
storing the files digitally. 
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HAND-OUT 10B: VOX POPS
Everyone has a story to tell; everyone has an opinion. Too much of journalism is about politicians
and officials and not the people whose lives are affected by their policies. One very good way to put
criticism, opinion, or views in someone else’s mouth is by using vox pops: clips from ordinary people.

Let the audience decide what it thinks.

1. Decide on a question.
At first, ask everyone the same question. Later, don’t be afraid to explore a little by asking different questions.
Don’t ask closed questions. A closed question is one that requires only a “yes“ or “no“ answer. 

2. Find the right location.
Go where you know you will find the kind of people you are looking for. If you are reporting on youth culture,
you may want to go to a university or a place where young people gather. If you are doing a piece about
health care, go to a hospital or clinic.  

3. Explain what you are doing.
It’s best to explain to people what you are doing BEFORE you start recording. Microphones sometimes
frighten people. Be fair and give them warning.

4. Track mark any particularly strong vox pops.
Strong vox pops can be funny, honest, rude, daring. Listen and track mark. You will save yourself a lot of time
this way.

5. Always record at least two minutes of natural sound.

6. Expect the unexpected.
Everyone has a story to tell. Listen, listen, listen. Stories come when you least expect them. 

7. Choose interesting and diverse vox pops for your finished piece.
You will not be using everything or everyone you have recorded. Take the most direct and interesting
comments – usually between 5 and 15 seconds – and mix up the opinions, negative and positive responses,
“don’t knows,“ different voices, gender, and age. You are looking for variety and a range of perspectives. 
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HAND-OUT 10C: VOICE AND PRESENTATION TIPS 1

Voice is the best tool a radio has to keep listeners tuned in. The best kind of radio sounds natural
and easy. The aim is to speak directly to just one person – don’t imagine an audience of hundreds or
thousands of people but one person listening to their radio. It is this person to whom you are

talking. Radio is about communication. You want to invite people to listen, to share, to join with you, and to
definitely listen again next time. 

1. Pay attention to your breathing.
Take frequent, small, quiet breaths when necessary. Fewer but bigger breaths get in the way of the script.

2. Use good microphone technique. 
Not too far, not too close (three to five inches). Don’t pop, and angle the mic slightly off-center. 

3. Relax. 
Be natural and be yourself. Use your full vocal range. Aim for energy and warmth. Don’t adopt a formal
“presenter’s“ style. Make music with your voice. 

4. Speak with authority. 
This comes from both confidence and accuracy. Understand what you’re reading. Read it out loud first; grasp
the meaning.

5. Write your script yourself. 
It’s easier to read.  

6. Mark your script. 
Symbols suggesting emphasis, pauses, speeding up or slowing down, a story sad or cheerful, will help your
delivery.

7. Remember you are speaking to only one person. 
Imagine someone you feel affection for – husband, wife, girlfriend – and talk to that person!
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HAND-OUT 10D: VOICE AND PRESENTATION TIPS 2
Voice is the best tool radio has to keep its listeners tuned in. Radio is about communication. You
want to invite people to listen, to share, to join with you, and to definitely listen again next time.
These are some points to remember.

1. Confidence
People will be more inclined to listen with respect if it sounds like you know what you’re doing.

2. Authority
People will also be more inclined to listen if you speak as though you believe in your material and have some-
thing important to say. 

3. Energy
Nobody wants to listen to someone who sounds as if he or she can barely stay awake.

4. Warmth
It’s nicer to listen to a pleasant voice than a harsh, thin, cold one. Try and aim for a rich, clear tone that is both
natural and friendly. The lower tones in your voice are the best for radio, for both women and men, and you
can find them by speaking from your stomach rather than from high in your throat. Sounds silly but it’s true. 

5. Know your material
Read your script or story out loud and make changes if it is difficult to get through without errors. Just
because it looks good on paper and sounds good in your head does not mean it will sound good when spo-
ken aloud. Become familiar with any names; it looks very bad if you stumble over pronunciation. Make sure
you can understand your script; if you can’t, your listeners won’t either.

6. To whom are you speaking?
Knowledge of your listeners is crucial. It allows you to understand the tone to use when speaking to them
and to know which topics will be of interest. It’s all about developing a relationship with your listeners. 
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HAND-OUT 10E: SCRIPT FOR PRESENTATION EXERCISE
Please read the following bit of script aloud to yourself. Try to sound as natural as possible.

The reception area at the Perundurai IRT Government Hospital. 
Someone asks directions to the Voluntary Counseling and Testing Center or VCTC. 

An employee at the hospital shows him the way. 
VCTC is a place where you can get tested for HIV. 
A sign reads “Counseling is in Progress.“  
Many people are waiting nearby. 
Each has his or her own concern. 
Some have come for their test results. 
Others already know that they’re HIV-positive. 
They are here to get more information on HIV from the counselor.
Dr. Krishnaswamy Mahadevan works with the Department of Sexually Transmitted Diseases at the Coimbatore
Government Hospital. 
He has over 20 years of experience in the field. 
He’s met many different kinds of people. 

Note: This script comes from a story on HIV testing from journalist Vijay Kumar from All India Radio in Tamil Nadu. You
can view the entire script and hear a recording of the story at http://www.internews.org/LocalVoicesCD/kv_tran-
script.htm
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HAND-OUT 10F: RECORDING NATURAL SOUND
Definition: In radio, natural sound is sound that appears naturally in a given location. It is a mixture
of sounds that gives a place its true ambience and sound character. Without these sounds, the ambi-
ence of a place will sound odd or unreal. 

Example:  You expect that sound coming out of an empty cathedral will for instance sound hollow and have
echoes. You cannot present it as sound from a classroom.

What to consider before recording natural sound? 
• Of the many sounds found at any given location, you need to identify the most natural and convincing sound:

the sound that will give the true picture of the place. For example, if you want natural sound from a carpenter’s
workshop, the sounds of “wood sawing“ and “nails being hammered into chairs“ would be your choice of natu-
ral sound, not the sounds of birds chirping in a nearby tree.     

• You need to consider the relationship between the natural sound you intend to use and the topic of your story.
In most cases, the natural sound must be related to that topic, or else the sounds won’t enhance the story. If
you interview someone in a natural sound environment, make sure that the background sound is related to
what the interviewee is talking about. For instance, interviewing a carpenter with “wood sawing“ sound in the
background makes much more sense than interviewing him in the kitchen of the carpentry shop. 

Preparing for recording
You need:
• A good digital recorder
• A sensitive microphone, preferably a stereo microphone
• A pair of good headphones (it’s a must to monitor your recording at all times)
• Several minutes to listen for natural sounds that relate to the subject of your story or describe the actions of

the characters in your story

How to record natural sound 
In many cases, natural sound should be recorded separately from the main interview. You may begin recording
as soon as you enter a location; record as much as possible to collect the full range of natural sounds in that
location. For example, if you want to record natural sounds from your kitchen, you have to consider what natu-
rally happens there: the buzz and ring of the microwave, the running water of the kitchen sink, the clink of cut-
lery, the hiss of the hot water kettle.
Let’s then imagine that you are doing a program on good nutrition and hygiene and you have already inter-
viewed a chef demonstrating good kitchen hygiene practices. The chef may have mentioned how boiling water
and washing utensils thoroughly is good for kitchen hygiene. It then follows that the sound of a boiling kettle
and water running from the kitchen tap provides for good natural sounds for that particular topic. Of course,
you may want to record other related sounds, such as scrubbing the floor or opening the kitchen dustbin. The
actual recording will have to be stage-managed to some extent to avoid having all the sounds occur simultane-
ously.
For all the recordings, place the microphone at a reasonable distance from the source of each sound and record
for at least three minutes. It is also important to place the microphone at the center of the room and record the
general ambience for the same amount of time. This could be used if you decide to lay a continuous back-
ground ambience in your mix. Make sure you monitor all your recordings. If any of the recordings sound artifi-
cial, change the microphone placement and re-record until it sounds natural.

Note: It is important to note the type of natural sound you are recording as well as the time codes on your recorder to
avoid confusion later. Save copies of the original sound recordings before you begin editing, since you never know
when you will need them.
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chapter 11
Teaching Journalists How to Edit Sound1

SONYA DE MASI

Learning objectives
After working through this chapter, the trainer will be able to demonstrate how to do the fol-
lowing on Adobe Audition: 

1. Transfer sound into a computer ready to modify.

2. Basic single-track editing (cutting and pasting).

3. Transform sound (noise reduction, amplification).

4. Mix audio in a multi-track format.

5. Convert and save audio in single-track, smaller file.

Why is it important to teach radio journalists this skill?
Chapter 10 established that capturing good, clean, creative sound is a prerequisite for telling a
good story on radio. But once the raw materials have been gathered, the journalist must be
able to re-create an event or experience to deliver a story that accurately (and sometimes not
so accurately) represents real events. Some journalists who work at under-resourced radio sta-
tions may have never heard a radio feature or documentary, let alone had the opportunity to
make one themselves. Sometimes it takes some convincing that the increased work involved in
producing a radio feature can be rewarding both professionally and personally. Teaching jour-
nalists how to edit sound well results in a much higher quality story that gets the message
across better and appeals to more listeners. 

The simplicity of contemporary digital editing on computer can make complex radio produc-
tion accessible to many more people than ever before. With a basic computer, some head-
phones, and an editing program such as Adobe or Audacity (the latter available as cost-free
open source shareware), journalists can now edit and produce wherever there is a power sup-
ply (which is, we know, not always guaranteed). 

This chapter provides lesson plans and exercises that will enable a trainer to guide journalists
through the process of audio downloading, editing, and producing. Journalists with no com-
puter literacy will benefit much more from this training if they first receive tutorials in how to
use a computer.

The instructions in this chapter are for Adobe Audition, which is widely used industry-standard
software. However, Audacity is increasingly popular for its accessibility. A very helpful online
tutorial for Audacity is available at http://audacity.sourceforge.net/manual-1.2/tutorials.html.

1 Some exercises and diagrams in this chapter were sourced from: O’Malley, G., A. Guilera, and N. Sordé. 2001. Digital Editing, Module VI.
Produced by AMARC Europe Women’s Network. 
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The Adobe Audition user manual has been specifically designed for radio journalists (as
opposed to music producers). It contains instructions for all the functions you will need to digi-
tally edit sound for a radio feature. 

The entire chapter has been saved on the manual CD, should you like to make adjustments or
have it translated. 

How much time do I need to allocate to teaching this skill in 
a weeklong training workshop? 
• About 6 hours for Adobe Audition or Audacity

• Up to 1-2 hours per trainee (depending on computer skills) during the last two
production/mentoring days

Exercises 
• Transferring Sound Into a Computer (essential, 1 hour )

• Editing and Saving Audio Files (essential, 1 hour, 30 minutes)

• Manipulating Sound (essential, 30 minutes)

• Assembling Edited Audio Files in a Multitrack Session (essential, 1 hour, 30 minutes)

• Mixing and Saving/Exporting Audio Files (essential, 30 minutes)

Hand-outs 
11A Editing Tips

11B Adobe User Manual for journalists

11C Transcript (for the trainer)

Sound
• Clip 1

• Kip’s Clip 2

• Music 1*

• Thomas

• Teacher Mary 2

• Nat sound children in class

• Voice 1

• Transcript Clip 1

* Use any music – this clip has not been included on the manual CD due to copyright issues. 
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TRANSFERRING SOUND INTO A COMPUTER
Note: This exercise contains instructions for both minidisc and flashdisc recorders. You do not have to demonstrate
how to transfer sound from both types of recorders if you’re using only one type of recorder for the workshop. Use
the instructions appropriate for the type of recorder you are using.

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to transfer sound from the recording device to the computer.
• Be able to navigate Adobe digital editing software.
• Know how to conduct basic internet research.
• Understand how to creatively follow up on newspaper stories for radio.

MATERIALS
• Digital recording device (minidisc or flashdisc), headphones 
• Computer with sound card 
• Digital editing program (Adobe Audition, Audacity)

HAND-OUTS
Hand-out 11B (Adobe User Manual)

TIME
1 hour

SOUND
A sound recording on a minidisc or flash disc recorder with which you can demonstrate how to download
sound to a computer (depending on which type of recorder you are using in the workshop)
Note: It’s easiest to use one of the recordings made during one of the sound recording exercises, or download
one of the sound files on the manual CD onto a recorder

INSTRUCTIONS
1. Make sure each trainee has a recording device, headphones, and a microphone. 
2. Ask each to sit in front of a computer. 
3. Distribute Hand-out 11B. 
4. Explain that you’re going to go through the hand-out with them to show how to transfer sound

onto a computer. 
5. Ask everyone to record themselves reading the following list of numbers: 

1 2 8 3 5 7 9 4 4 6 10
Encourage the trainees to use what they’ve learned to produce good sound. It doesn’t matter, though, if
they don’t make a perfect recording, since that means there will be more to edit.

6. Use the Adobe User Manual (Hand-out 11B) as a teaching guide and get everyone to transfer their sound
while you explain how to do it step by step. 

(Continued on next page)

EXERCISES
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7. Groups learn in different ways. Sometimes it works better to first show trainees how to transfer the sound
on one computer with everyone gathered around it. Other groups learn better if each trainee works
separately on a computer as you go around to make sure they’re doing it right. Try to think about trainees’
responses in previous sessions to gauge what training method will work best for them. Also take into
consideration their levels of technical and computer knowledge. When trainees have low levels of such
knowledge, it works better to first show them how and then get them to do it. 

8. Explain how to transfer sound into the computer and how to set and adjust recording levels.
9. Explain the importance of saving files in a disciplined and systematic way. Establish a protocol to be

followed by everyone.
10. Tell journalists that they are now ready to edit.

This exercise was developed by Sonya De Masi. 
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EDITING AND SAVING AUDIO FILES

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to complete a single-track edit.
• Know how to save audio files.

MATERIALS
• Digital recording device (minidisc or flashdisc), headphones 
• Computer with sound card 
• Digital editing program (Adobe Audition, Audacity)

HAND-OUTS
• Hand-out 11B (Adobe User Manual)
• Hand-out 11C (Transcript (for the trainer))

TIME
1 hour, 30 minutes

SOUND
The following sound bites on the manual CD: 
• Clip 1
• Kip’s Clip 2
• Transcript Clip 1

INSTRUCTIONS
1. Make sure each trainee has a recording device, headphones, and a microphone. 

2. Ask each to sit in front of a computer. 

3. Distribute Hand-out 11B. 

4. Explain that you’re going to go through the hand-out with them to show how to edit and save a sound
file.

5. Ask everyone to open the file loaded in the previous exercise of the list of numbers they recorded. 

6. Use the Adobe manual as a teaching guide and get everyone to edit the numbers into the correct order. It
may be necessary to demonstrate this first. The repeated numbers need to be deleted, while the others
need to be cut and pasted into the correct order.

7. Save the file according to the established protocol for your project. 

For further practice, you can facilitate the following exercise from Benjamin Kiplagat, the Kenya
Local Voices Technical Manager:

8. Make sure you have Hand-out 11C available (the transcript hand-out for trainers). Refer to it for accuracy
when you get journalists to transcribe the transcript clip.   

9. From the exercise CD extract Clip 1 (Edward Odhiambo Raw), Kip’s Clip 2, and Transcript Clip 1 onto all
the computers.

10. Open Adobe Edit View.

11. Ask journalists to listen to Clip 1 (duration: 1 minute, 20 seconds)

(Continued on next page)
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12. Trainees should transcribe this sound bite word for word. Include gaps, long pauses, repetitions, and
interruptions. Insert time codes after every three lines or so, even if they fall in the middle of a sentence. 

13. They should note carefully any variation in levels as they play the clip. 

14. Journalists should check their transcript and make notes on what should be edited out, or what parts
need level adjustments.

15. Using the Edit tool, ask the trainees to remove repetitions, gaps, long pauses, and any unnecessary noises.
Remind journalists they should try to preserve the natural rhythm of the speaker’s voice and so should not
edit too tightly. 

16. If necessary, this will mean copying natural breaths and pasting them where an edit is too tight. (This may
need experimentation, so tell journalists about the Undo function.)

17. They should check if the edit is smooth and sounds natural, then listen and identify any volume variations
on the clip.

18. Tell them to increase or decrease the levels accordingly, making sure that the new levels are in synch with
the rest of the clip.

19. Ask the journalists to listen to the clip once again to make sure that there are no sudden level variations.

20. Normalize the clip at -3db.  Note the new duration of the clip.

21. Save the clip as Clip 2.

22. Ask journalists to compare Clip 1 with Kip’s Clip 2. Note the difference.

23. Kip’s edited clip is 47 seconds, a reduction of 33 seconds.

24. Ask journalists to compare their transcript with Transcript Clip 1 from the exercise CD.

25. To refine trainees’ skills, repeat this exercise and request that they make even finer edits by completely
editing out any unnecessary sentences or phrases. 

This exercise was developed by Sonya De Masi. Benjamin Kiplagat also contributed.
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MANIPULATING SOUND

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Know how to modify sound files (amplify, normalize).

MATERIALS
• Digital recording device (minidisc or flashdisc), headphones 
• Computer with sound card

HAND-OUTS
• Hand-out 11A (Editing Tips)
• Hand-out 11B (Adobe User Manual)

TIME
30 minutes

INSTRUCTIONS
1. Make sure everyone has a copy of the Adobe manual. 

2. Ask journalists to open their numbers file, the final version with the numbers in order.

3. Explain the Amplify/Fade function in Adobe; you can refer to the manual. It might help to gather the
journalists around one computer to watch a demonstration before they return to their own station.

4. Ask journalists to practice increasing and decreasing the amplification using the presets and the slide.
Remember to note that background sound or hiss will also be affected.

5. Return to the issue of levels and explain how sound that is too “hot” (distorted or “clipping”) can never be
repaired. Demonstrate by amplifying a sound file until it exceeds the window parameters and show what
happens on the level meters.

6. Explain what normalizing is and how/when to use it.

When you normalize a waveform, the loudest part of the waveform is set to a specified amplitude
(usually -3db or 98%). This raises or lowers all other parts of the same waveform by the same
amount.

7. When they’re finished, ask journalists to save their files with a different name.

8. Distribute Hand-out 11A and read through it with the trainees. 

This exercise was developed by Sonya De Masi.
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ASSEMBLING EDITED AUDIO FILES IN A MULTITRACK SESSION

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to open a multi-track session. 
• Know how to import and move files. 
• Know how to fade in and out.
• Be able to mixdown and save a multitrack session.

MATERIALS
• Digital recording device (minidisc or flashdisc), headphones 
• Computer with sound card 
• Digital editing program (Adobe Audition, Audacity)

HAND-OUTS
Hand-out 11B (Adobe User Manual)

TIME
1 hour, 30 minutes

SOUND
The following sound bites on the manual CD: 
• Music clip (this clip is not on the manual CD – you need to create one yourself or you can use 

any music clip that’s about one minute long)
• Nat sound children in class
• Teacher Mary 2
• Thomas
• Voice 1

INSTRUCTIONS
1. Load the music clip (this can be any music clip of your choice) onto all the computers.
2. Ask journalists to open the sound file with the original, unedited recording of the series of numbers. 
3. Get the trainees to edit each number as a separate sound file and save with a new name in .wav format.
4. Open a multitrack session and import all the new numbered sound files.
5. Arrange the numbers in alternate tracks from 1 to 10.
6. Import the music sound file and drop it into a third track.
7. Have the journalists mix this underneath the numbers. Practice fading the music in and out at the

beginning and end of the number series, at an audible level that does not compete with the numbers.
8. Save the session with a new name.
9. For additional practice mixing, load the following clips from the CD (prepared by Benjamin Kiplagat): 

• Nat sound children in class
• Teacher Mary 2
• Thomas
• Voice 1

10. Ask journalists to open the loaded clips above in Edit View.
(Continued on next page)
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11. Explain how to arrange the clips in an appropriate order.

12. Tell trainees to try mixing the sound of children in the classroom underneath the voicer. There’s not much
to play with, but even a small fade underneath would work well. Suggested order is: 

• Nat sound children in class

• Voice 1

• Teacher Mary 2

• Thomas

13. Ask the journalists to save the session with an appropriate name when finished. 

14. Check the mix for clips that are placed too tightly or cross over. Check the fades.

This exercise was developed by Sonya De Masi. 
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MIXING AND SAVING/EXPORTING AUDIO FILES

LEARNING OBJECTIVES
By the end of this exercise, participants will: 
• Be able to mixdown from a multitrack to a single-track file.
• Know how to save and export sound files.

MATERIALS
• Digital recording device (minidisc or flashdisc), headphones 
• Computer with sound card 
• Digital editing program (Adobe Audition, Audacity)

HAND-OUTS
Hand-out 11B (Adobe User Manual)

TIME
30 minutes

SOUND
The following sound bites on the manual CD: 
• Music clip (this clip is not on the manual CD – you need to create one yourself or you can use 

any music clip that’s about one minute long)
• Nat sound children in class
• Teacher Mary 2
• Thomas
• Teacher

INSTRUCTIONS
1. Make sure everyone has as copy of the Adobe manual.

2. Explain to the journalists that the last step in digital editing is to convert the multitrack session into a
single track sound file ready for broadcast. Once it’s saved as a .wav file, you can broadcast it, copy it to a
portable format (to a flashdisc), or convert it to a smaller .mp3 file.

3. Ask journalists to open the session where they edited the numbers and music.

4. Demonstrate how to mixdown, referring to the Adobe manual.

5. Ask all the journalists to create a mixdown of their session and save it to .wav or .mp3 format with an
appropriate name. 

6. Encourage the practice of listening a final time to the mixdown for unexpected glitches.

7. Repeat with the multitrack session using the Kenya exercises edited in Edit View in the previous exercise.

This exercise was developed by Sonya De Masi.
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HAND-OUT 11A: EDITING TIPS

A sure sign that something has been well edited is that the listener cannot identify any edits. Many
radio stories are heavily manipulated; the meaning hasn’t been changed but the order of questions, or
words, might have been. This can be done for clarity or duration (to shorten the length of a story).

Staying true to the meaning of the speaker and observing a journalist’s ethical responsibilities will advance
listeners’ understanding of the story while presenting it in the most time-efficient, creative, engaging, listenable
way.

Listen while you edit.
Most journalists wear headphones while editing to focus closely on the sound. But people listen to the radio in
the car, or at home while doing other things. So for a different perspective, it’s good to also listen to your story
through speakers. And just because digital editing lets you look at the sound in wave form, the only test of
whether it sounds any good is to listen to it. 

Breathing and pausing are natural.
It’s very common for people learning digital editing to remove breaths from a voice clip, but this can interrupt
the natural rhythm of speech. Pauses and breaths between ideas or sentences are natural and should not be
removed. You can edit out and substitute a shorter breath or pause (which will have the natural ambience of the
background sound) if length is a concern. You can adjust the level of a noisy breath or substitute a quieter one.
This kind of manipulation stays true to the natural sound of the speaker. 

Ummm…..ahhhhh (or your local language equivalent)
Most people use filler words in speech while they are thinking, but if there are too many it can be distracting
and even irritating for the radio listener. Unless it is integral to the story (for example: you want to illustrate how
uncomfortable someone is talking about something), you can remove some of them. 

Listen back to your edits.
When you make a cut, listen back to it immediately while it is still easy to undo. In this way you will identify
digital clicks (mostly found at the beginning or end of an edit, and when sound waves don’t match up exactly).
You will also be able to identify when you have “clipped” the audio, which is common when edits are difficult.

Don’t edit too tightly.
Not every sound has to fit exactly next to the following sound. One example is the transition between the last
words in a voice clip and the first words in a narration. At all times you are aiming for natural cadence and rhythm.

Edit for tone as well as content.
It is usually possible to identify when a speaker has come to the end of a thought, phrase, or sentence. Novice
editors sometimes make the mistake of focusing only on their transcript and edit a sentence to end where they
want, not where the speaker had finished. If you don’t want a listener to be left wondering what else the
interviewee said, or be able to identify an edit, only cut where it sounds natural, even if this means leaving more
words than you would have liked. 

When editing for content or length, make sure that the interviewee’s delivery is consistent. For example, if he or
she is serious at the beginning of a response but laughing at the end and you make an edit in the middle, it
might be hard to reconcile the emotional change within one clip. You will have to make production decisions to
ensure delivery is consistent or at least realistic.

Review levels after editing.
After editing, check that the levels are even, within voice clips and from clips to narration. If the levels are
inconsistent, the listener will feel the need to adjust the radio’s volume, which can be distracting. 

Fade in and out of noisy clips.
If there is background noise or ambient sound underneath a voice clip, it’s best to fade in and out at the beginning
and end of the edit. This is easier to listen to and much less jarring than a very noisy clip that starts at full volume. 
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HAND-OUT 11B: ADOBE USER MANUAL2

TRANSFERRING SOUND
At the back of the computer (not the monitor) are small ports where the sound equipment will
connect. These include headphone, USB, and input ports. They are usually color-coded/labeled.  
• Line in (or the symbol with an arrow pointing into the center of a circle/semi-circle) is where you 

connect the minidisc to record into the computer. 
• Line out (an arrow pointing out of the center of a circle or semicircle) is for sound from the computer. 
• Mic or a symbol for a microphone is available should this be required (but it’s not recommended to record

directly into the computer for radio; do it into a recording device first and then transfer it).
• Spkr out or a symbol for speakers is where you connect speakers or headphones for playback.

Minidisc recorders:
Identify the Line In port and connect the cable from Line Out on the recording device. The sound will be played
into Adobe in real time.

Flash recorders:
Connect the recording device to the USB port, open the folder of the device that will appear on the screen,
identify the file, and copy it into the sound file that you have opened in your computer. 
• It is good practice to open a folder in the computer for all your sound files. The value of discipline in

saving cannot be overstated, particularly when the computers are shared by many users (as is the case
in many newsrooms). This will help to avoid problems when you are trying to retrieve stored sound
files. 

• Use the hard disc with the most space. Computers used for digital editing should have two hard disc
drives: one for programs and one for sound and other files. All sound files should be saved into this
folder, and then in a separate folder for each person who uses it. 

• A new folder should be opened for every story so all the raw and edited audio for each feature will be in
the same place. A standard way of naming files is a good idea. There are no rules, but the name might
include the date, name of the interviewee, and the terms “raw” or “edited.” For example, “031108 Smith
iv raw” means the original interview with someone called Smith on 3rd November 2008. Establish a
method and use it always. 

Adobe Audition does not control recording levels, which is done manually. These levels can be adjusted with
the mixer application that comes with the computer’s sound card. For the best results, record audio as loud as
possible without clipping. Try to keep the loudest point somewhere between -2 dB and 0 dB when setting the
recording levels. 

• Open the Windows Volume Control program.

• The screen at the end of the instructions in this section will appear.  

• Double-click the speaker icon in the system tray to access the Volume Control program, which resembles a
small mixing board with vertical sliders. 

• To adjust the sound card's playback (output) level, turn up the sliders on the Windows mixer to the desired
volume. 

• Make sure that Mute underneath both sliders is not selected. If the sliders are not visible, select Options >
Properties and choose the relevant functions. To go to the panel for recording control, go to Options >
Properties and select Recording. 

• Now select audio source Line in.

2 This manual was written and developed by Sonya De Masi. Some of the screen shots were taken from the original Adobe Audition
manual.  Adobe product screen shot(s) have been reprinted with permission from Adobe Systems Incorporated.
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For the purposes of radio journalism production, Adobe Audition has two main work areas:  The Edit View, for
editing audio files, and Multitrack View, for mixing sessions.

Open Adobe from the icon on the desktop. If the Multitrack View is displayed, it is possible to switch to Edit
using the tabs above the display window: 

There are also two small buttons in the far upper right of the screen that will also allow you to easily shuttle
between the two.

These buttons give instant access to all the software’s functions; it’s a good idea to explore them a little. 

Hold the mouse cursor over a button and it will display the function:

To set up to record, go to the Options menu. Check Monitor Record Level to activate the Level Meters and start
monitoring the recording source, which is useful for setting levels before recording. To quit monitoring, press
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the Stop control or uncheck Monitor Record Level on the Options menu. Also check Show Levels on Play and
Record to display audio levels during recording and playback. 

To open a new recording session in Edit View, click File > New.
In the new file, a dialog box will ask you to select the settings for the recording. 

Stereo recording (left and right channels) uses double the hard disc space as mono (one channel only).
Nevertheless, radio requires the best sound quality possible, so choose stereo recording. The final version can
always be saved at a lower, smaller, resolution. 

Of the choices available, 8000 Hz represents telephone-quality sound, 32000 Hz is better than FM-quality sound,
and 44100 Hz is CD-quality sound.

The recommended settings for radio production are:  

Sample Rate: 44100
Channels:       Stereo
Resolution:    16-bit
When these options have been selected, click OK and you are ready to record.

Confirm that the recording levels are set correctly. The audio needs to be as loud as possible, but if it is too loud it
will be distorted and unsalvageable. Adobe has a level or VU meter across the bottom of the screen. 

To activate the meter if it doesn’t show automatically, click Options > Monitor Record (or F10).
When stereo audio is displayed, the top meter (A) represents the left channel, and the bottom (B) the right.

A level of 0 dB is the maximum amplitude possible before distortion (sometimes called “clipping”) occurs. If clip-
ping does occur, the clip indicator to the right of the meter lights up red (D) and stays on until you clear it (by
clicking on it). This is very undesirable. 

The optimum levels for recording are usually a maximum of -4 dB or, better still, -6 dB. At this level, the VU meter
will show yellow and there is still room to go slightly over (to allow for irregular speech and unexpected, occa-
sional increases in sound levels), but not enough to peak and cause distortion.

Remember, if playing sound in from a minidisc, the levels cannot be adjusted in Adobe; go to the Recording
Control mixing desk and adjust the levels until they are right.
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So now you are ready to record. Use the control buttons on the left hand side at the bottom of the screen. Their
function is the same as for any other sound equipment. 

1. Click on the Record button. 

When finished, click Stop. A wave form will be displayed.

This has been recorded at optimum levels – the horizontal line at the top and bottom of the screen shows where
distortion occurs. 

This sound file is distorted (clipped), with the wave forms exceeding the cut-off line above and below.

This sound file is recorded too low.

Next step is to save the file. Click File > Save As… Save it in the dedicated folder according to the naming protocol
you have chosen. 
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EDITING AND SAVING SOUND FILES
1. In Edit View click on File > Open. Alternatively, click the Open button on the toolbar (and open folder icon) or

the Import button in the Files tab of the Organizer window.  (Note: To select multiple, adjacent files, click the
first file and Shift-click the last. To select multiple, nonadjacent files, Ctrl-click them.)

2. Play the file a few times to become familiar with how the visual wave form relates to the sound. 

Click on the point of the wave where you want to begin the edit. Hold down the left button of the mouse and
drag the mouse to the right until you reach the point where you want your cut to end. When the button is
released, the area selected becomes highlighted. 

To listen back and check the selection, click on Play. It will only play the selected part of the wave.

To expand or decrease the selection, right-click the mouse. This can also be done by dragging the yellow 
triangle at the top and bottom of the cursor. Remember, left-clicking the mouse at this stage will remove the 
selection and move the cursor to a new place and the edit will have to begin again. The selection can be 
modified and played back multiple times until the whole number is captured.

Erase the number by clicking on Edit > Delete Selection.

Check the edit by clicking Play. 

3. The Undo function enables the last action to be deleted. It allows editors to recover the sound file to how it 
was before the previous edit or cut. It is possible to keep undoing many more times than will be necessary – i.e.
you can use undo over and over again to get back to an earlier stage/edit. 

Activate Undo by going to Edit > Enable Undo. This function is accessed either through the Edit menu or the 
icon on the tool bar at the top of the screen. 

4. When you’re satisfied with the selection, choose Cut in the Edit menu. 

The selection is now deleted from the recording but is stored to the clipboard in the computer. An alternative is 
to select File > Save Selection. It will need a new file name and then should be stored in the appropriate file. 

Find the exact point of the wave where the edited sound needs to be inserted.

Select Paste in the Edit menu.

Listen back to the result and amend if the sound is clipped at the beginning or end.

Save the final file with a new name according to the file-saving protocol. 

6. During editing, the smaller files will stretch to fit the screen, so the Zoom function can be useful. It is also useful
for identifying a precise point in a file, which is large and so the wave form is much denser. The most useful
Zoom functions are the three at the top and the one in the left bottom corner of the Zoom menu.
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Zoom to center: This stretches the wave and thus shows more detail. This means that not all of the wave will
appear on the screen, just a part in the center of the wave. If you want to see a part not shown on the screen,
navigate using the green bar at the top of the screen just under the toolbar.

Zoom out: This option does the opposite. It shrinks the wave to show more on the screen.

Zoom out full: This option goes back to the original size, showing the whole wave on screen.

Zoom to selection: Shows all of a selection fitting on the screen.

Other editing tools are on the green navigation bar:

The top of the screen just under the tool bar shows the part you are viewing in the screen in proportion to 
the whole wave. The green part is the part you are viewing. If the whole bar is in green it means that you are 
seeing the whole wave. 

If the cursor is held over the bar it becomes a hand. Hold down the left button of the mouse and drag to move
across the wave. 

Right-click the mouse when the cursor is on the green bar and drag to make the area of the save bigger or 
smaller.

And finally, the timer:

The timer is a clock that shows the length of the audio works. By default it shows the time in decimal format:
minutes, seconds, and milliseconds (mm:ss.dd).  This can be changed in View > Display.

Time Format. The time at the left shows the length of the track until the point of the yellow line in the wave.
The table at the right side shows the beginning, end, and total length of the selection (the upper file) and of
the whole wave (bottom file). 

7. To save an edited file in Edit View:

Choose File > Save to save changes you made to the current file. Or, click the Save button in the File toolbar. 

Choose File > Save As to save changes to a different file. Alternatively, click the Save As button in the toolbar.

Adobe has different formats for saving sound files. They appear in a drop-down list in Save As. The Windows
PCM (.wav) format is the highest quality. 
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When saving for radio production purposes, .wav is ideal during the editing process, as is .mp3 for a smaller
format that does not require as much disc space. The sound quality is lower, but for most broadcast context it
would not be noticeable.

MANIPULATING SOUND
Adobe Audition and Audacity are able to perform some complex functions for altering and modifying sound.
For radio journalism, only a few of these will ever be required. By recording the best sound possible, no or
limited modification is necessary. 

1.  To transform, first open a wave. 

2. Go to the menu Effects > Amplitude > Amplify/Fade. A dialog box appears with options for setting the level
of amplification. This can be done manually by sliding the fader right and left or selecting presets that appear
in the right hand of the screen (Boost/Cut).

3. The best way to learn is to experiment. Play with the sound and see what happens. If some of the sound is too
low, experiment with Amplify. The preset numbers at the right of the dialog box – +/- 3db, +/- 6db, +/- 10 db
– are usually sufficient. It is rare to need to adjust sound to 10db. Some things can be improved but they can’t
always be made to sound perfect.

4. Remember the Undo function if you try something that sounds strange or is too much or too little.

5. The Amplitude function ensures that different sound files have the same volume. This means that, after
editing, listeners do not have to adjust the volume on their radio to compensate for uneven levels. 

6. The other useful radio journalism function is normalizing. This function is designed to improve (or “sweeten”)
the audio by ensuring the whole file has standard levels. This becomes important when producing complex
features with many different audio files (natural sound, narration, clips from several different interviewees,
and so on). It’s not possible to record different people and sounds at different times in different places and
have them all at the same level. So normalizing your final file before saving can smooth out the levels.

Select the entire file by double-left-clicking on the mouse anywhere in the file. (Watch that the whole file is in
the screen; zoom out to be sure, otherwise this method will only select what is visible.) 
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Go to Effects > Amplitude > Normalize. A dialog box will appear with options.

There are no rules, but the following settings are recommended and will achieve a good sound: 

• Select Decibels format

• Normalize to -3 dB, (or 98%)

• Select Normalize L/R Equally

• No DC Bias Adjust. 

Select OK.

7. Listen back to the file and check the edits. Always check your edits.

8. Save the file with an appropriate name.

MULTITRACK EDITING
1. Multitrack session files contain no audio data themselves. Instead, they are small files that point to other

audio files on the hard drive. A session file keeps track of which files are parts of the session, where they go in
the multitrack, which effects have been applied, and so on. 

2. It is very important to always save every individual file in a multitrack edit. This is especially the case in order
to move the entire session from one computer to another. If only the multitrack session is saved, it will be
there when it comes time to open it, but it won’t have any sound files in it.

3. To open a session file:
In Multitrack View, choose File > New Session. Select the sample rate (44100).
Go to the Import files folder (open folder icon), select the file you want to open, and click Open. To select 
multiple, adjacent files, click the first file and Shift-click the last. To select multiple, nonadjacent files, Ctrl-click 
them.
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4. Once the audio clips are open in the organizer box at the left hand side, click and drag them into the tracks as
for any other Windows file. 

To select a wave, just click on it. It will become highlighted. 

To select more than one at the same time, hit Ctrl-click.  

To move the waveforms, right-click the mouse and drag the wave right or left. Files can also be moved from
one track to another in this way.

5. To edit a sound file which is already in a multitrack session:

Double click on the wave and it will revert to Edit View. This is the best way to make changes to a file in a
session. Never edit in Multitrack View, which causes problems with saving files. Save the edited file and then
switch back to Multitrack View.

6. Clips can be grouped to more efficiently organize, edit, and mix a session. For example, if the three clips at the
end of a feature need to be moved back to allow a new clip to be inserted, they can be grouped and moved
without remixing.
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7. To group clips:
Hold down the Control key, and click each clip you want in the group.
Select Edit > Group Clips. Alternatively, right-click any clip in the group, and choose Group Clips. 
There is also a short-cut icon in the tool bar.

Grouped clips change color and the icon appears in the bottom left corner of each file.

To  ungroup clips:
Select any clip in the group and choose Edit > Group Clips. Alternatively, right-click any clip in the group and
deselect Group Clips (or use the tool-bar icon).

8. To fade in and out of a sound file in a multitrack session:
First select the following two options from the View menu: Enable Envelope Editing and Show 
Volume Envelopes.

Click on this line and the cursor shows as a hand. Click and create a mark.

The Volume Envelope is visible as a green line across the top of the sound files.

You can click on and drag this mark to increase or decrease volume at a specific point. The best way to
understand this process is to actually do it. The mark will move the line almost as though it were a piece of
rubber. Listen to how the location of the line will affect the sound. You can click and create as many marks as
you like.  
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To remove a mark, click and hold it, then drag it completely out of the track.

Try and create a smooth fade-out by creating a natural curve, rather than a straight line, from loud to silent. If
you experiment, you will see the difference a gentle curve fade-out can make.

9. To save a multitrack session:

If you save the multitrack session  you have created this is called a session.

It is not a complete sound file or a .wav file, but a space to mix different files. If you have modified or created 
new waves when working in a session you need to save them separately and also save the session as a whole.

To re-open a session, you need to be in the Multitrack View and select File > Open Session.

MIXDOWN AND SAVING SOUND
1. The last step in digital editing is to convert the multitrack session into a single track sound file ready for 

broadcast. Once saved as a .wav file you can broadcast it, copy it to a portable format (to a flashdisc), or 
convert it to a smaller .mp3 file.

2. To mixdown the multitrack session:

Select the option Edit > Mixdown to File > All audio clips.

This will mix all the wave forms in the session into a new single wave. The session from which they came still 
exists and has not changed. 

It is good practice to listen through the entire mixed-down file before saving it. Sometimes there are glitches 
in saving; perhaps a file was unintentionally moved or a mix isn’t perfect. Save only the file ready for 
broadcast after this final air-check.

It is not possible to make changes to the mixdown. Once mixed, fades, edits and, everything else are final. 

You can also keep the session (and all the relevant files) to change parts of it later.

Save your mixdown as a .wav or .mp3 file (see EDITING AND SAVING for a reminder of the options available 
and how to find them).
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Mentoring Journalists and Follow-up
Support
MIA MALAN

Learning objectives
After working through this chapter, the trainer will: 

1. Better understand the mentoring that the Local Voices program provides.

2. Better understand why mentoring should be an integral component of workshops.

Why is it important to master this skill as a trainer? 
No one learns how to be an experienced HIV journalist in a weeklong training session. Trainers
can share only the basics of HIV journalism in such a short time. Without follow-up and mentor-
ing, journalism workshops rarely have a long-term impact. 

Journalists who start a reporting job straight out of college only have basic knowledge. Most of
what they learn about radio journalism is in a newsroom supervised by a news editor who
reviews their scripts and helps them to improve on them. But this intensive mentoring process
often doesn’t happen at underresourced radio stations with skills and staff shortages. As a
result many journalists never develop much beyond what they learned at an equally underre-
sourced college.   

Training workshops help address this problem. But the skills learned during those workshops
need to be refined, and someone needs to make sure that they’re applied correctly. That is the
responsibility of the trainer.  

This chapter provides background on the mentoring process offered to trainees of the Local
Voices program. It also shares the mentoring experiences and tips of Local Voices field trainers
and discusses the qualities of a good mentor.  

Background
Mentoring offered by Local Voices programs 

Exercises
None

Hand-outs
None
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Background
Mentoring offered by Local Voices programs
The Local Voices Program provides the following mentoring and post-training support to
journalists: 

• Each office has a senior health journalist, media coordinator, and sound technician who
provide trainees with help for post-workshop stories. This includes assistance with developing
story ideas, reviewing radio feature scripts, research, finding experts and case studies to
interview, loaning equipment, recording voicers, and digital editing of sound. 

• The program provides all trainees with free access to production, recording, and research
facilities.

• Each trainee receives a minidisc or flashdisc recorder after completing five high-quality HIV
radio features. Prior to that, trainees may borrow equipment. 

• Trainees who were awarded recorders become eligible to write proposals for fully funded
travel grants to cover HIV stories outside the city in which they are based.

• Monthly roundtables are held where experts and case studies speak and are available for
interviews afterwards.

• Trainees who have shown a commitment to HIV reporting are invited to participate in
advanced journalism training.

• Trainees are assisted with entering journalism competitions. 

The type of mentoring that Local Voices programs offer is extremely comprehensive.
Maintaining the staff and equipment in Local Voices offices can be very costly. Most training
programs simply don’t have those resources. This chapter therefore focuses on various types of
mentoring and provides tips that are widely applicable. 

Why is mentoring necessary? 
Merely sharing knowledge with trainees doesn’t mean they will apply it correctly or understand
it.  Try to remember how you learned to drive – from someone who spent hours and several
sessions in a car with you, patiently teaching you the rights and wrongs, and repeating the nec-
essary principles over and over. If that person explained to you how to drive without also men-
toring you while you practiced, you would not have learned how to master this skill. Efficient
journalism training works in the same way. It doesn’t work if all you do is lecture to a classroom
full of reporters. The trainees need to be nurtured to apply those skills effectively.   
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You can mentor trainees in different ways: 

• Make sure you have exercises throughout the training workshop that allow trainees to apply
their skills. For example:

• Talking about radio scriptwriting principles does not mean that trainees will apply them. Create
writing exercises and work with the trainees on them (see the scriptwriting chapter).

• Get trainees to record interviews with experts during the training, so that they do their
interviews under your supervision. You can give them feedback afterwards, or remind them to
include a question that they forgot to ask. 

• Plan your training to allow at least a third of the time for production of stories; in a weeklong
workshop, this would give you two and a half days to intensively mentor trainees as they
apply all the principles (sound recording, digital sound editing, scriptwriting, presentation
skills) they learned in the previous days. Mentoring is time consuming and necessarily means
that fewer speakers and topics can be scheduled for a training workshop. But it’s worth it. A
focused workshop during which trainees learn three or four skills well is worth far more than
one in which 10 skills were taught without the trainer knowing whether trainees understand
how to apply those skills. 

• Stay in contact with the trainees after the workshops and offer to review their radio scripts.
This generally works better as part of a formal process with built-in incentives. The Local
Voices program, for instance, requires that trainees who would like to qualify for a free
recorder need to produce five stories that have been produced with the assistance of
Internews mentoring staff. 

What attributes does a good mentor have? 
No two people mentor in the same way. Interpersonal contexts determine the type of mentor-
ing that takes place. Styles depend on the personalities and cultural values of both the mentor
and the trainees. Penny Loretto, a woman with 20 years of experience in human resources,
career counseling, and internship advisement, considers the following to be the top 10 quali-
ties of a good mentor: 

1. Is willing to share skills, knowledge, and expertise.

2. Has a positive attitude and willingness to act as a role model.

3. Takes a personal interest in the mentoring relationship.

4. Exhibits enthusiasm for the field.

5. Values ongoing learning and growth in the field.
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6. Provides guidance and constructive feedback. 

7. Is respected by colleagues and employees at all levels of the organization.

8. Sets and meets ongoing personal and professional goals.

9. Values the opinions and initiatives of others.

10. Motivates others by setting a good example.

Source: http://internships.about.com/od/networking/a/findingamentor.htm

A Mentoring Story: The Rainbow
By Rocky Rohwedder

This mentoring story was published on the website of the George Lucas Educational Foundation.

Billy, a special education student, used to stare into the aquarium in the classroom every
afternoon. He could stand there for hours, even though we only had two fish and a little
ceramic castle. On several afternoons the strangest thing would happen: He would break
into a state of euphoria, jump up and down and scream, “The rainbow, the rainbow!” He was
so excited and enthusiastic he was disturbing the rest of the class. When we looked into the
aquarium, we didn't see any rainbow, so we had to pull Billy away, calm him down, and
placate his “inappropriate” euphoric behavior.

Then one afternoon the other teacher had all the kids outside playing and I was down on
the floor picking up some math blocks. Out of the corner of my eye I caught a blaze of color.
When I turned to see what it was, looking UP in the aquarium I saw the most brilliant
rainbow I have ever seen. At the right angle, from the right perspective (which was of course
how Billy had seen it) the glass, water, and sunshine produced an absolutely incredible
rainbow!

Without hesitation, I instinctively leaped to my feet, jumped up and down, and screamed
“The rainbow, the rainbow!” Finally, I had seen what Billy was trying to show us all these
months. Finally, by seeing the world from HIS perspective, I got it.

So, the moral of the story for me is that a good mentor should always seek to see the world
from the view of the mentee. From the mentee’s perspective you may find yourself instantly
transformed from “teacher” to “student,” and you may grasp a glimpse of some of the most
amazing things you will ever see or know.
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The best way to learn about good mentoring is to find out more about other mentors’ experi-
ences. The Association for Religion and Intellectual Life (ARIL) held a conference in the late
1990s to establish what constitutes a good mentor. Here is what five experts had to say: 

• “One's own life experience of an awareness of having been mentored and what that was like
is important. A mentor also needs a strong sense of self -- including being a good listener –
and a willingness to be vulnerable and open to irreducible differences and to meeting those
differences and engaging them.” – David Ames, Episcopal chaplain at Brown University and for-
mer executive director of ARIL 

• “In some ways, it's about showing how to do like me, offering support, encouragement, and
listening in order to believe in that possibility within the mentee. The key is looking in their
eyes and seeing them. Students have told me that their mentors were 'someone who saw
me.'... And the roles can shift – sometimes the mentor becomes the mentee, there are gifts to
offer one another." – Jane Rinehart, associate professor, sociology and women's studies,
Gonzaga University, Spokane, Washington 

• “A good mentor both shares knowledge and wisdom and draws out the possibilities of those
he/she mentors. There's an interest in and care for those he/she mentors as well as a willing-
ness to hold down to the rigors of their discipline – there's that loving side and also that disci-
plining side." – Laura Walters Baskett, associate chaplain and director of church relations,
University of Tulsa 

• “A good mentor is a person who has experienced nurturing and is willing to help connect
with a person. They must be knowledgeable and understand that eventually the mentee
becomes a peer. The letting-go part can be difficult, but at some point, the mentor has to
stand back and let go." – Donna Gilton, associate professor, Graduate School of Library and
Information Studies, University of Rhode Island 

• “Walt Whitman once wrote, 'I contain a multitude.' Mentors need to nurture the multitude in
all of us.” – Scott Holland, pastor, Monroeville Church of the Brethren, Monroeville, Pensylvania

For more comments, visit:
http://www.brown.edu/Administration/George_Street_Journal/vol22/22GSJ33a.html
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208 Experiences from the field: Mentoring Tips from Local Voices Mentors
Below are mentoring tips from the Local Voices training staff. All the staff have been mentors
for at least a year.

1. Allow mentees to feel comfortable.

I think it's really important to make journalists feel comfortable when mentoring them. Never
talk down to or lose patience with trainees who may seem slow in picking up a new skill or
don’t understand something – even after you’ve demonstrated something two or even three
times. Instead, ask trainees to give you regular feedback about what they’re feeling, and
instruct them to demonstrate how much they have understood; work from that point onwards,
constantly checking that the different stages are well understood. Always end by asking
trainees if they would like you to review any of the areas covered. – Sandra Ndonye, Media
Manager, Kenya

2. Allow mentees the time to practice difficult skills themselves.

Remember to make journalists feel in total control of the story while you mentor them – don't
take control from them, even if that’s the quicker option! I once mentored a junior journalist
who couldn't find statistics to support his story and didn't know how to attribute them to their

Ethiopia Resident Journalism Advisor Sonya De Masi mentors a local journalist on writing a radio
feature script.
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correct sources and to weave them into his stories, so he always left them out. But when I
asked him why he didn’t use figures he felt comfortable pointing out that he didn't understand
the jargon of numbers and percentages and wasn't ever sure who to ask. I spent a lot of time
with him and that has since changed. Now, he's very confident using stats in his stories, and
enjoys showing his colleagues how to accurately do it too. – Sandra Ndonye, Media Manager,
Kenya

3. Demonstrate to mentees how to do something. 

I once mentored a radio journalist from a vernacular radio station and guided her on how to
contact interviewees for her weekly show. Initially, she wasn't confident when she made phone
calls inviting people to her show because she didn't really know what to say and how to pitch
it. Many turned down her requests. After helping her do it a few times and writing down the
points to remember in conversations, she's now very confident and enjoys doing it on her own.
– Ann Mikia, Radio Specialist Trainer, Kenya

4. Provide mentees with feedback on their progress.

One of the most gratifying moments in mentoring someone is when I open the day's paper
and recognize the difference that it has made to the quality of their writing. To share in some-
one's delight and professional pride as they progress toward fulfilling their potential is for me
the best part about mentoring. – Jaya Shreedhar, Project Director, India

5. Be focused – you can’t teach everyone at once.

Don’t try to teach someone five things at a time. If you review a script and find everything’s
wrong, try to focus on one or two things to teach. Correct everything, but go into detail on two
things and repeat and practice the skill throughout. For example, if you find the script cons tantly
repeats the sound bites, work with the mentee on that – it’s a complex skill to learn. Don’t also
try to teach writing in the active voice and expressing one idea per sentence. Correct the sen-
tences, but focus on getting the mentee to master one or two skills at a time. Leave the rest for
the next mentoring session. It’s more effective. – Mia Malan, Senior Health Journalism Advisor

6. Be patient – it can take time to see results.

I remember clearly the day the first journalist came to us voluntarily for mentoring. About six
months after I arrived in Addis, a journalist who had attended one of my workshops came in to
the office, sat down in front of me, said he had a story idea and had gathered a bunch of inter-
views and sound, but now didn’t know what to do next. I was delighted – we had been trying
for a long time to encourage Ethiopian journalists to come to us for editorial support and men-
toring, but the idea had never really taken off. Yet gradually and over time, more and more
journalists have started to come to us and now it happens almost daily. – Sonya De Masi,
Resident Advisor, Ethiopia

209



Internews Radio Training Manual

210



Internews Radio Training Manual

chapter 13
Evaluating Your Training Workshop
MIA MALAN

Learning objectives 
After working through this chapter, the trainer will: 

1. Better understand the importance of evaluating a training workshop.

2. Better understand how to evaluate the effectiveness of a training workshop. 

Why is it important to master this skill as a trainer? 
Evaluating training workshops is essential, or you as the trainer will never really know how
trainees felt about the experience. It is one of the most effective ways to learn how to improve
future training workshops. 

Evaluation is, however, about more than simply handing out a questionnaire on the last train-
ing day. It is also important to evaluate the skills of journalists throughout the training week by
doing exercises, letting them fill out pre- and post-training questionnaires, and conducting
informal conversations. You don’t necessarily have to do these discussions yourself – it’s some-
times better to give this task to a staff member who is not as closely involved in the training
process, or to appoint one of the trainees as the spokesperson for the group. This way, trainees
often give more honest responses. 

This chapter provides information on the different types of training workshop evaluations that
the Local Voices program conducts as well as examples of evaluation forms. All of the examples
have been saved on the manual CD, so you may adjust it to your needs.   

Background
Local Voices Training Evaluations

Exercises
None

Hand-outs
13A Example of a Radio Training Workshop Evaluation Form 

13B Example of a Pre- and Post-training Questionnaire to Measure a Change in Knowledge

13C Answer Sheet for Hand-out 13B
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Local Voices Training Evaluations
The Local Voices program evaluates the impact of its training workshops in six different ways,
although not all the methods are applied in every office:

• Evaluation forms

• Pre- and post-training questionnaires that measure changes in knowledge

• Informal discussions

• Practical exercises

• Peer review at graduation ceremonies

• Output indicators

• Monitoring and evaluation

1. Evaluation forms 

At the end of each workshop, each trainee fills out an evaluation form that asks them to share
their thoughts about the facilitators, speakers, training venue, length of the workshop, what
they believe they learned, how they will apply those skills, what they need more help with, and
so on. The questions mention speakers and sessions by name to refresh the trainees’ memories.
Participants get about 20 to 30 minutes to fill out the forms. 

Evaluation forms provide trainers with: 

• Information on how trainees experienced the training workshop.

• Information on what trainees think they’ve learned.

• Quotes to use in marketing materials.

• Information on what worked and what didn’t, from the trainees’ perspective.

Evaluation forms, however, don’t provide trainers with: 

• Objective information on the knowledge and skills gained during a workshop.

For an example of a Local Voices evaluation form, see Hand-out 13A. 

2. Pre- and post-training questionnaires that measure changes in knowledge

Pre- and post-training questionnaires provide the trainer with an objective, quantitative
measurement of knowledge gained during a training workshop. The results reveal how much
impact the training had on workshop participants. They do not, however, provide trainers with
the opinions of journalists on how they “felt” about a training workshop.

The Local Voices program in India created a pre- and post-training questionnaire that trainees
fill out before starting with the workshop (on the first day), as well as on the last training day.
The pre- and post-training questionnaires are duplicates of each other, with the same
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questions to be answered before and after workshops. About half of the total of 10 questions
are HIV-related (specific to the theme of a workshop, e.g., antiretroviral treatment or counseling
and testing); the other half tests the radio journalism knowledge of trainees. 

Each trainee is required to fill out his or her name on the form, so that a correlation between
the pre- and post-training questionnaires can be drawn for each individual. The average pre-
and post-training scores/percentages are also calculated and compared. For example, if the
average pre- questionnaire was 4/10 (four correct out of ten) and the average post-training
questionnaire score 7/10 (seven correct out of ten), there was a 30% increase in knowledge. 

The Local Voices program has not yet used questionnaires in multiple choice format, although
it’s a format worth exploring. 

To determine whether trainees remembered the knowledge gained during a workshop,
trainers can administer the same questionnaire three to six months after the workshop. 

For an example of such a questionnaire, see Hand-out 13B. 

Evaluation Form Tips
• KEEP IT ANONYMOUS: Don’t ask trainees to fill out their names. They will feel less comfortable about

being frank, and critical comments can really help you improve your workshops.

• LIMIT THE NUMBER OF QUESTIONS: Be realistic about how much information you can expect someone
to share after a tiring five- to seven-day workshop. Try and stick to a maximum of 15 questions.

• USE A RATING SYSTEM: Ask trainees to give a session or facilitators a mark of 1 to 10, which helps you
calculate the average mark for each session and get a good impression of what worked and what 
didn’t. 

• MAKE SURE FORMS ARE FILLED OUT WHILE PARTICIPANTS ARE STILL AT THE TRAINING VENUE: Asking
trainees to take the forms home, fill them out on their own time, and e-mail them back to you rarely
works. More often than not the trainer ends up spending weeks trying to track down trainees who
didn’t return their forms. Days or weeks after the workshop, trainees will usually submit less detailed
forms than the ones collected immediately after the workshop.

• GIVE PARTICIPANTS ENOUGH TIME TO FILL OUT THE FORMS: If you want useful information, you need
to allocate enough time for trainees to fill out evaluation forms. Giving participants 10 minutes to do
so won’t provide you with useful answers.

• INCLUDE OPEN-ENDED QUESTIONS: Most donors will ask you to write a training report and you may
also want to write up something for marketing purposes. Open-ended questions will lead to good
quotes. 
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3. Informal discussions

Informal discussions during tea breaks and lunch between participants and non-training staff
members can provide a lot of information that evaluation forms often don’t. Trainees will natu-
rally shy away from sharing something with trainers that they didn’t like about the workshop.
They’re often concerned that such remarks will offend the trainer and harm their trainee-trainer
relationships. Even issues about per diems or travel arrangements are easier shared with some-
one who is not leading the workshop. As mentioned in the introduction to this chapter,
appointing one of the trainees as a spokesperson or encouraging other staff members to min-
gle with participants during breaks can be helpful. 

4. Practical exercises

Each chapter in this manual contains practical exercises that test the knowledge of trainees
throughout the workshop. For example, the scriptwriting chapter contains writing exercises,
and the sound recording chapter has exercises that evaluate whether trainees are able to apply
their newly acquired knowledge of sound acoustics to a recording room. 

These exercises help the trainer understand: 
• Which skills have been mastered and which skills the trainer needs to spend more time teaching.

• Which explanation methods work better than others.

Pre- and Post-training Questionnaire Tips 
• MAKE SURE QUESTIONS HAVE CLEAR RIGHT AND WRONG ANSWERS: Do not include questions that

can have more than one right answer, because it complicates scoring. For example, ask: “What is AIDS
activists’ preferred term for referring to HIV-infected people?” (Answer: People living with HIV). Don’t
ask: “How should we refer to HIV-infected people?” (Answers: People living with HIV, People with HIV,
HIV-positive people, etc.).

• LIMIT THE NUMBER OF QUESTIONS: An average of about 10 questions is a realistic number for
trainees who are also expected to fill out an evaluation form.

• TEST KNOWLEDGE, NOT SKILLS: Pre- and post-training questionnaires can’t tell you whether trainees
have acquired practical skills. They can only reveal whether trainees have acquired the knowledge to
develop such skills. 

• MAKE SURE THAT THE QUESTIONS DIRECTLY RELATE TO KNOWLEDGE SHARED IN YOUR TRAINING
WORKSHOP: Don’t ask, “Name two classes of antiretroviral drugs” if you don’t specifically address this
in the training workshop. Also be sure to instruct expert speakers to include such information in their
presentations if you expect trainees to remember these facts.
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5. Peer review at graduation ceremonies

Local Voices holds a graduation ceremony for each group of trainees. But participants who fail
to complete a workshop story aren’t awarded certificates. At graduation ceremonies, stories are
played and trainees get the opportunity to critique produced pieces and share their ideas with
each other and the trainer. 

6. Indicators

A list of 28 output indicators collected quarterly record the number of workshop and post-
workshop stories produced by each trainee, males and females trained, travel and equipment
grants given out, visits to the Media Resource Centers, mentoring opportunities, and HIV sub-
jects covered, among others. Each field office enters the results into a fixed template.

Donors are often most interested in the number of people trained. The Local Voices program,
however, considers the output of trainees as equally important – if not more important. The
program has shown that smaller groups of journalists trained intensively often produce a 
higher number of stories than large groups trained less intensively. 

Kenya Technical Manager Benjamin Kiplagat presenting journalist Zainab Aziz with her
training certificate.
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The Local Voices program uses the trainee-story ratio to keep track of the productivity of
trainees – the higher the average number of stories per trainee, the more productive they are
considered to be. Combined with the average of number mentoring opportunities (i.e., how
often trainees make use of the mentoring offered by Local Voices staff ), this information gives a
good indication of how much trainees take advantage of and benefit from mentoring. 

7. Monitoring and Evaluation

Measuring the impact of a journalism program presents a variety of challenges. Unlike 
traditional behavior change communication approaches, programs like Local Voices do not
attempt to control the message. Also, journalists are exposed to a diversity of sources, so it’s
difficult to identify the genesis of a story. The Local Voices program has developed a 
monitoring and evaluation tool that is currently being implemented in various countries. 
It measures the frequency, accuracy, and quality of journalism reports with the help of panels
of HIV experts and journalists. For more information, contact the Local Voices office in
Washington, DC, at +1 202-833-5740.
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HAND-OUT 13A: EXAMPLE OF A RADIO TRAINING WORKSHOP EVALUATION FORM
WORKSHOP EVALUATION FORM

14-18 April 2008 Radio Workshop
Theme: HIV Counseling and Testing

The Internews team would like to know what you think about the just-ended radio training workshop. Please fill out
this evaluation form honestly. Your feedback will help us plan and structure future workshops to better suit you.

What was the most valuable skill you learned from this workshop?
..................................................................................................................................................................................................................................

..................................................................................................................................................................................................................................

..................................................................................................................................................................................................................................

How will you apply this skill in your work?
..................................................................................................................................................................................................................................

..................................................................................................................................................................................................................................

..................................................................................................................................................................................................................................

Are there any radio journalism skills tackled with which you would want extra individual help? Explain.
..................................................................................................................................................................................................................................

..................................................................................................................................................................................................................................

Give brief comments about and ratings of the following, using the numbers 0 to 10 (0 is very bad, 10 is excel-
lent):

Guests and speakers:

Stanley Ngara, community mobilizer, Liverpool VCT: Discussing HIV counseling and testing
..................................................................................................................................................................................................................................

........................................................................................................................................................................... Rating .................... out of 10

Naphtali Opiyo, counseling psychologist, Discordant Couples Research Project, KNH 
..................................................................................................................................................................................................................................

........................................................................................................................................................................... Rating .................... out of 10

Susan and Paul, who shared their personal stories about living with HIV and about testing and counseling 
..................................................................................................................................................................................................................................

........................................................................................................................................................................... Rating .................... out of 10

How did you feel about the following sessions?
Radio scriptwriting (Ida Jooste and Ann Mikia)

..................................................................................................................................................................................................................................

........................................................................................................................................................................... Rating .................... out of 10

(Continued on next page)

H
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Minidisc recorder use and techniques (Benjamin Kiplagat)
..................................................................................................................................................................................................................................

........................................................................................................................................................................... Rating .................... out of 10

Digital sound editing (Benjamin Kiplagat)
..................................................................................................................................................................................................................................

........................................................................................................................................................................... Rating .................... out of 10

Interviewing skills (Sandra Ndonye and Ida Jooste)
..................................................................................................................................................................................................................................

........................................................................................................................................................................... Rating .................... out of 10

Story idea sourcing and research, using the Media Resource Center (Sandra Ndonye)
.................................................................................................................................................................................................................................

........................................................................................................................................................................... Rating .................... out of 10 

The workshop facilitators (Internews team of trainers) 
..................................................................................................................................................................................................................................

........................................................................................................................................................................... Rating .................... out of 10

The workshop program (flow of daily activities) 
..................................................................................................................................................................................................................................

........................................................................................................................................................................... Rating .................... out of 10

The practical exercises that accompanied the theory you did each day
..................................................................................................................................................................................................................................

........................................................................................................................................................................... Rating .................... out of 10

What suggestions would you have for a future follow-up workshop – in what skills do you feel you need more
training or support?

..................................................................................................................................................................................................................................

..................................................................................................................................................................................................................................

..................................................................................................................................................................................................................................

..................................................................................................................................................................................................................................

Thank you for filling out this form.
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HAND-OUT 13B: EXAMPLE OF A PRE-  AND POST-TRAINING QUESTIONNAIRE 

TO MEASURE A CHANGE IN KNOWLEDGE

Name: …………………………………..

Date: …………………………………….

Theme of workshop: Counseling and Testing

Please answer the following questions. Your answers will help us learn more about your knowledge level and
how we can best help you with reporting on HIV. 

HIV-related questions

1. What does VCT stand for? 

..........................................................................................................................................................................................................................

2. What is the name of the type of HIV test that VCT centers use?  

..........................................................................................................................................................................................................................

3. How long does a window period last?

..........................................................................................................................................................................................................................

4. What is the preferred term to use when referring to HIV-infected people?

..........................................................................................................................................................................................................................
5. Can someone be infected with AIDS?

..........................................................................................................................................................................................................................

Radio journalism questions

1. How many ideas should each sentence in a radio feature script have? 

..........................................................................................................................................................................................................................

2. What is an omni-directional microphone? 

..........................................................................................................................................................................................................................

3. You have to record an interview at a big wooden table. The surface of the table is reflecting the sound too 
much. What would you do to the table to allow it to absorb more sound? 

..........................................................................................................................................................................................................................

4. On which sample rate should you record for radio on Adobe Audition? 

..........................................................................................................................................................................................................................

5. What is “popping”? 

..........................................................................................................................................................................................................................

This questionnaire was developed by Mia Malan.  
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HAND-OUT 13C: ANSWER SHEET FOR HAND-OUT 13B 

HIV-related questions

1. What does VCT stand for? 

Voluntary counseling and testing

2. What is the name of the type of HIV test that VCT centers use?  

Rapid test

3. How long does a window period last for?

Up to three months

4. What is the preferred term to use when referring HIV-infected people?

People living with HIV (PLHIV)

5. Can someone get infected with AIDS?

No. You can only get infected with HIV. AIDS is the name of a syndrome of diseases that you develop as a 
result of HIV infection. 

Radio journalism questions

6. How many ideas should each sentence in a radio feature script have? 

One idea per sentence

7. What is an omni-directional microphone? 

A microphone that records sound from multiple sides (as opposed to a directional microphone) 

8. You have to record an interview at a big wooden table. The surface of the table is reflecting the sound too 
much. What would you do to the table to allow it to absorb more sound? 

Put a piece of material such as a tablecloth, towel, a few pillows, or piece of clothing on the table (at least at 
the side where you are doing the interview)

9. On which sample rate should you record for radio on Adobe Audition?

44100

10. What is “popping”? 

The popping sound of “Ps” and “Bs” that you record if you hold the microphone too close to your mouth.

This questionnaire was developed by Mia Malan. 
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